## Content

1. **Document History** ................................. 7

2. **Getting Started with Lumira Discovery** ........................................ 9
   2.1 What is SAP BusinessObjects Lumira? ........................................ 9
   2.2 Connecting to a Data Source ...................................................... 11
   2.3 Creating a Document .............................................................. 11
   2.4 Installation ............................................................................. 13
       - SAP BusinessObjects Lumira Discovery Installation Wizard ........... 13
       - Silent Installation with a Response File ...................................... 15
       - Uninstalling SAP BusinessObjects Lumira Discovery ..................... 16
   2.5 Upgrade ................................................................................... 17
       - Side-by-side Installation ........................................................... 17

3. **Introducing the Lumira Discovery User Interface** .............................. 18
   3.1 Home Page ............................................................................. 18
       - Data Source ........................................................................... 19
       - Local Document ..................................................................... 20
   3.2 DataView ............................................................................... 21
   3.3 DesignView ............................................................................ 21
       - Preview .................................................................................. 23
   3.4 Global Tool Bar ....................................................................... 23
   3.5 Side Bar .................................................................................. 24
   3.6 Measures and Dimensions Pane ................................................... 25
   3.7 Column Data Actions ............................................................... 26

4. **Acquiring Datasets** ..................................................................... 31
   4.1 Viewing a Data Source Connection and its Associated Documents ........................................ 32
   4.2 Acquiring Data from SAP HANA views ........................................ 33
       - Connecting to SAP HANA .......................................................... 33
       - Downloading Data from SAP HANA .......................................... 36
       - Accessing SAP BW data in SAP HANA views .............................. 38
       - Specifying values for SAP HANA variables and string input parameters ........................................ 39
   4.3 Acquiring Data from SAP Business Warehouse (BW) .............................. 40
       - Connecting to SAP BW ............................................................. 41
       - Downloading a BW Dataset ...................................................... 43
       - Configuring Secure Network Communication (SNC) ...................... 51
       - Support for SAP BW Structures ................................................. 51
   4.4 Acquiring Data Using Query with SQL ........................................ 52
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Installing Data Access Drivers</td>
<td>54</td>
</tr>
<tr>
<td>Connecting to a Query with SQL Data Source</td>
<td>56</td>
</tr>
<tr>
<td>4.5 SAP Universe</td>
<td>59</td>
</tr>
<tr>
<td>Acquiring Data from the SAP Universe</td>
<td>59</td>
</tr>
<tr>
<td>Building a Query</td>
<td>60</td>
</tr>
<tr>
<td>Using Prompts to Filter Data</td>
<td>61</td>
</tr>
<tr>
<td>Limitations of SAP Universe</td>
<td>62</td>
</tr>
<tr>
<td>4.6 Data from Files</td>
<td>62</td>
</tr>
<tr>
<td>Acquiring Data from an Excel Workbook</td>
<td>62</td>
</tr>
<tr>
<td>Acquiring Data from a Text File</td>
<td>65</td>
</tr>
<tr>
<td>Acquiring Data Copied to Clipboard</td>
<td>67</td>
</tr>
<tr>
<td>4.7 Data from Extensions</td>
<td>68</td>
</tr>
<tr>
<td>Application Extensions</td>
<td>68</td>
</tr>
<tr>
<td>5 Do more with Datasets</td>
<td>74</td>
</tr>
<tr>
<td>5.1 Editing an Acquired Dataset</td>
<td>74</td>
</tr>
<tr>
<td>5.2 Renaming a Dataset</td>
<td>75</td>
</tr>
<tr>
<td>5.3 Refreshing Data in a Document</td>
<td>75</td>
</tr>
<tr>
<td>5.4 Editing and Cleaning Data</td>
<td>76</td>
</tr>
<tr>
<td>5.5 Creating Hierarchies</td>
<td>77</td>
</tr>
<tr>
<td>5.6 Sorting</td>
<td>85</td>
</tr>
<tr>
<td>5.7 Creating Measures</td>
<td>85</td>
</tr>
<tr>
<td>5.8 Measures Associated with Dimensions</td>
<td>88</td>
</tr>
<tr>
<td>6 Working with Multiple Datasets</td>
<td>90</td>
</tr>
<tr>
<td>6.1 Adding Datasets in a Document</td>
<td>90</td>
</tr>
<tr>
<td>6.2 Removing a Dataset</td>
<td>91</td>
</tr>
<tr>
<td>6.3 Merging Datasets (JOIN)</td>
<td>91</td>
</tr>
<tr>
<td>6.4 Appending Datasets (UNION)</td>
<td>92</td>
</tr>
<tr>
<td>6.5 Linking Datasets</td>
<td>93</td>
</tr>
<tr>
<td>6.6 Creating and Managing Dataset Links</td>
<td>94</td>
</tr>
<tr>
<td>6.7 Linking Datasets While Creating a Visualization</td>
<td>95</td>
</tr>
<tr>
<td>7 Building Charts</td>
<td>96</td>
</tr>
</tbody>
</table>
7.1 Creating a Chart Directly on the Chart Canvas ........................................... 96
7.2 Working with the Chart Builder ................................................................. 97
   Creating a chart with the Chart Builder .................................................. 99
   Assigning Measure to Axis ........................................................................ 99
   Changing Chart Type for Series ............................................................. 100
   Chart Properties ...................................................................................... 101
7.3 Chart Types .............................................................................................. 102
   Working with Geo Map ............................................................................ 103
   Analyzing Data in Crosstabs ................................................................. 105
7.4 Blending Your Data .................................................................................. 110
7.5 Renaming a Chart .................................................................................... 112
   Restoring a Chart’s Default Title ............................................................ 112

8 Do More with Charts ....................................................................................... 113
8.1 Reference Lines .......................................................................................... 113
   Adding a Reference Line ......................................................................... 113
   Managing Reference Line ....................................................................... 114
8.2 Sorting ......................................................................................................... 115
   Sorting Measures ...................................................................................... 115
8.3 Conditional Formatting .............................................................................. 116
   Creating Conditional Formatting Rules .................................................. 117
   Managing Conditional Formatting Rules ............................................... 118
8.4 Display Formatting ...................................................................................... 118
8.5 Modifying Chart Colors and Appearance .............................................. 119
   Dimension Color Palette ........................................................................ 119
   Measure Color Palette .......................................................................... 123
8.6 Hierarchical Data ....................................................................................... 127
   Finding Dimensions in a Hierarchy ......................................................... 127
   Drilling Through Hierarchical Data ....................................................... 128
8.7 Plotting Measures as a Dimension in a Chart .......................................... 130

9 Stories ........................................................................................................... 131
9.1 Creating a Story ......................................................................................... 131
9.2 Formatting a Story Page ............................................................................ 132
9.3 Formatting a Visualization ....................................................................... 134
9.4 Enhancing your stories With Shapes, Illustrations, Text Boxes, and Images .................................................................................. 135
   Adding Text to a Story ............................................................................ 136
   Uploading Custom Illustrations and Shapes ........................................... 137
9.5 Linking to a Web Page or to Another Page in the Story ................................ 137
   Modifying a Hyperlink ............................................................................ 138
   Removing a Hyperlink ............................................................................ 138

10 Filters ............................................................................................................ 139
<table>
<thead>
<tr>
<th>Section</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>10.1</td>
<td>Filtering Data from Dataset</td>
<td>139</td>
</tr>
<tr>
<td>10.2</td>
<td>Filtering Data in Visualization</td>
<td>141</td>
</tr>
<tr>
<td>10.3</td>
<td>Filtering Data in Stories</td>
<td>143</td>
</tr>
<tr>
<td>10.4</td>
<td>Using Controls</td>
<td>145</td>
</tr>
<tr>
<td></td>
<td>Displaying Controls in the Document</td>
<td>147</td>
</tr>
<tr>
<td></td>
<td>Editing Controls</td>
<td>150</td>
</tr>
<tr>
<td>10.5</td>
<td>Filtering Data in Charts</td>
<td>150</td>
</tr>
<tr>
<td></td>
<td>Filtering Data by Rank</td>
<td>150</td>
</tr>
<tr>
<td>11</td>
<td>Export</td>
<td>152</td>
</tr>
<tr>
<td>11.1</td>
<td>Exporting Stories for all Data Points</td>
<td>152</td>
</tr>
<tr>
<td>11.2</td>
<td>Exporting Datasets for all Data Points</td>
<td>153</td>
</tr>
<tr>
<td>12</td>
<td>Inter-operability</td>
<td>155</td>
</tr>
<tr>
<td>12.1</td>
<td>Working with Different Inter-operability Scenarios</td>
<td>156</td>
</tr>
<tr>
<td>13</td>
<td>Advanced Analysis</td>
<td>158</td>
</tr>
<tr>
<td>13.1</td>
<td>Calculations</td>
<td>158</td>
</tr>
<tr>
<td></td>
<td>Moving Average</td>
<td>160</td>
</tr>
<tr>
<td></td>
<td>Difference From</td>
<td>160</td>
</tr>
<tr>
<td></td>
<td>Percentage Of</td>
<td>161</td>
</tr>
<tr>
<td></td>
<td>Running Calculations</td>
<td>161</td>
</tr>
<tr>
<td></td>
<td>Custom Calculation</td>
<td>162</td>
</tr>
<tr>
<td>13.2</td>
<td>Lumira Functions Reference for Offline Documents</td>
<td>163</td>
</tr>
<tr>
<td></td>
<td>Aggregate Functions</td>
<td>164</td>
</tr>
<tr>
<td></td>
<td>Character Functions</td>
<td>170</td>
</tr>
<tr>
<td></td>
<td>Date and Time Functions</td>
<td>177</td>
</tr>
<tr>
<td></td>
<td>Expression Functions</td>
<td>191</td>
</tr>
<tr>
<td></td>
<td>Miscellaneous Functions</td>
<td>202</td>
</tr>
<tr>
<td></td>
<td>Numeric Functions</td>
<td>206</td>
</tr>
<tr>
<td></td>
<td>Operator Functions</td>
<td>210</td>
</tr>
<tr>
<td>13.3</td>
<td>Lumira Discovery Functions Reference for Online Documents</td>
<td>213</td>
</tr>
<tr>
<td>14</td>
<td>Publish Dataset and Documents</td>
<td>215</td>
</tr>
<tr>
<td>14.1</td>
<td>Saving a Document to Local Directory</td>
<td>215</td>
</tr>
<tr>
<td>14.2</td>
<td>Publishing a Document to SAP BusinessObjects Lumira, server for BI Platform</td>
<td>216</td>
</tr>
<tr>
<td>14.3</td>
<td>Publishing a Dataset to SAP HANA</td>
<td>218</td>
</tr>
<tr>
<td>14.4</td>
<td>Saving a Discovery Document Without Sensitive Data</td>
<td>219</td>
</tr>
<tr>
<td>15</td>
<td>Managing Lumira Discovery</td>
<td>220</td>
</tr>
<tr>
<td>15.1</td>
<td>Manage Licenses</td>
<td>220</td>
</tr>
<tr>
<td></td>
<td>Upgrading from Lumira Discovery Trial</td>
<td>221</td>
</tr>
<tr>
<td>15.2</td>
<td>Setting Application Preferences</td>
<td>222</td>
</tr>
</tbody>
</table>
The following table provides an overview of the most important document changes.

With Lumira Discovery 2.0 SP02, the following changes have been made:

Table 1: Document History

<table>
<thead>
<tr>
<th>Description</th>
<th>Related Links</th>
</tr>
</thead>
<tbody>
<tr>
<td>A new chapter has been added that mentions the necessary actions to add hyperlink to a web Page or to another page in the story.</td>
<td>Linking to a Web Page or to Another Page in the Story [page 137]</td>
</tr>
<tr>
<td>Information about using controls has been enhanced.</td>
<td>Using Controls [page 145]</td>
</tr>
<tr>
<td></td>
<td>Displaying Controls in the Document [page 147]</td>
</tr>
<tr>
<td>A new chapter has been added that mentions about the procedure to remove a dataset from the document having multiple datasets in Lumira Discovery.</td>
<td>Removing a Dataset [page 91]</td>
</tr>
<tr>
<td>A new chapter has been added that gives information about the SNC connection and its configuration details in SAP BW.</td>
<td>Configuring Secure Network Communication (SNC) [page 51]</td>
</tr>
<tr>
<td></td>
<td>Connecting to SAP BW [page 41]</td>
</tr>
<tr>
<td></td>
<td>Downloading a BW Dataset [page 43]</td>
</tr>
<tr>
<td>A new chapter has been added that mentions about the procedure to rename a dataset in Lumira Discovery.</td>
<td>Renaming a Dataset [page 75]</td>
</tr>
<tr>
<td>Information about connecting to SAP HANA using HTTPS connection (for both Live and Import) has been added.</td>
<td>Connecting to SAP HANA [page 33]</td>
</tr>
<tr>
<td></td>
<td>Downloading Data from SAP HANA [page 36]</td>
</tr>
<tr>
<td>A new chapter about Manage Licenses has been added that mentions about different license key has been added.</td>
<td>Manage Licenses [page 220]</td>
</tr>
<tr>
<td>A new chapter about Filtering Data from Dataset has been added that mentions about importance of dataset filter to limit the values displayed while working with large amounts of data.</td>
<td>Filtering Data from Dataset [page 139]</td>
</tr>
<tr>
<td>A new chapter about Display Formatting has been added that mentions about different ways to display a measure on the chart.</td>
<td>Display Formatting [page 118]</td>
</tr>
</tbody>
</table>
With Lumira Discovery 2.0 SP01, the following changes have been made:

Table 2: Document History

<table>
<thead>
<tr>
<th>Description</th>
<th>Related Links</th>
</tr>
</thead>
<tbody>
<tr>
<td>Information about Uploading Custom Illustrations and Shapes has been enhanced.</td>
<td>Uploading Custom Illustrations and Shapes [page 137]</td>
</tr>
<tr>
<td>Information on various inter-operability scenarios has been added.</td>
<td>Working with Different Inter-operability Scenarios [page 156]</td>
</tr>
</tbody>
</table>
2 Getting Started with Lumira Discovery

2.1 What is SAP BusinessObjects Lumira?

SAP BusinessObjects Lumira enables customers to gain insights from trusted enterprise data sources and personal data, and to share those insights through interactive visualizations, stories and tailored analysis applications with other users, on desktop browsers and mobile devices.

SAP BusinessObjects Lumira provides connectivity to SAP enterprise data models in SAP BW, SAP HANA and SAP BusinessObjects universes (UNIX) as well as to a wide variety of third party databases and file data for data acquisition, cleansing and manipulation. It also provides online connectivity with full support for SAP HANA and SAP BW.

To visualize data and enable interactivity, SAP BusinessObjects Lumira provides powerful UI elements such as charts, crosstabs, geo maps and filter components out of the box, along with a rich set of ready to run analysis applications, templates and samples. Both self-service dashboards and tailored, centrally (IT) managed applications are built from the same libraries of UI elements and same data connections and sources, to provide a uniform and consistent experience for business end users. The UI element library is based on the latest SAPUI5 HTML5 library, and ensures alignment with SAP’s Fiori UI strategy while leaving full flexibility to customize the look and feel according to customer-specific corporate standards. Rich APIs and SDKs are provided to create customer-specific visualizations and data connectors, having established a considerable ecosystem of partner extensions.

To serve the particular needs of business key users, corporate analysis application designers, administrators and business end users, SAP BusinessObjects Lumira provides dedicated tools and deployment units to serve these particular needs:

**SAP BusinessObjects Lumira Discovery**

SAP BusinessObjects Lumira Discovery is the rich client for business key users who need a flexible tool to connect to data sources, acquire, manipulate and merge data, to work offline with data, to explore and analyze data online and to create stories with visualizations from all types of data in an ad-hoc fashion.

**SAP BusinessObjects Lumira Designer**

SAP BusinessObjects Lumira Designer is the rich client for professional analysis application designers (typically working in IT departments) to create corporate analysis applications and reports. Lumira Designer provides the same UI elements as Lumira Discovery and more, and allows full control of the application look and feel, and user interaction through scripting and corporate CSS style sheets. Lumira Designer also enables the creation of shared UI elements (e.g. headers, footers, toolbars) and the decomposition of complex...
applications into smaller, better manageable parts, which eventually enable cost-effective management of large corporate BI deployments.

SAP BusinessObjects Lumira, server version for BI Platform

SAP BusinessObjects Lumira, server version for BI Platform is installed on the SAP BusinessObjects BI platform and hosts the execution runtime of Lumira documents that are created from Lumira Discovery and Lumira Designer. Administrators manage and secure Lumira documents with standard tools and mechanisms of the BI platform. Business users can view Lumira documents from the BI Launchpad in desktop browsers or on mobile devices through SAP BusinessObjects Mobile. They can interact with data (filtering, sorting, ranking, for example), adapt visualizations, create and share personal views (bookmarks), export data and print Lumira documents.

Interoperability

All three deployment units share the same technology stack for data connectivity, UI elements, personalization and collaboration, enabling a coherent user experience and smooth interoperability between the Lumira deployment units:

WYSIWYG (What You See Is What You Get) layout and design
Stories (created with Lumira Discovery) and analysis applications (created with Lumira Designer) use the same data and look the same for authors and for consumers.

Extension of Lumira Discovery stories
Lumira Discovery stories can be opened and enhanced in Lumira Designer, to evolve an ad-hoc story into a corporate application, for example.

Open extended stories in Lumira Discovery
Lumira Discovery stories that have been extended in Lumira Designer can be viewed in Lumira Discovery, and even be modified (in certain boundaries).

Data Manipulation for Lumira Designer
Prepared data sets from Lumira Discovery can be used as data sources in Lumira Designer, to meet information needs that cannot be served with online data connectivity.

Related Information

Inter-operability [page 155]


2.2  Connecting to a Data Source

A dataset is a set of columns and hierarchies used to create a document. Using datasets, you can build charts and stories to analyze your data.

Context

Datatypes are broadly classified into Server, File and Extension. In Lumira Discovery, you need to choose the preferred connection type to import the dataset.

Procedure

1. On the Home Page, under Data Source, choose Show All.
   All connection types are listed under Data Source in the left-hand corner.
2. Select your preferred connection type.
   For more information on connecting to a dataset, see Acquiring Datasets [page 31].

Results

Acquire the dataset and start building charts and stories.

Related Information

Data Source [page 19]

2.3  Creating a Document

You can connect to a data source and store the acquired dataset in a new .lumx document.

Context

Each Lumira Discovery document contains:
• One or more datasets.
• Charts built from datasets.
• Stories that describe data using charts, text, navigation points, and images.

Procedure

1. On the Home page, choose Show ALL under Data Source.
   All the data source types are listed under Data Source on the left, and all recently used documents are listed at the center of Lumira Discovery.
2. Select a source file or enter the data source connection details and choose Visualize.
   The dataset is imported into the document.

   Note
   If you select SAP HANA Live | Import as a data source, data is not acquired as a dataset and saved in a document. Instead, the data is accessed from the server, and only measures and column names are referenced in the document.

Results

A new document is created and opened in Lumira Discovery. Enter details such as document name and location before saving the document.

Next Steps

You can now start building your visualizations and stories from the dataset imported. If you want to view or edit the dataset, choose DataView in the upper right-hand corner of Lumira Discovery.
2.4 Installation

2.4.1 SAP BusinessObjects Lumira Discovery Installation Wizard

The SAP BusinessObjects Lumira Discovery installation wizard identifies your computer’s operating system, checks for installation prerequisites, and updates files as required. The wizard is in a self-extracting archive file called SBOPLumiraDiscoverySetup.exe.

For a list of supported platforms and information about specific platforms and configurations, see the Product Availability Matrix (PAM) available on SAP Support Portal at https://apps.support.sap.com/sap/support/pam. Here you can enter SBOP LUMIRA in the search field to retrieve the information.

2.4.1.1 Installing SAP BusinessObjects Lumira Discovery

Context

Procedure

1. Launch the SAP BusinessObjects Lumira Discovery installation program by doubing-clicking SBOPLumiraDiscoverySetup.exe.

   By default, SAP BusinessObjects Lumira Discovery is installed at the following location C:\Program Files\SAP BusinessObjects Lumira\Lumira Discovery. The SAP BusinessObjects Lumira Discovery installation wizard launches and verifies installation prerequisites on your machine. If the installer detects that certain installation pre-requisites are missing, a dialog box appears with a list of missing components. Choose each item in the list for a description of the action required in order to meet the requirement. You have to resolve the issues related to prerequisite before continuing with the installation.

2. Choose the language to use for the installation and the default installation directory:
   a. In the Setup language list, select the installation language.
   b. Accept the default installation directory, or enter a different directory path. You can also browse to navigate to a different directory.
   c. Choose Next. The License Agreement page opens.

3. Review your license agreement, select the I accept the License Agreement check box, and choose Next. The Ready to Install page opens.
Note
This is the last point at which you can modify your installation information before the wizard starts updating files on your computer.

4. Choose Next.
The installation is completed when the Finish Installation page opens.
5. To automatically start SAP BusinessObjects Lumira Discovery after the wizard closes, the Launch SAP BusinessObjects Lumira Discovery after installation completes check box is selected by default.
6. Choose Finish to close Installation Manager.

2.4.1.2 Checking Installation Prerequisites

The Lumira Discovery installation wizard confirms that all prerequisites are met before you start to install the application.

For quicker installation, make sure that the following requirements are met before starting:

- The correct installation package is available for your 64-bit operating system.
- You have Administrator rights.
- Sufficient disk space is available.

Table 3: Disk space requirements

<table>
<thead>
<tr>
<th>Resource</th>
<th>Required space</th>
</tr>
</thead>
<tbody>
<tr>
<td>Drive hosting the user application data folder</td>
<td>2.5 GB</td>
</tr>
<tr>
<td>User temporary folder (\AppData\Local\Temp)</td>
<td>200 MB</td>
</tr>
<tr>
<td>Drive hosting the installation directory</td>
<td>1 GB</td>
</tr>
</tbody>
</table>

- These local ports are available:
  - Local port 6401
  - One port in the range of 4520–4539
- During installation, the SAP BusinessObjects Lumira Discovery setup checks whether Microsoft redistributable runtime VS 2015 DLL(X64) is installed. If it is not installed, the setup installs this component automatically.
2.4.2 Silent Installation with a Response File

In a silent installation, the SAP BusinessObjects Lumira Discovery installation wizard runs without displaying a user interface or prompting for user input. It reads required input from a text file.

A silent installation is typically used by network administrators to push multiple installations across a network, or for performing custom installations. After creating a silent-installation response file, you can add the silent-installation command to your installation script.

You can create a response file by running the SAP BusinessObjects Lumira Discovery installation wizard in write mode.

2.4.2.1 Creating a Response File

Using the SAP BusinessObjects Lumira Discovery installation wizard to create a response file enables you to access parameters entered on the user interface.

Procedure

1. At a command prompt, navigate to the directory containing the SBOPLumiraDiscoverySetup.exe self-extracting archive file.
   The file might be located for example at C:\Program Files\SAP BusinessObjects Lumira\Lumira Discovery\.
2. At a command prompt, enter SBOPLumiraDiscoverySetup.exe -w <ResponseFilePath> \response.ini
   <ResponseFilePath> is the location where you want to save the response.ini file.
   The SAP BusinessObjects Lumira Discovery installation wizard opens.
3. Follow the wizard prompts, and select Next on the Start installation page.
   The wizard writes your installation options to a response.ini file at the location you chose in step 2.
   When the wizard completes, the installation program exits and the response file is created. The response file can then be used for future installations
4. Open the response.ini file in a text editor.

   i Note

   When creating a response file with the GUI installation program, the passwords entered via the GUI is not written to the response file in plain text format. You must replace the starred entries (********) with your passwords before performing a silent installation.

5. Save and close the response.ini file.
2.4.2.2 Performing Silent Installation

Use the response.ini file to run a silent installation.

Prerequisites

The response.ini file must be available for use.

Procedure

1. At a command prompt, navigate to the directory containing the SBOPlumiraDiscoverySetup.exe installation program.
   By default, this program is located at C:\Program Files\SAP BusinessObjects Lumira\Lumira Discovery\SBOPlumiraDiscoverySetup.exe.
2. At a command prompt, enter SBOPlumiraDiscoverySetup.exe -s -r <ResponseFilePath> response.ini
   <ResponseFilePath> is the path to the response.ini file.
   The -s parameter hides the SBOPlumiraDiscoverySetup.exe file's self-extraction progress bar during silent installation. Ignore this parameter if you want to watch the progress bar.

2.4.3 Uninstalling SAP BusinessObjects Lumira Discovery

Use the uninstall utility to remove SAP BusinessObjects Lumira Discovery from the computer.

Procedure

1. Choose Start Control Panel Programs Programs and Features.
2. Locate SAP BusinessObjects Lumira Discovery.
3. Right-click SAP BusinessObjects Lumira Discovery and choose Uninstall.
   The Confirm Uninstall page opens.
4. Select Next.
   SAP BusinessObjects Lumira Discovery is removed from the computer.
5. Select Finish to close the installation program.
2.5 Upgrade

2.5.1 Side-by-side Installation

Upgrading from SAP Lumira 1.x to SAP BusinessObjects Lumira Discovery 2.0 is not supported. However, you can install the SAP BusinessObjects Lumira Discovery independently, or side-by-side with an existing deployment. With side-by-side installation, you can install the 2.x version of Lumira on a machine with an existing, older 1.x deployment.

**Note**

To avoid conflicts between the two deployments, install the second deployment into a unique directory.

For example, the two cases can be:

- You can choose to install SAP BusinessObjects Lumira Discovery 2.0 and then select the required installation path. For more information, see [Installing SAP BusinessObjects Lumira Discovery](#) [page 13].
- You can choose to install SAP Lumira 1.x and SAP BusinessObjects Lumira Discovery 2.0 in parallel, choosing different paths for the two installations. For more information on installing SAP Lumira 1.x, see [SAP Lumira Installation Guide (desktop)](#).

**Note**

When you try to open Lumira documents created using SAP Lumira 1.x, they open by default with SAP BusinessObjects Lumira Discovery 2.0. You can open Lumira 1.x manually however, and view the documents in it.
3 Introducing the Lumira Discovery User Interface

The topics in this section clarify what you can see and experience when using Lumira Discovery.

3.1 Home Page

When you start Lumira Discovery you can start working immediately from the Home page, performing tasks such as creating or opening a dataset, using the samples that are shipped with the product, and so on.

Home page contains the list of both .lums (Lumira 1.x) and .lumx (Lumira Discovery 2.0) documents.

The Home page in Lumira Discovery is a central location from which you can do the following:

- Connect to your data.
- Connect to your most recently used connections.
- Discover and explore content produced by Lumira Discovery.

This image is interactive. Hover over each section for a description. Click the highlighted sections for more information.
3.1.1 Data Source

Connect to data using multiple data source options. By default, the first five data sources are listed. When you expand the list, the data sources are categorized into Server, File, and Extension.

1. **Server**: Connect to data stored in databases like Query with SQL, SAP BW Live | Import, SAP HANA Live | Import, SAP Universe
2. **File**: If you save your file to a local drive on your computer or another location in your organization, you can import your file into Lumira Discovery. A new dataset is created in your Lumira Discovery, but your file actually remains on your local drive.
3. **Extension**: By adding extensions, you can either create a custom chart type or acquire data from data sources that are generally not supported in Lumira Discovery.

Related Information

*Acquiring Datasets* [page 31]
*Application Extensions* [page 68]
### 3.1.2 Local Document

In the home page, your documents are listed under *Local Document*. Each listed document represents one or more pages of visualizations based on the underlying datasets. You can also access sample documents from here.

1. **Local Document**: When you open Lumira Discovery for the first time, this pane is empty. As you create and save new documents, the most recently opened documents appear here.
2. **Sample Documents**: If you are new to Lumira Discovery and want to try it out but don’t have any data or if you have a dataset but don’t understand how Lumira Discovery works, you can stop worrying: SAP has created samples for you to use until you feel more comfortable with Lumira Discovery.
3. **Search**: Search enables you to search documents within Lumira Discovery. It starts looking for matches as you enter search text.
4. **Refresh**: You can add a .lumx document in Lumira Discovery without importing it through any of the Data Sources by choosing (Refresh). Also, if you have downloaded a Lumira document from SAP Lumira, server version from BI Platform, you will find that document in the view after refreshing.
5. **Views**: Lumira Discovery provides a toggle button to help you navigate between different views to see your documents. You can choose to view the documents as tiles by choosing the (Tile View) button, or as a list by choosing the (List View) button.

**Related Information**

[Home Page](page 18)
3.2 DataView

The raw data that is first acquired by the application is often formatted inconsistently and hard for business users to interpret. Use the tools in the DataView to view and prepare data before creating charts to visualize it, making sure it is presentable and understandable.

This image is interactive. Hover over each section for a description. Click the highlighted sections for more information.

- Global Tool Bar [page 23]
- DesignView [page 21]
- Column Data Actions [page 26]
- Side Bar [page 24]

3.3 DesignView

DesignView is where you build charts using your data by dragging and dropping fields onto shelves.

DesignView contains pages and stories. You can create new pages in a story and select between the pages in the story. Every story has one or more pages that can contain items such as visualizations, text, graphics, and input controls. Explore and analyze the data using filters, controls, calculations, conditional text, and other tools.

Discovery has several ways to view and organize the charts in DesignView.
This image is interactive. Hover over each section for a description. Click the highlighted sections for more information.

- Preview [page 23]
- Creating a Chart Directly on the Chart Canvas [page 96]
- Formatting a Story Page [page 132]
- Creating a Story [page 131]
- Global Tool Bar [page 23]
- Side Bar [page 24]
- DataView [page 21]
- Preview [page 23]
- Creating a Chart Directly on the Chart Canvas [page 96]
- Formatting a Story Page [page 132]

Related Information

Formatting a Story Page [page 132]
Creating a Story [page 131]
Creating a Chart Directly on the Chart Canvas [page 96]
Enhancing your stories With Shapes, Illustrations, Text Boxes, and Images [page 135]
3.3.1 Preview

You can toggle between **Preview** and **Design View**.

- **Preview**: Select **Preview** to see how the story appears when published.
- **Design View**: **Design View** in Lumira Discovery allows you to dig deeper into your data by adding and removing measures and dimensions, changing visualization type, creating new visualizations, and adding and deleting visualizations and pages from the document. You have lots of flexibility in exploring and designing a report here.

3.4 Global Tool Bar

Use these tools to change the data display, add calculations, merge data, refresh data, and undo user actions. Also, you can use this pane to view, and edit the data source, charts and stories.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;</td>
<td>Expands/Collapses measures and dimensions.</td>
</tr>
<tr>
<td><img src="image" alt="Save" /></td>
<td>Save/Save As the current document.</td>
</tr>
<tr>
<td><img src="image" alt="Add Dataset" /></td>
<td>Adds a new dataset.</td>
</tr>
<tr>
<td><img src="image" alt="Add Calculated" /></td>
<td>Adds calculated dimensions or measures.</td>
</tr>
<tr>
<td><img src="image" alt="Merge" /></td>
<td>Merges the data to a dataset. You can merge data from multiple datasets into the current dataset, but the data must be compatible.</td>
</tr>
<tr>
<td><img src="image" alt="Append" /></td>
<td>Appends the data to a dataset. You can append another dataset to the current one. Data in common columns is appended to the current dataset, and data in unique columns is added in new columns.</td>
</tr>
<tr>
<td><img src="image" alt="Link" /></td>
<td>Links datasets to expand your analysis. If you have multiple datasets that contain related data, but you don’t want to wait for your technical staff to perform a time-consuming database merge, then you can link the datasets.</td>
</tr>
</tbody>
</table>

**Note**

Dataset linking is not supported for BW online.
### Option Description

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>⚙️</td>
<td>Refreshes the document to get fresh data from the data source.</td>
</tr>
<tr>
<td>⬅️</td>
<td>Reverses the last action. You can undo most actions, but actions that change the underlying data, such as adding or updating the data, clears the undo history.</td>
</tr>
<tr>
<td>⚡️</td>
<td>Repeats the last action.</td>
</tr>
<tr>
<td>📊 <strong>Insert Chart</strong></td>
<td>Changes the chart type and customizes the chart.</td>
</tr>
<tr>
<td>📐</td>
<td>Converts stories to PDF, which helps you to send files to consultants, business partners, and clients. PDF files are used by companies to make sure that no changes are made to the original document.</td>
</tr>
<tr>
<td>⌁</td>
<td>Shows/Hides filter bar.</td>
</tr>
<tr>
<td>📊</td>
<td>Displays the data in columns and rows.</td>
</tr>
<tr>
<td>📊</td>
<td>Displays only the unique values in each column. The number of times each value occurs is also displayed.</td>
</tr>
<tr>
<td>📐</td>
<td>Export all data values from a visualization to Microsoft Excel or any CSV format.</td>
</tr>
</tbody>
</table>

### 3.5 Side Bar

The side bar lets you toggle between the **DATASET** and **SUMMARY** panes, when you are in **DataView**, and between the **DATASET** and **DESIGN** panes when you are in **DesignView**.

You can show or hide the side pane by choosing the icon ☐ in the upper left corner.

- **DATASET** pane: Displays measures and dimensions that are available in the currently selected dataset.
  The current dataset appears at the top of the Dataset pane.
  To search for fields in the Dataset pane, type in the search text box.
  To see how the Dataset pane is arranged, see [Measures and Dimensions Pane](#) [page 25].
- **SUMMARY** pane: Select a column in to display information about its values:
  - View each unique value in the column, along with the number of times it occurs.
  - Search for a value in the column.
  - Sort the display by value or by number of occurrences.
• **DESIGN**: This provides quick and easy access to common features in Lumira Discovery. It contains different types of text, graphics, and other customizations that you can drag to the story page. *Choose Text* is selected by default, but you can select other options to display different content.

**Related Information**

- Formatting a Visualization [page 134]
- Enhancing your stories With Shapes, Illustrations, Text Boxes, and Images [page 135]
- Measures and Dimensions Pane [page 25]

### 3.6 Measures and Dimensions Pane

When you connect to a data source, Lumira Discovery assigns each field in the data source as a dimension or measure. The *Measures and Dimensions* pane lists the measures, dimensions, hierarchies, and inferred dimensions in a dataset. You can perform the following actions:

- When preparing data, use the tools on the *Measures and Dimensions* pane to define and to create hierarchies.
- When visualizing data, use this pane to view, sort, select, and filter the data in a visualization. Data is grouped into measures (quantitative data) and dimensions (categorical data). Measures and dimensions can be dragged directly to the Chart Canvas or to shelves in the Chart Builder.

**Table 5: Objects on the Measures and Dimensions pane**

<table>
<thead>
<tr>
<th>Object</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Measures</td>
<td>A map to aggregated data in a column or calculation. You use measures to get a calculated result when columns are combined. For example, a measure called Sales Revenue would represent the column Sales Revenue that contains the summed revenue for sales. Measures are automatically detected and listed.</td>
</tr>
<tr>
<td>Dimensions</td>
<td>A data object that represents categorical data in a dataset.</td>
</tr>
<tr>
<td>Object</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Hierarchies</td>
<td>A reference to more than one related column in a dataset; the columns have hierarchical relationships. For example, an object Time could include Year, Quarter, and Month columns arranged in a hierarchical structure under the top object Time.</td>
</tr>
<tr>
<td></td>
<td>Lumira Discovery supports two types of hierarchies:</td>
</tr>
<tr>
<td></td>
<td>● <strong>Offline Hierarchy:</strong> Unlike online data sources, offline data sources don’t have built-in hierarchies. However, often offline data sources have related dimensions that have an inherent hierarchy from which you can build your own hierarchy. For example, a data source may have fields for Country, State, and City. These fields could be grouped into a hierarchy called Location.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong></td>
</tr>
<tr>
<td></td>
<td>When you drop the offline hierarchies to chart, you do not have the option to expand and collapse to any required level unlike online data sources.</td>
</tr>
<tr>
<td></td>
<td>● <strong>Online Hierarchy:</strong> These are built-in hierarchies of SAP BW or SAP HANA. You can access these hierarchies by right-clicking on the column in crosstab or by right-clicking the axis labels for any other charts and choosing the Select Hierarchy option. You can choose to expand or collapse to any required level.</td>
</tr>
<tr>
<td>Attributes</td>
<td>Maps to a column in a dataset.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong></td>
</tr>
<tr>
<td></td>
<td>Supported only for offline dataset.</td>
</tr>
<tr>
<td>Inferred dimensions</td>
<td>One or more columns created from geography or time data that is available to the application (to support a hierarchy).</td>
</tr>
</tbody>
</table>

### 3.7 Column Data Actions

You can find the data actions for columns containing characters, dates, and/or numbers by right-clicking either on the column header or on a measure or dimension pane. The actions that are available depend on the type of data in the column.

Depending on the data type of the selected column or of a particular cell in a column, you can perform the following tasks:

- Duplicate, rename, and remove columns
- Create calculated dimensions
- Find, replace, and change string values
- Fill in prefixes and suffixes
- Convert, trim, and group values
- Edit text strings
### Table 6:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
<th>Available for</th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>Characters</td>
<td>Dates</td>
<td>Numbers</td>
</tr>
<tr>
<td><strong>Duplicate</strong></td>
<td>Inserts a new column that is a copy of this column.</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td><strong>Rename</strong></td>
<td>Changes the name of this column to a specified name.</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td><strong>Split</strong></td>
<td>Divides this column after a specified split point and moves all string values after that point to a new column. The split can be a punctuation mark (for example, a comma) or a text string.</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td><strong>Remove</strong></td>
<td>Removes this column.</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td><strong>Convert Case</strong></td>
<td>Converts text in this column to lowercase or uppercase.</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td><strong>Replace</strong></td>
<td>Finds a specified string in this column and replaces it with another specified string.</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
<td>Available for</td>
<td>Characters</td>
<td>Dates</td>
</tr>
<tr>
<td>--------------</td>
<td>------------------------------------------------------------------------------</td>
<td>---------------</td>
<td>------------</td>
<td>-------</td>
</tr>
<tr>
<td><strong>Fill</strong></td>
<td>Prefixes or suffixes a specified string with a specified character, to a specified length.</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td><strong>Convert to Text</strong></td>
<td>Converts all values in this column to text.</td>
<td>No</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td><strong>Convert to Integer</strong></td>
<td>Converts all values in this column to integers.</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td><strong>Convert to Number</strong></td>
<td>Converts all values in this column to numbers.</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td><strong>Convert to Date/Time</strong></td>
<td>Converts all values in this column to dates, times, or date-times, in the selected format.</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td><strong>Trim</strong></td>
<td>Removes characters in this column before or after a specified punctuation mark or character.</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
<td>Available for</td>
<td></td>
<td></td>
</tr>
<tr>
<td>-----------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>---------------</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Group by Selection</strong></td>
<td>Creates a group for the values selected in this column.</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>If you have multiple groups, then you can add the same column value in one or more group.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Group by Range</strong></td>
<td>Creates a group for a specified range of values in this column.</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td><strong>Create Calculated Dimension</strong></td>
<td>Creates a new column and applies a specified function to values in the new column.</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
<td>Available for</td>
<td></td>
<td></td>
</tr>
<tr>
<td>-----------</td>
<td>-----------------------------------------------------------------------------</td>
<td>---------------</td>
<td>--------</td>
<td>--------</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Characters</td>
<td>Dates</td>
<td>Numbers</td>
</tr>
<tr>
<td><strong>Concatenate</strong></td>
<td>Joins two or more columns, with an optional specified separator and name for the merged column.</td>
<td>No</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td></td>
<td><em>Concatenate</em> options become available when you select two or more columns.</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
# Acquiring Datasets

Before you can build charts and analyze data, you have to acquire data to your Lumira Discovery. A wide variety of data sources are supported in Lumira Discovery.

When acquiring data, the application displays a preview of it, parses the data, and analyzes the columns to determine the data type. Objects representing columns are proposed as either dimensions or measures. You can manually hide some types of columns, based on the column name and data properties.

**Note**

The maximum number of cells that can be acquired is determined by the capacity of your computer. You will be warned when an acquisition includes 30 million cells for 64-bit operating systems, or 15 million cells for 32-bit operating systems.

Depending on the data source, data can be adapted before acquisition to include or remove columns, dimensions, measures, variables, and input parameters. Some data sources have additional options, such as formatting data, naming and trimming columns, and specifying column-name prefixes.

<table>
<thead>
<tr>
<th>Data source</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Microsoft Excel</strong></td>
<td>Loads an Excel worksheet as a dataset</td>
</tr>
<tr>
<td><strong>Text</strong></td>
<td>Loads a text file (.csv or .txt) as a dataset</td>
</tr>
<tr>
<td><strong>Copy from Clipboard</strong></td>
<td>Creates a dataset from data that was copied to the clipboard</td>
</tr>
<tr>
<td><strong>SAP HANA Live</strong></td>
<td>Connects to SAP HANA and delegates calculations to SAP HANA</td>
</tr>
<tr>
<td><strong>SAP HANA Import</strong></td>
<td>Connects to SAP HANA and downloads data from SAP HANA</td>
</tr>
<tr>
<td><strong>SAP BW Live</strong></td>
<td>Connects to SAP BW and delegates calculations to SAP BW</td>
</tr>
<tr>
<td><strong>SAP BW Import</strong></td>
<td>Connects to SAP BW and downloads data from SAP BW</td>
</tr>
<tr>
<td><strong>Query with SQL</strong></td>
<td>Run freehand SQL on a database and download a dataset</td>
</tr>
<tr>
<td><strong>SAP Universe</strong></td>
<td>Connects to SAP Universe and downloads metadata from SAP BusinessObjects universe files (.unx)</td>
</tr>
</tbody>
</table>

**Note**

For some online data sources, such as **SAP HANA Live**, data is not acquired as a dataset and saved in a document. Instead, the data is accessed from the server, and only measures and column names are referenced in the document.
In Lumira Discovery 2.0, when you open a document created using both online and offline datasets, the charts created using offline datasets are rendered. Also, you can see only the offline datasets listed in the Side Bar.

After a dataset is acquired, you can add or remove columns, dimensions, measures, and variables in it.

Related Information

- Acquiring Data from an Excel Workbook [page 62]
- Acquiring Data from SAP HANA views [page 33]
- Acquiring Data from SAP Business Warehouse (BW) [page 40]
- Acquiring Data Using Query with SQL [page 52]
- SAP Universe [page 59]
- Acquiring Data Copied to Clipboard [page 67]
- Acquiring Data from a Text File [page 65]

4.1 Viewing a Data Source Connection and its Associated Documents

You can view all connections defined for the application, and the documents associated with each connection, and change the target data source for locally defined connections.

Procedure

1. On the home page, under Used Connections, choose Show More. The All Connections panel appears towards the right with a list of all available data source connections. Select a connection to display a list of documents associated with it. In the Documents you can find a list of the documents associated with each connection. If you choose Excel under the All Connections pane for example, documents based on the Excel are listed in Documents.

2. You can choose a data source link under All Connections pane and start acquiring data.

3. (Optional) To change the data source connection for a document, choose (Edit).

Related Information

Home Page [page 18]
4.2  Acquiring Data from SAP HANA views

You can acquire data from SAP HANA analytic or calculation views.

Data in an SAP HANA database is accessible in a "view". This is a predefined virtual grouping of table columns that enables data access for a particular business requirement. Views are specific to the type of tables that are included, and to the type of calculations that are applied to columns. An attribute view is built on dimension tables for example, while an analytic view is built on a fact table and attribute views, and a calculation view executes a function on columns when the view is accessed.

You can connect to SAP HANA views in two ways:

- By downloading data from SAP HANA
  Data is copied locally and can be modified and edited before being visualized in charts.
- By connecting to data in SAP HANA
  Data is read-only (you cannot edit it), but you can visualize it in charts.

After connecting to a view, data is presented as columns, facets, measures, dimensions, and hierarchies in the application.

Related Information

Connecting to SAP HANA [page 33]
Downloading Data from SAP HANA [page 36]

4.2.1 Connecting to SAP HANA

While connected to SAP HANA, you can view data and create visualizations from a SAP HANA cube. Enable InA connection to configure a HTTP connection on the SAP BI Platform and SAP HANA.

Prerequisites

- You need to know your SAP HANA server name, port number, user name and password. For more information, contact your SAP HANA administrator.
Procedure

1. On the Home Page, select **SAP HANA Live**.
   The **SAP HANA Live Data** dialog box appears.

2. Select either a direct connection to the **SAP HANA** (offline connection), or log on to the **SAP BI Platform** (online connection) to access the managed OLAP connections to SAP HANA.
   - For a connection to the **SAP HANA**, proceed as follows:
     1. Select **SAP HANA**.
     2. Select the server host name and the port number. Also, to have a secured HTTPS connection, prefix the server host name with https.
        HTTPS connection supports Secure Socket Layer (SSL) connection and Transport Layer Security (TLS) connection. For more information on SSL configuration, refer to the following:
        - A blog on SSL configuration at https://blogs.sap.com/2017/03/14/bi-platfrom-ssl-is-now-supported-by-lumira-1.31.4/.
     3. Enter your username and password.
     4. Choose **Connect**.
     5. In the **Select Data Source** dialog box, search for the required view.
        The search returns the list of available SAP HANA views.
     6. Expand the SAP HANA view that contains the data to view, and choose the cube that contains the data.
     7. Choose **OK**.
   - **SAP BI Platform**-OLAP (managed) connections allow you to directly acquire data from the SAP HANA database without having to remember your credentials.
     For SAP HANA Live connections, it is better to use OLAP (i.e. managed) connections as it has better SAP BI Platform security capabilities compared to Local connections. For a connection to the SAP BI Platform, proceed as follows:
     1. Select **SAP BI Platform**.
     2. Enter the system name. Also, to have a secured HTTPS connection, prefix the system name with https.
        HTTPS connection supports Secure Socket Layer (SSL) connection and Transport Layer Security (TLS) connection. For more information on SSL configuration, refer to the following:
        - A blog on SSL configuration at https://blogs.sap.com/2017/03/14/bi-platfrom-ssl-is-now-supported-by-lumira-1.31.4/.
     3. Enter the BI Platform connection details like username and password.
     4. Select the authentication type.
     5. Choose **Next**.
        The **Select an SAP HANA data source** dialog box appears.
     6. You can filter the list of available OLAP connections to HANA from the drop-down list. Alternatively, you can apply a search, based on key words, for the specific OLAP connection.
     7. Select an OLAP connection.
        In this release, only a predefined connection is supported where the system saves password for the SAP HANA database.
8. Choose Connect. The Select Data Source dialog box appears.

9. Search for the required SAP HANA view that contains the data to view, expand it (if required) and choose the cube that contains the data

10. Enter values for variables, if any.

11. Choose OK.

You can start analyzing your data by building charts.

Related Information

Restrictions for Connecting to SAP HANA [page 35]
Downloading Data from SAP HANA [page 36]

4.2.1.1 Restrictions for Connecting to SAP HANA

When connected to an SAP HANA online data source, the following restrictions apply:

- The Change Aggregation action that is typically available for each measure in the Measures and Dimensions panel is not available.
- These actions that are typically available for each dimension in the Measures and Dimensions panel are not available:
  - Convert to Number
  - Convert to Text
  - Convert to Date/Time
  - Create a measure
  - Create a date/time hierarchy
  - Create a custom hierarchy
  - Create a geographic hierarchy by Latitude / Longitude
  - Duplicate
  - Merge this column
  - Create Calculated Dimension
- Although you cannot create date/time hierarchies, any level-based hierarchies that are modeled specifically as time hierarchies in your HANA views will be treated as time hierarchies by SAP BusinessObjects Lumira. For details, see the section titled “Considerations for working with SAP HANA” in the SAP Lumira Installation Guide.
- Although you cannot create custom hierarchies, any regular level-based hierarchies that are modeled in HANA will be treated by Lumira similarly to custom hierarchies.
- Although you can create a geographic hierarchy “By Names”, the resultant geographic hierarchy will have only one level.
- The “Create New Dataset” action is not available from each visualization’s thumbnail in the visualization gallery.
- Additional datasets can be added only from the same instance of the first SAP HANA dataset, using the same SAP HANA connection. It is not possible to acquire data from other data sources.
The following SAP HANA functions are not supported in calculated measures or dynamic text:

- AddMonthToDate
- AddYearToDate
- LastDayOfMonth
- DayOfYear
- Week
- LastWord
- ExceptLastWord

4.2.2 Downloading Data from SAP HANA

You can manipulate data and create visualizations from an SAP HANA cube. While acquiring data, you can also choose to filter the dimensions, measures and hierarchies that you want to use while creating visualizations.

Prerequisites

You must know your SAP HANA server name, port number, user name, and password. For more information, contact your SAP HANA administrator.

Procedure

1. On the Home page, select SAP HANA Import.

   The Import data from SAP HANA dialog box appears.

2. Select either a direct connection to the SAP HANA, or log on to the SAP BI Platform to access the managed OLAP connections to SAP HANA.

   - For a connection to the SAP HANA, proceed as follows:
     1. Choose SAP HANA.
     2. Select the server to log on to from the Server list.
     3. Enter the Instance number.
     4. To connect to the SAP HANA server, perform one of the following:

   Table 8:

<table>
<thead>
<tr>
<th>Section</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>If you connect by entering credentials</td>
<td>Enter your user name and password, and choose Connect.</td>
</tr>
<tr>
<td>Section</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>If you connect via Single Sign-on (SSO)</td>
<td>Select the <strong>Authenticate by Operating System (SSO)</strong> checkbox, and choose <strong>Connect</strong>.</td>
</tr>
<tr>
<td>If you connect via Secure Sockets Layer (SSL)</td>
<td>Select the <strong>Enable SSL</strong> checkbox, and choose <strong>Connect</strong>. For more information on SSL connection, refer to the following:</td>
</tr>
<tr>
<td></td>
<td>○ A blog at <a href="https://blogs.sap.com/2017/03/14/bi-platform-ssl-is-now-supported-by-lumira-1.31.4/">https://blogs.sap.com/2017/03/14/bi-platform-ssl-is-now-supported-by-lumira-1.31.4/</a></td>
</tr>
</tbody>
</table>

The offline connections are created using JDBC connection and online connections are created using SAP HANA INA connection.

5. Choose **Connect**.
   The search returns the list of available SAP HANA views.
6. Expand the SAP HANA view that contains the data to view, and choose the cube that contains the data.
7. Choose which data to acquire:
   ○ To acquire particular dimensions and measures in the data, select Next, choose the dimensions and measures, and select OK.
   ○ To acquire all data, select Create.
   ○ To view the sample values of the dimension, click the link under **Values Preview**.
   ○ To filter dimensions, choose the filter icon.
8. Choose **Visualize**.

○ SAP BusinessObjects BIP-managed connections allow you to directly acquire data from the SAP HANA database without having to remember your credentials. For a connection to the SAP BusinessObjects BI Platform, proceed as follows:
1. Enter the BI Platform connection details system name, username and password. Also, if you want to have a secured connection, Select the **Enable SSL** checkbox.
   For more information on SSL connection, refer to the following:
   ○ “Configuring HTTP/SSL” chapter under ”Managing Web Application Container” in the *Business Intelligence Platform Administrator Guide*, at https://uacp2.hana.ondemand.com/viewer/2e167338c1b24da9b2a94e68efd79c42/4.2.4/en-US/467d50b06e041014910aba7db0e91070.html.
   ○ A blog at https://blogs.sap.com/2017/03/14/bi-platform-ssl-is-now-supported-by-lumira-1.31.4/.
2. If you want to save your password, select **Remember me**.
3. Choose **Connect**.
4. Select an OLAP connection, and choose **Next**.
The following OLAP connections are supported:

- **Single sign-on (SSO)**: System establishes connection via single sign-on.
  
  **Note**

  SSO in HANA Managed connection works only if you have configured Kerberos SSO in the system where you have installed Lumira Discovery and the SAP HANA system that you are trying to connect to.

- **Predefined**: System saves the password for the SAP HANA database.

5. You can apply a search, based on key words, for the specific OLAP connection. The search returns the list of available SAP HANA views.

6. Expand the SAP HANA view that contains the data to view, and choose the cube that contains the data.

7. Choose **Next**.

8. Select the dimensions and measures you want to download to your Lumira Discovery dataset.

9. Choose **Create**.

**Results**

You can start analyzing your data by building charts. Choose **DataView** if you want to modify the dataset or check the dimension values that you have filtered.

**Related Information**

- Downloading Data from SAP HANA [page 36]
- Acquiring Data from SAP HANA views [page 33]

### 4.2.3 Accessing SAP BW data in SAP HANA views

You can access SAP Business Warehouse (BW) data that is available in SAP HANA analytic or calculation views.

In an SAP BW-on-SAP HANA system, you can use the SAP HANA modeler to import SAP BW models (for example, SAP HANA-optimized cubes, Data Store Objects (DSO), and BW Query Snapshots) as analytic views and calculation views. Once the models are activated, the application can consume them by connecting to an SAP HANA cube.

4.2.4 Specifying values for SAP HANA variables and string input parameters

You are prompted to enter a value for an SAP HANA variable or a string input parameter when acquiring an analytic view in Download from SAP HANA One mode and when creating a document on an analytic view in Connect to SAP HANA One mode.

Context

Each SAP HANA variable defines a filter on a dimension of a view. You enter a value for each dimension before data is acquired, and the value appears as a facet row after acquisition.

You enter a value for each SAP HANA input parameter when acquiring data, and SAP BusinessObjects Lumira passes the value to a calculation, such as a formula for a calculated measure. When entering a value for a string input parameter, you must enter an SQL statement, using single quotes to indicate the beginning and end of the statement string. For example, enter `BUKRS='CALP'` to search for CALP.

Procedure

1. Connect to an SAP HANA instance in Download from SAP HANA One or Connect to SAP HANA One mode.
2. Choose which data to acquire:
   - To acquire particular data, select an analytic view, select Preview and select data, select Select, choose the dimension values and measures, and select Edit Variables.
     When no variables or input parameters are defined in a view, the Edit Variables button is not available.
   - To acquire all data available in an analytic view, choose the view, and select Create.
     A HANA Variables box appears, listing the variables and input parameters defined for the analytic view. Variables are prefixed by "VAR" and input parameters are prefixed by "IP."
3. Choose a variable or an input parameter.
   The dimension or input parameter value appears in the right pane.
4. Choose one or more values, and select Add.
   To choose multiple individual values, press and hold `Ctrl` and select each value. To choose a range of values, press and hold `Shift` and select the first and last value in the range.
   The selected values appear in the bottom pane.
5. Select OK.
6. If you are acquiring data through Preview and select data, select Create to start the data acquisition.
Data appears in the Prepare room, and each variable appears as a facet with the selected prompt values.

Results

The Variables button appears at the top of the facets pane. Select the button to view the values you chose for SAP HANA variables.

4.3 Acquiring Data from SAP Business Warehouse (BW)

Lumira Discovery lets you access BEx queries from an SAP BW system. SAP BW connectivity allows you to connect to SAP Business Explorer (BEx) queries or InfoProviders. After you acquire data in Lumira Discovery, you can perform the following data discovery actions:

- Interact with, manipulate, and experiment with the BW data
- Apply data transformations to the BW data
- Merge BW data with other data sources
- Build visualizations and compose stories

You can connect to BW queries and acquire a slice of BW data into Lumira Discovery. It is important to understand how the data is acquired. The following sections describe specific BEx query concepts that you should be aware of, and known limitations.

Connect to existing BEx queries on a BW 7.x system

Your organization might have invested in and refined your BEx queries over time. While Lumira Discovery is not positioned for the same use cases (OLAP analysis) as the Analysis client applications, Lumira Discovery is able to leverage that investment in queries by allowing connection to the BW 7.x systems.

Answer the BEx variables

It is common for BEx queries to have BW variables defined in them. Variables are important both for filtering data and for guaranteeing that users see the correct data (for example, using key date and exit variables) and only the data they have permission to see (using authorization variables).
Select the BW metadata

You can choose the specific dimensions and measures to acquire. The selection of dimensions and measures is important because it influences the volume of data acquired, and because certain BEx query concepts directly influence the acquired BW data values (BEx conditions and zero suppression for example).

Note

This is not applicable for BW online however, as the data is not acquired as a dataset and saved in a document. Instead, the data is accessed from the server, and only only the measures and column names are referenced in the document.

Acquire BW data into Lumira Discovery

Although your organization’s BEx queries may be highly developed, a query rarely corresponds 100% to a user’s needs. In many cases, you may need to trim, split, or concatenate fields in preparation for creating a visualization, or merging with another dataset. You can benefit from the many data preparation features that Lumira Discovery offers.

Once the BW data is acquired, the data is stored in a local Lumira Discovery file. Interactions and calculations performed on the BW data do not access the BW OLAP engine. Refreshing of the BW data values in Lumira Discovery is possible, but the refresh is based on the dimensions and measures that you selected at data-acquisition time. For information on key design behaviors and limitations while interacting with local BW data, see the following sections.

Related Information

Connecting to SAP BW [page 41]
Downloading a BW Dataset [page 43]
Support for SAP BW Structures [page 51]

4.3.1 Connecting to SAP BW

Prerequisites

Before you can connect to a SAP BW, you need to register that system through SAP GUI for Windows on the same computer. It is recommended that you test the connectivity of the registered BW system via SAP Logon before using it in Lumira Discovery. Refer to the SAP GUI for Windows documentation to configure a new system. To download SAP GUI for Windows, go to SAP Service Marketplace.

The list of available BW servers is derived from SAP Logon.
You need to know your SAP BW details, including the server name, port number, user name and password. For more information, contact your SAP BW administrator.

(Optional) You have configured SAP BW server with SNC connection in SAP Logon. For more information, see Configuring Secure Network Communication (SNC) [page 51]

**Procedure**

   
   The SAP BW Live Data dialog box appears.

2. Select either a direct connection to the SAP BW, or log on to the SAP BI Platform to access the managed OLAP connections to SAP BW.

   - For a connection to the SAP BW, proceed as follows:
     1. Select SAP BW.
     2. Select the server to log on to from the dropdown list.
     3. Enter the client identification number.
     4. Enter BW connection details like username, password, and language.
     5. If you have selected SNC configuration, you do not have to re-enter Username and Password.
     6. Choose Connect.
        
        The Select Data Source dialog box appears.

   - SAP BI Platform managed connections allow you to acquire data directly from the SAP BW database without having to remember your credentials.
   
   For a connection to the SAP BI Platform, proceed as follows:

   1. Select SAP BI Platform.
   2. Enter the BI Platform connection details system name, username and password.
   3. If you have selected SNC configuration, you do not have to re-enter Username and Password.
   4. Select the Authentication type from the dropdown list.
   5. Choose Next.
   6. Select an OLAP connection, and select Next.
      
      The following OLAP connections are supported:

      - **Single sign-on (SSO)**: System establishes connection via single sign-on.

      - **Predefined**: System saves the password for the SAP HANA database

      7. You can apply a search based on key words for the specific OLAP connection. The search returns the list of available SAP HANA views

      8. Expand the SAP HANA view that contains the data to view, and choose the cube that contains the data.

      9. Choose Next.
10. Select the dimensions and measures you want to download to your Lumira Discovery dataset.
11. Choose Visualize.

Related Information

4.3.2 Downloading a BW Dataset

You can download a BW dataset from either a local SAP BW system or the SAP BusinessObjects BI Platform.

Prerequisites

Before you can connect to a SAP BW, you need to register that system through SAP GUI for Windows on the same computer. It is recommended that you test the connectivity of the registered BW system via SAP Logon before using it in Lumira Discovery. Refer to the SAP GUI for Windows documentation to configure a new system. To download SAP GUI for Windows, go to SAP Service Marketplace.

The list of available BW servers is derived from SAP Logon.

You need to know your SAP BW details, including the server name, port number, user name and password. For more information, contact your SAP BW administrator.

(Optional) You have configured SAP BW server with SNC connection in SAP Logon. For more information, see Configuring Secure Network Communication (SNC) [page 51].

Context

SAP BW connectivity allows you to connect to SAP Business Explorer (BEx) queries or InfoProviders. After you acquire data in Lumira Discovery, you can perform the following data discovery actions:

- Interact with, manipulate, and experiment with the BW data
- Apply data transformations to the BW data
- Merge BW data with other data sources
- Build visualizations and compose stories
- Share data in a visual manner with other users in your organization
Procedure

1. On the Home Page, choose SAP BW Import.
   The Import data from SAP BW dialog box appears.
2. Select either a direct connection to a SAP BW, or log onto the SAP BI Platform to access the managed OLAP connections to BW.

   ○ For a connection to a SAP BW:
     1. Enter the BW connection details like username, password and language.
     2. If you have selected SNC configuration, you do not have to re-enter Username and Password.
     3. Choose Connect.
     4. Search and choose a BEx Query, and then choose Create.
        You can apply a search, based on keywords, for your BEx Query, using the Roles or InfoAreas view.
     5. Enter values for variables of the BEx Query, if any.
     6. Select the dimensions and measures you want to download to your Lumira Discovery dataset.
     7. Choose Create.

   ○ For a connection to SAP BI Platform:
     1. Enter the BW connection details like username, password and language.
     2. If you have selected SNC configuration, you do not have to re-enter Username and Password.
     3. Choose Connect.
     4. Select an OLAP connection, and choose Next.
        You can filter the list of available OLAP connections to BW using the Show Connections dropdown list. Alternatively, you can apply a search, based on keywords, for the specific OLAP connection.
     5. Enter values for variables of the BEx Query, if any.
     6. Select the dimensions and measures you want to download to your Lumira Discovery dataset.
     7. Choose Create.

Note

While acquiring or editing the data from the BW dataset to Lumira Discovery or while refreshing the BW dataset in SAP Lumira, server for BI platform, if you obtain the following error message: Result set too large (XXXXX cells). Data retrieval restricted by configuration (Maximum=XXXXX cells), then perform the following:

1. Navigate to the location where you have installed Lumira Discovery. For example, Program Files.
2. In this directory, choose SAP BusinessObjects
   - DBICS_DA_RESULT_SET_LIMIT_DEF=500000
3. Lumira > Lumira Discovery > SBOPLumiraDiscovery.ini
4. Open the SBOPLumiraDiscovery.ini file with administrator rights.
5. Modify the cell limit by increasing the Maximum value according to your requirements in the following code snippet:
   - DBICS_DA_RESULT_SET_LIMIT_MAX=1000000
   Ensure that the MAXIMUM value is always greater than the DEFAULT value.
6. Save the file and restart the application.
Next Steps

For details on supported BEx query features relevant to SAP BW data acquisition, see this SAP note: 1869560.

i Note

In Lumira Discovery, each SAP BW variable defines a filter on a dimension of a view. In this release, you can select dimensions and filter the selected dimensions while acquiring the dataset in SAP BW.

Related Information

Acquiring Data from SAP Business Warehouse (BW) [page 40]
Connecting to SAP BW [page 41]
Data Acquisition Design Behaviors and Known Limitations [page 45]

4.3.2.1 Data Acquisition Design Behaviors and Known Limitations

Be aware of design behaviors and limitations regarding BW query concepts.

For details on supported BEx query features relevant to SAP BW data acquisition, see this SAP note: 1869560.

Related Information

SAP BW Hierarchy Support [page 47]
SAP BW Filtering Support [page 48]
Limitations with SAP BW Measures [page 49]
Limitations with Mixed Currency and Unit Symbols [page 49]
Understanding SAP BW Data Acquisition [page 46]
Restrictions and Usage Patterns [page 50]
4.3.2.1.1 Understanding SAP BW Data Acquisition

Learn the specific BEx query concepts you need to know for SAP BW data acquisition, as well as known limitations.

Lumira Discovery lets you access BEx queries from an SAP BW system. You can connect to BW queries and acquire a slice of BW data into Lumira Discovery. It's important to know how the data is acquired.

The SAP BW data source allows you to do the following:

Connect to existing BEx queries on an SAP BW 7.x system

Your organization might have invested in and refined your BEx queries over time. While Lumira Discovery is not positioned for the same use cases (OLAP analysis) as the Analysis client applications, Lumira Discovery is able to leverage that investment in queries by allowing connection to the BW 7.x systems.

Answer the BEx variables

It is common for BEx queries to have BW variables defined in them. Variables are important not only for filtering data, but also for guaranteeing that users see the correct data (for example, using key date and exit variables) and only the data they have permission to see (using authorization variables).

Select the SAP BW metadata

You can choose the specific dimensions and measures to acquire. The selection of dimensions and measures is important because it influences the volume of data acquired, and because certain BEx query concepts directly influence the acquired BW data values (for example, BEx conditions and zero suppression).

Acquire SAP BW data into Lumira Discovery

Although your organization's BEx queries may be highly developed, a query rarely corresponds to 100% of a user's needs. In many cases, you may need to trim, split, or concatenate fields in preparation for creating a visualization, or merging with another dataset. You can benefit from the many data preparation features that Lumira Discovery offers.

Once the SAP BW data is acquired, the data is stored in a local Lumira Discovery file. Interactions and calculations performed on the BW data do not access the BW OLAP engine. Refreshing of the BW data values in Lumira Discovery is possible, but the refresh is based upon the dimensions and measures that were selected at data-acquisition time. For information on key design behaviors and limitations while interacting with local BW data, see the following sections.
**Note**
In this release, you can choose the date format while acquiring data in BW. However, if you have not chosen any specified format, then the BW considers default date format.

### 4.3.2.1.2 SAP BW Hierarchy Support

Lumira Discovery supports SAP BW hierarchies. Here’s what you need to know.

BW hierarchies can be acquired into Lumira Discovery. The BW hierarchies are flattened into level-based dimensions as part of the acquisition process.

The parent-child relationship of BW hierarchies is not supported, but after the hierarchy is acquired as level-based dimensions, you can use the custom hierarchy feature to build the acquired dimensions into a level-based hierarchy. The custom hierarchy can then be used for visualizations.

#### BW time-generated hierarchies

Lumira Discovery supports a time hierarchy concept as a single data type. For any given level of a standard BW time hierarchy, nodes and leaves may be of mixed data types (for example, nodes are of data type String, while leaves are of data type Date or Time). Lumira Discovery assigns only the data type String to a hierarchy level column. You can create visualizations with the acquired hierarchy, but the data points may not be ordered chronologically as expected, because of the mapping to data type String.

#### BW hierarchical structures

You cannot acquire BW hierarchical structures (either dimension-based or measure-based).

#### BW hierarchies with link nodes

BW hierarchies and the data relating to link nodes can be acquired. However, the context of data values that represent the link node is not persisted. Be careful when performing aggregations on the BW data, because double-counting of link nodes cannot be avoided.

Changing of hierarchies in Lumira Discovery

Changing of BW hierarchy context within a visualization or story is not supported. This applies to BEx queries containing the following BW prompting scenarios:

- Hierarchy variables (and hierarchy node variables)
- Key date variables driving a change in context, where entire hierarchies are modelled as time-dependent

4.3.2.1.3 SAP BW Filtering Support

Lumira Discovery provides support for SAP BW filtering.

Filtering of BW data is an integral part of the overall BW data acquisition workflow. Lumira Discovery is able to leverage data filtering defined in the BEx query via the following configurations:

- BEx query filters defined on dimensions
- BW variable prompting
- BEx conditions
- Zero suppression

Lumira Discovery offers limited support of BEx conditions and zero suppression:

BEx conditions

BEx conditions defined along the row are supported at the time of data acquisition. You can select the dimensions to acquire, and define a specific ordering for the dimensions. The ability to order the dimensions prior to data acquisition is necessary, because the acquisition of data takes into account the BEx condition rule defined in the query (for example, Top 3 Product Sales), and how the aggregation will be applied (for example, Top 3 per Region for all Countries).

**Note**

At the time of selection of dimensions and measures for data acquisition, the row/column structure of the underlying BW query is not reflected. When you select the dimensions, they are conceptually placed into a row axis. Because of this behavior, BEx conditions at data acquisition time in Lumira Discovery may not produce the results you expect, compared to the underlying BW query definition.

Once data is acquired in Lumira Discovery, the concept of BEx conditions is not supported. The calculation of the data aggregation based on the placement or ordering of dimensions in a Lumira Discovery crosstab or visualization is performed locally on the acquired data.

BEx conditions defined along the column are not supported at the time of data acquisition. When there are active BEx conditions along the column defined in the BW query, the conditions are ignored and do not influence the acquisition of BW data in Lumira Discovery.

For more information on BEx conditions, see this page: https://help.sap.com/saphelp_nw70/helpdata/en/43/2695d2fd2f0d23e10000000a1553f7/content.htm.
Zero suppression

Zero suppression defined along the rows is supported at the time of data acquisition. Zero suppression defined along the columns is not supported at the time of data acquisition.

Once data is acquired in Lumira Discovery, the concept of zero suppression is not supported. The calculation of selected measures in a Lumira Discovery crosstab or visualization is performed locally on the acquired data.

For more information on zero suppression, see this page: http://help.sap.com/saphelp_nw70/helpdata/en/a4/dd3841d132d92be10000000a1550b0/content.htm.

4.3.2.1.4 Limitations with SAP BW Measures

Be aware of the limitations for SAP BW measures.

For BW formula-based measures, the aggregation state in Lumira Discovery is detected as “none” because the aggregation is not known during data acquisition. Lumira Discovery is unable to determine the aggregation based on available information from BICS. This can lead to unexpected data results when the acquired measure is used in Lumira Discovery visualizations, where aggregation is expected.

In this scenario, Lumira Discovery will not automatically determine how to aggregate the BW data. However, you can manually change the aggregation of a measure in Lumira Discovery, once data is acquired.

4.3.2.1.5 Limitations with Mixed Currency and Unit Symbols

Be aware of the limitations for unit and currency symbols in measures.

Lumira Discovery does not support the acquisition of a unit or currency symbol assigned to a measure. A measure can be configured with a custom symbol, such as a unit or currency, by using the Display Formatting feature in Lumira Discovery. However, Lumira does not support the situation where the display of mixed units and currency symbols is required.

In addition, Lumira Discovery does not support the situation where aggregation of values of different currencies is required.
4.3.2.1.6 Restrictions and Usage Patterns

Be aware of restrictions and usage patterns.

Delegated search for prompts

Delegated search is supported for LOV (list of values) prompts, with the exception of the following prompt types:

- Date
- Time
- Hierarchy variable
- Hierarchy node variable

When using delegated search on LOV prompts, these are the restrictions and usage patterns:

- Search is based on the selected LOV presentation (Text or Key or Text & Key), and is case-sensitive.
- When Text & Key presentation is selected, the delegated search is based on Key first. If no Key values are returned, then a delegated search is performed by Text.
- Use of search wildcards is supported: *+, +” represents a single character.

Selection Option variable support

Manual entry of Key values is possible as part of Selection Option variable support. The use of the “*” wildcard pattern as part of the Key value is permitted (but not the “+” wildcard).

Examples:

- *3* works.
- *3 works.
- * works.
- A value followed by a wild card (for example, 3*) does not work.

Other known limitations:

- Entering Key values by using pattern matching does not trigger the highlighting of associated selections in the list of values.
- Pattern matching is supported only in conjunction with the use of the operators = or !=. For example, combinations of the operator > and *3 do not work.
4.3.3 Configuring Secure Network Communication (SNC)

Secure Network Communications (SNC) integrates SAP NetWeaver Single Sign-On or an external security product with SAP systems.

Context

With SNC, you strengthen security by using additional security functions provided by a security product that are not directly available with SAP systems. SNC secures the data communication paths between the various SAP system client and server components.

After enabling SNC configuration, you can directly connect to SAP BW Live or SAP BW Import without providing Username and Password again in Lumira Discovery. For more information, refer to “Configuring Secure Network Communication (SNC)” chapter in Business Intelligence Platform Administrator Guide at https://help.sap.com.

Procedure

1. Launch SAP Logon.
2. Select the SAP BW server you want to connect to.
3. Right-click the selected server and select Properties.
   The System Entry Properties dialog box appears.
4. Navigate to the Network tab and select the Activate Secure Network Connection option.
5. Choose OK.

Related Information

Data Acquisition Design Behaviors and Known Limitations [page 45]
Connecting to SAP BW [page 41]
Acquiring Data from SAP Business Warehouse (BW) [page 40]
Downloading a BW Dataset [page 43]

4.3.4 Support for SAP BW Structures

Lumira Discovery can connect to and acquire data from SAP BW queries with structures. Lumira Discovery supports data acquisition from two types of structures: dimension structures, and measure structures.
Known data acquisition behaviors

The dimension structure is always added to the metadata explorer result set, and can’t be removed.

The hierarchical context is lost when data from a BW structure is acquired, both for dimension-based and measure-based structures. For example, the result set of the dimension structure is always a pivot, and not a hierarchy. This is to ensure that the measure values are accurate. Also, the aggregation type for the measure values is set to “None”.

An auto-generated ordinal numeric key (1, 2, 3, and so on) is required as part of the data acquisition step, to drive the order of the dimension structure. This key will appear as a column in the Data View, and should be associated with the dimension structure so that when the dimension structure is displayed in a visualization, the data is in the correct order.

4.4 Acquiring Data Using Query with SQL

You can create a data provider by entering the SQL for a target data source manually. You can specify the source tables, columns, and functions used to acquire data.

For a complete list of database middleware that Query with SQL can access, see the SAP Product Availability Matrix.

Table 9: Supported database middleware drivers

<table>
<thead>
<tr>
<th>Supported database middleware</th>
<th>How to obtain the driver</th>
</tr>
</thead>
<tbody>
<tr>
<td>Amazon Redshift</td>
<td>The Simba Redshift driver is included with Lumira Discovery.</td>
</tr>
<tr>
<td>Apache Spark</td>
<td>Manually install the driver in Lumira Discovery as described in the section “Installing Data Access Drivers”. Select the Generic JDBC datasource - JDBC Drivers database. The driver binaries are located at &lt;InstallDir&gt;\Program Files\SAP BusinessObjects Lumira\Lumira Discovery\Desktop\utilities\SparkJDBC\ There are multiple .jar files at this location. Select all of them during driver installation.</td>
</tr>
<tr>
<td>Apache</td>
<td>Amazon EMR and Apache Hive Simba drivers are included with Lumira Discovery.</td>
</tr>
<tr>
<td>Cloudera</td>
<td>The Cloudera Impala Simba driver is included with Lumira Discovery.</td>
</tr>
<tr>
<td>Supported database middleware</td>
<td>How to obtain the driver</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>--------------------------</td>
</tr>
<tr>
<td><strong>IBM DB2</strong></td>
<td>Go to the IBM DB2 connectivity download page at <a href="https://www.ibm.com/account/profile/us?page=reghelpdesk">https://www.ibm.com/account/profile/us?page=reghelpdesk</a>. Choose the appropriate driver for your database, save the compressed installation file to your computer, extract the compressed file (db2jcc.jar) to a local directory, and run the installer from your computer. For versions earlier than 9.5, you must extract db2cc.jar and db2jcc_license_cu.jar instead. Before you can download a driver, you must register using a free IBM-recognized user e-mail address as the account name. If you do not know which version of the driver to use, both drivers for DB2 version 10.1 [DB2 version 10.1 FP0 (GA) and version 10] are suitable for all versions later than DB2 version 9.5. For more information, contact your database administrator.</td>
</tr>
<tr>
<td><strong>IBM Netezza</strong></td>
<td>See your Netezza administrator.</td>
</tr>
<tr>
<td><strong>Microsoft SQL Server</strong></td>
<td>Go to the SQL Server 2005, 2008, and 2012 Microsoft Drivers download center page at <a href="http://www.microsoft.com/en-us/download/driver.aspx?q=driver">http://www.microsoft.com/en-us/download/driver.aspx?q=driver</a>. Choose the appropriate driver for your database, save the installation file to your computer, and run the installer from your computer. If you don't know which version of the driver to use, Microsoft JDBC Driver 4.0 for SQL Server is suitable for all supported SQL server versions. If you are installing JDBC Driver 4.0 for SQL Server, the driver is sqljdbc_4.0.2206.100_enu.exe for a Windows operating system. The sqljdbc4.jar driver file is extracted to <code>\sqljdbc_4.0\enu\</code> in the specified extraction folder.</td>
</tr>
<tr>
<td><strong>Oracle</strong></td>
<td>Go to the Oracle JDBC Driver Downloads page at <a href="http://www.oracle.com/technetwork/database/features/jdbc/index-091264.html">http://www.oracle.com/technetwork/database/features/jdbc/index-091264.html</a>. Before you can download a driver, you must create a free user account. If you don't know which version of the driver to use, ojdbc14.jar is suitable for any supported version of Oracle 10 and 11.</td>
</tr>
<tr>
<td><strong>Salesforce</strong></td>
<td>The Salesforce driver is installed by default. You do not need to install it. However, you need to get a logon token to be able to acquire Salesforce data. Log on to the Salesforce website and go to My Settings &gt; Personal &gt; Reset My Security Token. A logon token will be sent to you by e-mail. Append the token to the end of your password when logging on to Lumira Discovery.</td>
</tr>
<tr>
<td><strong>Sybase</strong></td>
<td>The Sybase driver (jconn4.jar) is installed by default; you do not need to install it. It is located at <code>\&lt;InstallDir&gt;\program Files\SAP BusinessObjects Lumira Discovery\desktop\plugins\com.businessobjects.connectionserver.standalone_3.1.3.v20120603-0404\connectionserver\jdbc\drivers\jdbc\</code>.</td>
</tr>
</tbody>
</table>
Supported database middleware | How to obtain the driver
--- | ---
Teradata | Go to the Teradata connectivity download page at [http://downloads.teradata.com/download/connectivity/jdbc-driver](http://downloads.teradata.com/download/connectivity/jdbc-driver). Choose the appropriate driver for your database, save the compressed installation file to your computer, extract the compressed file to a local directory, and run the installer from your computer.
Before you can download a driver, you must create a free user account. If you don’t know which version of the driver to use, the Teradata JDBC Driver 14 is suitable for all supported Teradata versions. For Windows, use `TeraJDBC__indep_indep.14.00.00.14.zip`. Once extracted, the driver files are `tdgssconfig.jar` and `terajdbc4.jar`.
IBM Puredata | See your Netezza administrator.
Informix Dynamic | See your IBM administrator.
GreenPlum 4 | See your GreenPlum administrator.

Table 10: JDBC drivers for typical database middleware

<table>
<thead>
<tr>
<th>Database middleware</th>
<th>JDBC driver available</th>
</tr>
</thead>
<tbody>
<tr>
<td>Oracle</td>
<td><code>ojdbc14.jar</code></td>
</tr>
<tr>
<td>Microsoft SQL Server</td>
<td><code>sqljdbc4.jar</code></td>
</tr>
<tr>
<td>Teradata</td>
<td><code>terajdbc4.jar</code> and <code>tdgssconfig.jar</code></td>
</tr>
<tr>
<td>Sybase</td>
<td><code>jconn4.jar</code></td>
</tr>
<tr>
<td>IBM DB2</td>
<td><code>db2jcc.jar</code> or <code>db2cc.jar</code> and <code>db2jcc_license_cu.jar</code> for versions earlier than 9.5</td>
</tr>
<tr>
<td>IBM Netezza</td>
<td><code>nzjdbc.jar</code></td>
</tr>
</tbody>
</table>

### 4.4.1 Installing Data Access Drivers

All the SAP drivers are automatically installed in the application. For other databases, you need to install the JDBC data access driver for your database middleware, before using Query with SQL.

**Prerequisites**

- You must be familiar with your database and with the SQL language.
- The correct data access driver must be installed for your database middleware. A data access driver is the software provided by a database vendor that allows a client application to connect to middleware and to
access data in a database. You copy the data access driver for your middleware from your database vendor support website to a local folder, and then you can select the driver in the application and connect to the database.

**Note**

Installing data access drivers from a vendor site can be problematic due to the variety of driver versions and file formats. If you are unfamiliar with your database version or the vendor website, contact your database administrator.

**Context**

Follow these general steps to obtain a data access driver:

1. Download the data access driver (a .jar file) from the database vendor site, and copy the file to a local folder.
2. Register the driver path by selecting the driver in the application.
3. Select a Query with SQL data source on the *Query with SQL* tab in the application preferences.
   You can select an installed SQL driver or install the required driver.

**Procedure**

1. Select Preferences > SQL Drivers. The *Driver Installation* page lists database middleware names and the status of drivers:
   - If the status check mark is green, the driver is correctly installed, and you can start using Query with SQL.
   - If the status check mark is red, the driver is not installed for that middleware, and you have to install it.
   - If the status check mark is yellow, a compatible driver is available for the middleware, but the application must be restarted before it is available. Once the software has restarted, you can use Query with SQL.

2. Choose a data source, and perform one of the following actions:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>If the data source middleware has a green check mark.</td>
<td>The data access drive is installed. You do not need to perform the remaining steps in this task.</td>
</tr>
<tr>
<td>If the data source middleware has a yellow check mark</td>
<td>Restart the application, and repeat step 1.</td>
</tr>
<tr>
<td>If the data source middleware has a red check mark</td>
<td>Go to step 3.</td>
</tr>
</tbody>
</table>

3. If the middleware driver is not configured, choose the database driver, and choose *Install* at the top of the database list.
4. In the selection box for locally available middleware:
Option | Description |
--- | --- |
If the correct .jar file is listed | Go to step 6. |
If the correct .jar file is not listed | Download the driver from the vendor support site, install the driver, select Cancel to close the driver selection box, and then download and install the correct .jar file. |

You must access the web page that lists JDBC data access drivers for the middleware vendor. Depending on the database, different types of driver files are available; usually a compressed file containing the drivers or an executable file to install the drivers automatically. For the application, download only the compressed file.

5. On your vendor’s support website, download the compressed JDBC driver file (for example, a .tar, .gz, or .zip file) for your database middleware version.

6. On your computer, select the folder that contains the extracted JDBC driver files for your database middleware.

   A complete list of supported JDBC drivers is included in the Product Availability Matrix, available on the SAP Service Marketplace site at https://support.sap.com/pam.

7. Restart the application.

   The list of available database middleware drivers is updated.

**Results**

When you use *Query with SQL* to create a new document in the application, the target database middleware is listed with a green check mark, indicating that the driver is available to access the database.

### 4.4.2 Connecting to a Query with SQL Data Source

You can connect directly to a database to specify the data to acquire and to set parameters to optimize the database connection.

**Prerequisites**

- You must be familiar with your database and with the SQL language.
- The correct data access driver must be installed for your database middleware. A data access driver is the software provided by a database vendor that allows a client application to connect to middleware and to access data in a database. You copy the data access driver for your middleware from your database vendor support website to a local folder, and you can then select the driver in the application and connect to the database.
Note

Installing data access drivers from a vendor site can be problematic due to the variety of driver versions and file formats. If you are unfamiliar with your database version or the vendor website, contact your database administrator.

You need to install a JDBC data access driver for your database middleware before using Query with SQL. The data access driver is a `.jar` file that you download from a database vendor site and copy to the driver folder in the application installation path.

Restriction

Sampling data and scheduling job on Hadoop is not supported in Lumira Discovery 2.0.

Procedure

1. On the Home page, under Data Source, choose Query with SQL.
2. Select the database middleware for the target database and choose Next.
3. Enter your logon credentials and, if necessary, select Advanced to adjust advanced driver parameters.
4. Choose Connect.
5. Select a table, or type an SQL query to fetch the required table.
6. Choose Preview, and select the columns you want to acquire.
7. Choose Visualize.
   
   You can now start building charts and analyzing data in your visualization. If you want to modify the dataset first, choose DataView.

4.4.2.1 Editor Options for Query with SQL

Use an SQL editor to write SQL and create a query with SQL data source based on a connected database. The SQL editor is accessed from the query with the SQL connection option when you create a new document.

Only the `SELECT` statement is authorized in the SQL editor to acquire data from database tables. Use these SQL editor options to select tables for the data source:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Catalog</td>
<td>The accounts available to the connected database. Expand each node to see the tables available. Double-click a table to add it to the SQL query.</td>
</tr>
<tr>
<td>Query</td>
<td>The <code>SELECT</code> query to fetch tables (only <code>SELECT</code> is supported). You can add table names by double-clicking the table in the account node in the left pane.</td>
</tr>
</tbody>
</table>
### 4.4.2.2 Connection Parameters for Query with SQL

You can create your own data provider by manually entering the SQL for a target data source to acquire table data. When using Query with SQL, you must enter connection information for the target database, and you can specify connection parameters to optimize the fetching of data.

**Table 12: Logon parameters**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Username</td>
<td>The username that you use to connect with the target database</td>
</tr>
<tr>
<td>Password</td>
<td>The password that you use to connect with the target database</td>
</tr>
<tr>
<td>Server (&lt;\text{host}&gt;:&lt;\text{port}&gt;)</td>
<td>The name and port of the server hosting the database</td>
</tr>
<tr>
<td>Database</td>
<td>The database name</td>
</tr>
</tbody>
</table>

**Table 13: Advanced parameters**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connection Pool Mode</td>
<td>Use to keep the connection pool mode’s connection active.</td>
</tr>
<tr>
<td>Pool Timeout</td>
<td>If the connection pool mode is set to \textit{Keep the connection active for}, the length of time in minutes to keep the connection open.</td>
</tr>
<tr>
<td>Array Fetch Size</td>
<td>The maximum number of rows authorized with each fetch from the database. For example, if you enter 20, and your query returns 100 rows, the connection retrieves the data in five fetches of 20 rows each. To deactivate array fetch, enter an array fetch size of 1. Data is retrieved row by row. Deactivating the array fetch size can increase the efficiency of retrieving your data, but it slows server performance. The greater the value in the array fetch size, the faster your rows are retrieved. However, make sure that the client system has adequate memory.</td>
</tr>
<tr>
<td>Array Bind Size</td>
<td>Size of the bind array before it is transmitted to the database. Generally, the larger the bind array, the more rows (n) can be loaded in one operation, and performance will be optimized.</td>
</tr>
</tbody>
</table>
### Parameter | Description
--- | ---
Login Timeout | The number of minutes before a connection attempt times out, and a message appears.
JDBC Driver Properties | Values for JDBC driver properties. You can define the value of more than one property, separated by commas. For example, the `oracle.jdbc.defaultNChar=true,defaulNChar=true` value for JDBC driver properties sets the `oracle.jdbc.defaultNChar` and `defaultNChar` driver properties.

## 4.5 SAP Universe

The SAP Universe lets you use advanced query capabilities to acquire data from `.unx` universes. It allows you to build, test, and preview the results of queries on a business layer or published universe.

You can acquire a highly specific subset of data from the universe data source that is relevant to the analysis you want to perform. For example, you can include filters and prompts in a query to customize the data returned from the data source.

### 4.5.1 Acquiring Data from the SAP Universe

**Procedure**

1. On the *Home* page under *Data Source*, choose *Show More*.
2. Choose *SAP Universe* under *Databases*.
   
   The *SAP Universe* dialog appears.
3. Enter the following details:
   a. Enter the system name that hosts your Central Management Server (CMS). If you are connecting to a CMS that belongs to a different network domain, make sure the hosts file located at `C:\Windows\System32\drivers\etc` has the corresponding host name entry. For example, `x.x.x.x<NameOfMachineHostingCMS>`.
   b. Enter the CMS username, password, and authentication. To use Windows AD authentication to connect to the CMS, append the following two entries in the `SAPLumira.ini` file, located at: `<LumiraInstallDir>\SAP BusinessObjects Lumira\Lumira Discovery`.

```
-Djava.security.auth.login.config=<Path_to_bscLogin>\bscLogin.conf
-Djava.security.krb5.conf=<Path_to_kbr5>\krb5.ini
```
For example:

- `Djava.security.auth.login.config=C:\Windows\bscLogin.conf`
- `Djava.security.krb5.conf=C:\Windows\krb5.ini`

c. Choose Next.

A list of universes available when the CMS appears.

4. Select a universe and choose Next.
   The query panel opens, displaying the universe tree, called the business layer.

5. Select the required objects in the universe tree, and choose Finish.
   You can start analyzing the data and building your charts. If you want to modify the dataset, choose Data View.

### 4.5.2 Building a Query

You can run queries on published universes.

**Context**

**Note**

For detailed information about querying universes, see “Using the Query Panel” in the *Information Design Tool User Guide*.

**Procedure**

1. To select the objects you want to include in the query, drag them from the business layer (the universe tree) to the *Result Objects* pane.

2. For hierarchy result objects, select members to include or exclude in the results.

   To open the Member Selector, choose the arrow to the right of the hierarchy object name:

3. To filter the results of the query, drag objects from the business layer to the *Query Filters* pane.

   If a mandatory filter is defined on an object, the filter is triggered when you add the object to the *Result Objects* pane. The mandatory filter is visible in the query script, but not in the *Query Filters* pane.

   Non-mandatory pre-defined filters are listed in the business layer. You can drag these pre-defined filters to the *Query Filters* pane to limit the results. The filter is visible in the query script.

   You can also build business filters, including filters that use prompts.

4. For relational universes, you can build combined queries. To open the *Combined queries* pane, choose the icon.
5. To set query properties, choose the icon.

6. To see or edit the query script, choose View Script.

7. To preview the query results, choose Refresh in the Data Preview pane.

You can profile the values in the result columns. In the Data Preview pane, choose the Advanced Preview icon.

8. To run the query, choose Finish.

You can start building charts and analyzing the data. If you want to modify a dataset, choose Data View.

### Related Information

**Using Prompts to Filter Data** [page 61]

### 4.5.3 Using Prompts to Filter Data

You can use prompts to customize a dataset for your needs.

A prompt is a special type of query filter. It is a dynamic filter that displays a question every time you refresh the data in a query. You answer prompts by specifying the values you want to view before you refresh the data. You can specify values by typing them, selecting them from the list of values, or searching the list for the values you're interested in. The query returns only the values you specified.

**Note**

If you search for values, only values that have been retrieved from the server are searched. As you scroll down the list of values, more values are retrieved from the server.

Prompts allow multiple users viewing a single document to specify a different sub-set of the database information and display it in the same report tables and charts. Prompts also reduce the time it takes for the data to be retrieved from the database.

When you define a prompt query filter, you can either build a new prompt, or use an existing one defined as a parameter in the business layer.

If you define more than one prompt in a query, you can change the order in which prompts are displayed. Change prompt order in the query properties.
4.5.4 Limitations of SAP Universe

The SAP Universe has the following limitations:

- The SAP Universe does not support OLAP universes.
- Universe parameter prompting does not support hierarchical prompts.
- Currently, the SAP Universe does not support multiple flows of SQL. If a query will result in two separate SQL statements, you will need to modify your query before the SAP Universe can execute it.

4.6 Data from Files

In Lumira Discovery, you can connect to or import data from data files such as text, excel, or Copy from Clipboard.

4.6.1 Acquiring Data from an Excel Workbook

Context

You can acquire data from multiple Microsoft Excel workbooks. You choose which rows and columns to acquire. You can also acquire data from cross tables.

Procedure

1. On the Home page, under Data Source choose Microsoft Excel.
2. Choose one Excel file, and then choose Open.
   Data from the Excel files is previewed in the Add new dataset dialog box, where you can choose rows and columns to acquire the dataset. You can also acquire data from cross tables.
Table 14: Add new dataset dialog options for Excel

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Dataset Name</strong></td>
<td>Enter a name for the new dataset.</td>
</tr>
<tr>
<td><strong>File(s)</strong></td>
<td>Select the Excel workbooks that will be the data source for the new dataset.</td>
</tr>
<tr>
<td><strong>Sheet</strong></td>
<td>If an Excel workbook contains multiple worksheets, select the worksheet to acquire for the dataset.</td>
</tr>
<tr>
<td><strong>Append all sheets</strong></td>
<td>Select this check box to add all worksheets in the workbook to the dataset. Common columns are appended, and different columns are added as new columns.</td>
</tr>
<tr>
<td><strong>Set first row as column names</strong></td>
<td>Select this check box to set the first row values in the worksheet as column names in the dataset.</td>
</tr>
<tr>
<td><strong>Table Header Type</strong></td>
<td>Select <strong>Standard Table (No Transformations)</strong> or <strong>Cross Table</strong>.</td>
</tr>
<tr>
<td><strong>Select All</strong></td>
<td>Select this check box to add all columns in the worksheet to the dataset.</td>
</tr>
<tr>
<td><strong>Show record count</strong></td>
<td>Select this check box to show the number of columns and the number of rows in the dataset.</td>
</tr>
<tr>
<td><strong>Advanced Options &gt; Show hidden columns</strong></td>
<td>Select this check box to display hidden worksheet columns as column headers in the dataset.</td>
</tr>
<tr>
<td><strong>Advanced Options &gt; Show hidden rows</strong></td>
<td>Select this check box to display hidden worksheet rows in the dataset.</td>
</tr>
<tr>
<td><strong>Advanced Options &gt; Detect merged cells</strong></td>
<td>Select this check box to highlight merged worksheet cells in the dataset.</td>
</tr>
<tr>
<td><strong>Advanced Options &gt; Range Selection</strong></td>
<td>If a worksheet contains one or more named ranges, select the range to apply to columns acquired for the dataset. A dataset is restricted to the columns defined in this range.</td>
</tr>
<tr>
<td><strong>Advanced Options &gt; Column</strong></td>
<td>For cross tables, specify the number of columns to use for the left header.</td>
</tr>
<tr>
<td><strong>Advanced Options &gt; Row</strong></td>
<td>Specify the number of rows to use for the top header.</td>
</tr>
</tbody>
</table>

3. (Optional) Modify the Excel options for acquiring data.
4. Choose **Start Visualizing**.
Results

You can now start building charts and analyzing the data.

Related Information

Acquiring Data from Multiple Excel Workbooks [page 64]

4.6.1.1 Acquiring Data from Multiple Excel Workbooks

When acquiring data from multiple Excel workbooks, you have to ensure the data format and data type to be same in all the workbooks.

Procedure

1. On the Home page, under Data Source choose Microsoft Excel.
2. Choose one or more Excel files, and choose Open.
   
   Data from the Excel files is previewed in the New Dataset dialog.
3. (Optional) In the Dataset Name box, enter a name for the dataset.
4. Choose Add Files next to Files. Browse to and select the Microsoft Excel spreadsheet that you want to acquire data from.
   
   You can use wild cards to search for a spreadsheet name. By default, the first file in the path is considered the reference file, which you want to add data to from other spreadsheets.
   
   For example, enter C:\data\monthly_updates\*.xls(x) to find all .xls (.xlsx) files in the path.
5. In the Sheet list, select a worksheet.
   
   This worksheet is the reference sheet that data from other worksheets will be appended to. The count of records is updated to reflect the number of records from all acquired data. A “Source file” column is added to the dataset, listing each data source name. If you selected the Append all Sheets checkbox, all worksheets in the Excel spreadsheet are added to the dataset.
   
   Data from the worksheet appears in the preview pane of the New Dataset dialog.
6. (Optional) To display hidden worksheet rows or columns in the dataset, select Advanced Options.
7. (Optional) To display hidden worksheet columns in acquired data, select the Show Hidden Columns checkbox, and enter the column range to display in the Range Selection list.
8. (Optional) To display hidden worksheet rows in acquired data, select the Show hidden rows checkbox, and enter the row range to display in the Range Selection list.
Results

The data is acquired and appears under Data View.

4.6.2 Acquiring Data from a Text File

You can acquire data from one or more text files if the data is stored with delimiters or in fixed-width columns. An example of a text file using delimiters is a comma-separated value (.csv) file. Similarly, you can acquire data from other text files like log file (.log file), print distributor file (.pnr file) or a tab-separated files (.tsv file).

Context

A .csv file stores numbers and text in plain-text format. Each record consists of fields usually separated by a comma or a tab, and records are separated by line breaks. Here is an example of a .csv file, with data separated by commas:

```
"Product","Country","Year","Quantity","Margin"
"Skis","Italy","2013","1,297","1,929"
"Computers","China","2014","609","10,659"
```

Acquiring data from this .csv file results in five columns in the dataset: "Product," "Country," "Year," "Quantity," and "Margin." Column 2, in this example, would contain the values "Country", "Italy", and "China".

Here is an example of a text file with the data stored in fixed-width columns:

```
Product   Country   Year      Quantity  Margin
Skis      Italy     2013      1,297     1,929
Computers China     2014      609       10,659
```

You can acquire data from multiple-file data sources. The files must have the same format and data type.

Table 15: Add new dataset dialog options for text files

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dataset Name</td>
<td>The name of the dataset</td>
</tr>
<tr>
<td>File(s)</td>
<td>The file or files that contain the data for the new dataset. You can import data from one or multiple files. To specify multiple files, separate the file paths in the File(s) field with semicolons, or select Add Files and choose one or more files to add to the selection.</td>
</tr>
<tr>
<td>Separator</td>
<td>Choose whether data in your files is separated by delimiters or is entered in fixed-width columns. Delimiters are symbols, such as commas, tabs, or spaces, that separate fields in the data source and that will specify columns in the dataset in SAP Lumira.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Set first row as column names</strong></td>
<td>Select this check box to use the first row of data as column names in the dataset. Clear this check box to use the default column names (&quot;Column1&quot;, &quot;Column2&quot;, and so on).</td>
</tr>
<tr>
<td><strong>Select All</strong></td>
<td>Select this check box to select all the columns in the table.</td>
</tr>
<tr>
<td><img src="image" alt="Advanced Options ➤ Number format" /></td>
<td>The format for numeric columns in the dataset</td>
</tr>
<tr>
<td><img src="image" alt="Advanced Options ➤ Date format" /></td>
<td>The format for date columns in the dataset</td>
</tr>
<tr>
<td><img src="image" alt="Advanced Options ➤ Break Column" /></td>
<td>When acquiring data stored as fixed-width columns, analyze the data file and suggest column widths (in characters) for separating data into columns in the dataset. If the suggested widths aren’t suitable, you can change them by entering values separated by commas. For example, if your data is in three columns and the column widths are five, 10, and 15 characters, you would enter 5, 10, 15 in the Break Column box, and select Apply to see a preview of the resulting dataset.</td>
</tr>
<tr>
<td><img src="image" alt="Advanced Options ➤ Trim leading spaces" /></td>
<td>Select this check box to remove leading and trailing values from numbers and text in the dataset, so that column headers do not appear as empty fields. For example, if a “Product” entry has a leading space (“ Product”), the space is removed, and “Product” appears as the column header.</td>
</tr>
</tbody>
</table>

**Procedure**

1. On the Home Page, under Data Source choose Show More.
2. Select Text.
3. Select one or more text files and choose Open.
   - Data from the files is previewed in the Text dialog.
4. (Optional) Adjust the dataset options in the dialog as needed.
5. Choose Visualize.

**Results**

You can start building charts and stories to analyze the data. To modify the dataset, choose Data View.
4.6.3 Acquiring Data Copied to Clipboard

Text-based data can be copied to the clipboard from a text-based file (for example, from Microsoft Excel) or from a web page.

Context

Table 16: New Dataset dialog options for data copied from the clipboard

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Dataset Name</strong></td>
<td>The name of the dataset</td>
</tr>
<tr>
<td><strong>Separator</strong></td>
<td>Choose whether data on the clipboard is separated by delimiters or is entered in fixed-width columns. Delimiters are symbols, such as commas, tabs, Semicolon or spaces, that separate fields in the data source and that will specify columns in the dataset in the application.</td>
</tr>
<tr>
<td><strong>Select All</strong></td>
<td>Select this check box to select all the columns in the table.</td>
</tr>
<tr>
<td><strong>Set first row as column names</strong></td>
<td>Select this check box to use the first row of data as column names in the dataset. Clear this check box to use the default column names (“Column1”, “Column2”, and so on).</td>
</tr>
<tr>
<td><strong>Advanced Options &gt; Number Format</strong></td>
<td>The format for numeric columns in the dataset</td>
</tr>
<tr>
<td><strong>Advanced Options &gt; Date Format</strong></td>
<td>The format for date columns in the dataset</td>
</tr>
<tr>
<td><strong>Advanced Options &gt; Break Column</strong></td>
<td>When acquiring data stored as fixed-width columns, analyze the data file and suggest column widths (in characters) for separating data into columns in the dataset. If the suggested widths aren’t suitable, you can change the widths by entering values separated by commas. For example, if your data is in three columns and the column widths are five, 10, and 15 characters, you would enter 5,10,15 in the Break Column box, and select Apply to see a preview of the resulting dataset.</td>
</tr>
<tr>
<td><strong>Advanced Options &gt; Trim leading spaces</strong></td>
<td>Select this check box to remove leading and trailing values from numbers and text in the dataset so that column headers do not appear as empty fields. For example, if a “Product” entry has a leading space (“Product”), the space is removed and “Product” appears as the column header.</td>
</tr>
</tbody>
</table>

**Note**

The Microsoft Internet Explorer (IE) web browser has a known issue when copying text to the clipboard. If you encounter this issue, use a different supported browser instead.
Procedure

1. Copy text from a text-based file or webpage to the clipboard.
2. On the Home Page, under Data Source choose Show More.
3. Select Copy from Clipboard.
   The text you copied is pasted in the dialog.
4. (Optional) Choose Trim Spaces to remove leading and trailing spaces from numbers and text in the dataset.
5. (Optional) Choose Trim Row to remove blank lines from the dataset.
6. Select Proceed.
   Data from the files is previewed in the Copy from Clipboard dialog.
7. (Optional) Adjust the dataset options in the dialog as needed.
8. Choose Visualize.

Results

You can start analyzing data and building charts from the text-based data. If you want to modify the dataset first, choose Data View.

4.7 Data from Extensions

Lumira Discovery allows you to acquire data from many different data source types and provides a wide variety of visualization types. You can extend your choices by installing extensions in the application.

4.7.1 Application Extensions

A standard installation of Lumira Discovery allows you to acquire data from many different data source types and provides a wide variety of visualization types. You can extend your choices by installing extensions in the application.

Lumira Discovery extensions are similar to the extensions, add-ons, and plug-ins that are available for popular web browsers. Using extensions, you can add new features or provide enhanced connectivity for better data analysis.

Two kinds of extensions are available for Lumira Discovery: Data Access SDK Extensions and Visualization Extensions. You can use Data Access SDK extensions to acquire data from data sources that are not otherwise supported by Lumira Discovery or use visualization extensions to design your own chart types and customize it based on your requirements.

Extensions can be provided by SAP or created by your own developers or third parties. For example, if your organization is using a custom database type (data access extension), the developers can create an extension...
that allows Lumira Discovery users to use your organization’s data. If they want to use a customized chart type (visualization extension), they can create an extension adds that the customized chart type to the Chart Builder.

Extensions provided by SAP are available from the SAP Extension Repository. You can install those extensions from the repository using the Extension Manager. For details on how to create and publish extensions, see the Data Access Extensions for SAP Lumira Developer Guide and the SAP Lumira Visualization Extensions Developer Guide.

**Note**

In Lumira Discovery, you need to pay for the license in some of the extensions to access them, as not all extensions are available for free trial.

**Note**

Lumira Discovery 2.0 version does not support Data Access SDK and Visualization extensions developed using the sap.ui.commons library. Therefore, if you are installing an extension developed using this framework, you need to migrate the APIs from the sap.ui5.commons library to the sap.m framework. For more information on Sap.m libraries, see https://sapui5.hana.ondemand.com/#docs/api/symbols/sap.m.html.

Related Information

Data Access Extension [page 69]
Visualization Extensions [page 70]
Finding Extensions in Lumira Discovery [page 71]
Installing or Uninstalling an Extension in Lumira Discovery [page 72]
Updating an Extension in Lumira Discovery [page 73]

4.7.1.1 Data Access Extension

You can use customized Data Access SDK extensions to acquire data from data sources that are generally not supported by Lumira Discovery.

To access a custom data source, create a plugin and install it in Extension Manager.

Any Data Access SDK extensions you install appear in the Extension Manager dialog box.
4.7.1.2 Visualization Extensions

To use a custom chart type in Lumira Discovery, you can either develop a Visualization SDK extension or use an extension provided by SAP.

Any Visualization SDK extensions you install appear as Extensions in the Insert Chart (Insert Chart). You have to maximize the chart to add measures and dimensions to it.

For information on creating Visualization SDK extensions, refer to the Creating a Visualization Extension chapter in the Visualization Extension Plugin for SAP Web IDE Guide, 1.27 version.

Related Information

Tutorial: Installing and Using the Flagbar Visualization Extension in Lumira Discovery [page 70]
Manually Install the Flagbar Extension in Lumira Discovery [page 70]
Create a Flagbar Visualization SDK Extension Document in Lumira Discovery [page 71]

4.7.1.2.1 Tutorial: Installing and Using the Flagbar Visualization Extension in Lumira Discovery

A sample Visualization SDK extension that uses flags instead of bars to display results is available to use as a tutorial.

When you install Lumira Discovery, some Visualization SDK extension samples are also installed. The helloworld extension displays the words “Hello World”, while other extensions rely on data files.

The Flag Bar chart Visualization SDK extension shows how you can use images within your chart results. The tutorial explains how to set up the data to use with the extension. Some other Visualization SDK extension samples are “Bullet”, “samplebar”, and “hello world”.

4.7.1.2.2 Manually Install the Flagbar Extension in Lumira Discovery

You install the flagbar extension by means of a sample visualization.

Procedure

1. Select File > Extensions
2. From the Extension Manager dialog, choose \( \text{(Add)} \).
3. Browse to the extension sample directory (\texttt{<installdir>SAP BusinessObjects Lumira\Lumira Discovery\Desktop\samples\extensions\charts}).
4. Select \texttt{sap.viz.ext.flagbar.zip} and choose Open.
5. Close the Extension Manager dialog.
6. Restart Lumira Discovery.

**4.7.1.2.3 Create a Flagbar Visualization SDK Extension Document in Lumira Discovery**

Use the sample flagbar Visualization SDK extension to create a Lumira Discovery document.

**Procedure**

1. Start Lumira Discovery.
2. Select File \( \Rightarrow \text{New} \).
3. Double-click Text.
4. Find your flagbar file and Open it.
5. Choose Create.
6. In the Chart Builder, select the Flag Bar Chart.
7. Add measures.
   - Athens (2004) and Beijing (2008) are examples of measures you could add.
8. Add dimensions to the appropriate shelves.

**Results**

Your Lumira Discovery document shows a breakdown of medals by country, using images of flags in the chart.

**4.7.1.3 Finding Extensions in Lumira Discovery**

You can find extensions to install either from the SAP Extension Repository or as transport units.

- From the SAP Extension Repository
  - If you want to install extensions published by SAP Partners, choose Go to Partner Extension Website and download the extension.
Select File > Extensions.

The Extension Manager opens, showing the extensions available from the SAP Extension Repository, including extensions you have already installed.

- If you want to install extensions published by SAP Partners, choose Go to Partner Extension Website and download the extension.

- **Transport Units**
  - If the developers in your organization have created an extension, they can make it available to users as a transport unit, which you can manually install from a shared network folder. Or, if a third party develops an extension, they can distribute it as a transport unit.
  - When you click Manual Installation in the Extension Manager, it opens the file browser. When you open a transport unit, packaged as a .zip file, it is automatically verified as a Lumira Discovery extension, installed, and then added to the list of installed extensions in the Extension Manager.

### 4.7.1.4 Installing or Uninstalling an Extension in Lumira Discovery

You can install or uninstall extensions easily.

#### Prerequisites

For a Data Access extension, you have included the below code snippet in the json file that is available under the `<Install Directory\features\com\sap\bi\da\da extension name>` path, in the extension file.

```json
"extensionType" : "da"
```

For a Visualization extension, you have included the below code snippet in the .json file that is available under the `<Install Directory\features\sap\viz\ext\viz extensionname>` path in the extension file.

```json
"extensionType" : "viz"
```

#### Procedure

1. Select Extensions (Ctrl+J).
   
   Alternatively, you can add extensions from the Home screen. Under Data Source, choose Show All and in

   Extensions, choose (Add).

2. In the Extension Manager dialog, to install any extension, choose (Add).
3. From the **Open** file dialog box, navigate to the extension file `<filename>.zip` and double-click it, or click the **Open** button.

4. To uninstall an extension, choose [Uninstall].

5. Restart Lumira Discovery after installing or uninstalling any extensions.

### 4.7.1.5 Updating an Extension in Lumira Discovery

You can use the *Extension Manager* to update extensions manually if necessary.

**Context**

Some extensions are compatible only with a particular version of Lumira Discovery. When you install a new version of Lumira Discovery, your installed extensions should update automatically. But if for any reason the extensions do not update automatically, you can update them manually from the *Extension Manager*.

**Procedure**

1. Select **File > Extensions**.
   
   The *Extension Manager* opens, showing the extensions available from the SAP Extension Repository, including extensions you have already installed.

2. Select the required extension and then choose [Upgrade].
5  Do more with Datasets

5.1  Editing an Acquired Dataset

After a dataset has been acquired, you can edit it.

Context

You can edit this information in acquired datasets:

- Add new columns that were removed from the data source when it was originally acquired
- Remove columns that were included in the original data source
- Change values selected for SAP HANA variables and input parameters
- Edit the SQL query for a Query with SQL data source

Procedure

1. Open a dataset that is already acquired in the application.
2. Select Data ➤ Edit Data Source.
3. Perform one or more of the following actions:
   - Select a column name check box to add a new column.
   - Clear a column name check box to remove a column.
   - To change SAP HANA variables and input parameters, select Edit Variables, enter or delete values for variables or input parameters, and select OK.
   - Edit the SQL query for a Query with SQL data source
4. Select OK.
   The document is refreshed. If the data source has undergone a model change, such as columns being added or removed, the Data Mapping dialog opens so that you can resolve the model changes.
5.2 Renaming a Dataset

You can rename a dataset in Lumira Discovery after acquiring it from your local system. If you are working on a document that has multiple datasets, it is always convenient to rename datasets for a better understanding. You can rename only documents created using offline datasets.

Procedure

1. Click the dataset you want to rename.
2. Choose (Rename).
3. Enter a name for the dataset and press Enter.

You cannot rename a dataset with an already existing name in a SAP BusinessObjects Lumira document.

5.3 Refreshing Data in a Document

The data that is saved with a document can become stale or invalid. Refresh the document to get fresh data from the data source.

Context

For example, if you have an Excel data source comprising two columns <Name> and <Age>, and you acquire the Excel data into Lumira Discovery, and the numbers in the Excel data are subsequently updated, you might want to refresh the document to reacquire the updated Excel data.

If the data source undergoes a model change like adding or removing columns, then the data is not automatically refreshed. You can resolve the model changes in the Data Mapping dialog. If the <Name> column in the Excel file is split into <First Name> and <Last Name> columns for example, and the <Name> column in the Excel file is removed, you need to map the columns in the Data Mapping dialog box.

Procedure

1. Select the down-arrow next to the (Refresh) icon and select either Refresh or Refresh with Prompts.
If your data source contains variables, choosing the *Refresh with Prompts* option lets you reselect variable values before the data is refreshed. These data sources support refreshing with prompts:

- Download from SAP HANA
- Download from SAP Business Warehouse
- SAP Universe

**Note**

Refreshing data is not supported for SAP HANA and BW online documents.

If the data source model has not changed, the data is refreshed.

If the data source model has changed, the *Data Mapping* dialog appears. The dialog lists the datasets in your document that can’t be automatically refreshed. Complete the rest of these steps:

2. For query-based data sources such as MySQL, select *Edit Query*.
   In the *Edit Data Source* dialog, redefine your query, and select *OK* when finished.

3. Select a dataset in the *Data Mapping* dialog.
   The *Changed Columns* for the dataset in question are shown.

4. Using the drop-down lists, choose columns from the data source to map the *Changed Columns* to.
   You can map columns only to other unused columns of the same type. You can also remove any columns that you no longer need in your dataset, but be aware that any dependencies based on the removed columns are removed as well.
   Using the above Excel example, you could choose the changed column *<Name>*, and map it to the *<Last Name>* or *<First Name>* column from the drop-down list.

### 5.4 Editing and Cleaning Data

You can enrich your dataset by editing, formatting and cleaning values in a column. These actions can be performed in both the *Grid* and *Facet* view.

**Context**

If you select a column in *DataView*, all the related editing option’s appear to the right of the column.

**Procedure**

1. Perform one of the following actions:
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>To edit all values in a single column</td>
<td>Select the column header.</td>
</tr>
<tr>
<td>To edit all values in multiple columns</td>
<td>Press $\text{Ctrl}$ and select each column header.</td>
</tr>
<tr>
<td>To edit an individual value</td>
<td>Select a cell.</td>
</tr>
<tr>
<td>To edit multiple values in a column</td>
<td>Press $\text{Ctrl}$ and select each cell.</td>
</tr>
<tr>
<td>To edit a range of characters or a word within a cell (cell inner selection)</td>
<td>(Character values only) Double-click the <strong>Grid</strong> view or <strong>Facet</strong> view, and select a range of characters or a word.</td>
</tr>
</tbody>
</table>

2. Open the **Summary** tab to the left of the **Data** pane.
   Unique column values appear in a **Values** box at the top of the panel. If you have not selected any columns, the **Summary** tab displays the message *Select a column to display unique values and number of records.*

### 5.4.1 Converting Data to Another Type

You can convert a dimension or column from one data type to another. For example, you can convert text to number, integer etc.

**Procedure**

1. Perform one of the following actions:
   - In the **Measures and Dimensions** pane, right-click the dimension.
   - Select the column and right-click the column heading.
2. Choose the data type you want to convert the string to. For example, if you want to convert characters to numbers then navigate to **Convert to** $\rightarrow$ **Number** option. For more information see, [Column Data Actions](page 26)
3. In the data conversion dialog, enter the required options (if available) and choose **OK**.

### 5.5 Creating Hierarchies

If the dataset contains dimensions that logically form a hierarchy, such as Year-Quarter-Month or Country-State-City, you can define the hierarchy in the application.

Hierarchies allow you to view data at different levels of granularity. In charts that contain hierarchies, you can drill up and down through the different levels of data to gain a deeper understanding of the relationship between the dimensions and measures. The following types of hierarchies are available:
Table 17:

<table>
<thead>
<tr>
<th>Hierarchy</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Date/Time</td>
<td><code>&lt;Year&gt;</code>&lt;Month&gt;<code>&lt;Day&gt;</code></td>
</tr>
<tr>
<td>Geographic</td>
<td><code>&lt;Country&gt;</code>&lt;Region&gt;<code>&lt;City&gt;</code></td>
</tr>
</tbody>
</table>

**Tip**

You must create a geographic hierarchy from your location data before plotting it on a geographic map. For example, to plot sales by city on a map, you have to create a geographic hierarchy for the `<city>` dimension.

| Custom      | `<Product Type>`<Product>    |

**Note**

As online data sources have built in hierarchies, you will obtain a list by default, which makes reporting easier for your users.

### Related Information

- Creating Time or Date/Time Hierarchy [page 78]
- Creating a Custom Hierarchy [page 80]
- Creating Geographic Hierarchy [page 81]

### 5.5.1 Creating Time or Date/Time Hierarchy

Use dimensions containing date or datetime information to create a time hierarchy.

**Prerequisites**

Your dataset must contain a dimension with a valid date or datetime format, for example:

- 1997-07-16
- 2/19/2015 1:04:26 PM

Date/Time hierarchy is supported only for offline data sources.
Context

With time hierarchies, you can view and analyze your data at different time levels:

- Drill up or down through data aggregated by year, month, quarter, day, and (for datetime data) hour, minute, and second.
- Filter data based on date or time.
- Answer time-based questions, such as "What time of day are most orders placed?".

Procedure

Right-click on the dimension or column that contains a valid date or date/time data and select `Hierarchy` > `Date/Time`.

Results

A time hierarchy is created and displayed in the `Dimensions` panel. Columns are created for each level in the hierarchy, for example:

- Year
- Quarter
- Month
- Day
- Hour
- Minute
- Second

Note that Hour, Minute, and Second are created only for datetime data.

Related Information

- Creating a Custom Hierarchy [page 80]
- Hierarchical Data [page 127]
- Creating Time or Date/Time Hierarchy [page 78]
- Creating a Geographic Hierarchy Using Latitude and Longitude [page 83]
5.5.2 Creating a Custom Hierarchy

You can create a hierarchy using any combination of the available dimensions.

**Context**

Use a custom hierarchy to drill through and filter data using your own defined levels, such as Product Area - Product Line - Product.

**Procedure**

1. Right-click the dimension or column and select the **Hierarchy** > **Custom** option to use as the base for the hierarchy. The **Create Hierarchy** dialog box appears. The dimensions available on the **Measures** and **Dimensions** pane are listed in the left pane. You can enter a search string to find a dimension (for example, the first letters of a dimension name).

2. Add dimensions to the hierarchy in the right pane.

   ➤ **Tip**

   You can double-click a dimension to move it between the panes.

3. (Optional) Use the arrows beside the hierarchy list to move a selected dimension up or down in the hierarchy.

4. Enter a name for the hierarchy, and choose **Create**. The new custom hierarchy appears on the **Measures** and **Dimensions** pane. New columns are created for each level of the new hierarchy.

**Related Information**

- Creating a Geographic Hierarchy with Location Names [page 81]
- Creating a Geographic Hierarchy Using Latitude and Longitude [page 83]
- Creating Time or Date/Time Hierarchy [page 78]
- Hierarchical Data [page 127]
5.5.3 Creating Geographic Hierarchy

You must create a geographic hierarchy to plot location data on a geographic chart.

The application contains a database of location information that includes countries, regions, sub-regions, and cities, plus their latitude and longitude. The application uses this data to create geographic charts.

To create a geographic chart, you must first map your geographic data to the information contained in this database by creating a geographic hierarchy.

Tip

The location names in the application’s database are available in many different languages, so you can use location names in different languages to create a geographic hierarchy.

5.5.3.1 Creating a Geographic Hierarchy with Location Names

Data in a geographic hierarchy can be mapped on a geographic chart. Geographic hierarchies based on location names are easily understood by users.

Context

During data acquisition, the application looks for dimensions containing location names. These dimensions are good candidates for creating a geographic hierarchy.

Procedure

1. Right-click dimension or column, and select Hierarchy Geo and select By Names. This option is available for string dimensions and columns.
2. In the Geographical Data dialog, choose which dimensions to map to the hierarchy:

Tip

If a geographic level, for example Sub-Region, does not apply to your location, select None. Locations can still be mapped on a geographic chart with some information missing.
Table 18:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| Show       | ○ Select All Dimensions to view all possible dimensions for each level in the geographic hierarchy.  
           | ○ Select Geo Dimensions to view only the suggested dimensions.               |
| Country    | Select the dimension to map to the Country level.                            |
| Region     | Select the dimension to map to the Region level, for example State or Province. |
| Sub-Region | Select the dimension to map to the Sub-Region level.                         |
| City       | Select the dimension to map to the City level.                               |

3. Select Confirm.

The Geographical Data dialog displays the mapping between the locations in your dataset and the locations in the application’s database:

○ Locations mapped exactly are marked with green.
○ Locations with more than one possible match (for example, if more than one city named London was found) are marked with yellow.
○ Locations not found in the geographic database are marked with red.

4. Select All in the Show list to display the mappings for all locations:

○ For items marked with yellow, select the correct location from the list.
○ For items marked with red, either edit the source data or ignore the error.
  If a location was not found in the database, it will not be included in the geographic hierarchy.
○ (Optional) For items marked with green, you can choose to remove them from the mapping.

5. Choose Done.

Results

The geographic hierarchy is created.

Next Steps

Right-click the dimension where you have created new geographic hierarchy and select Rename or Remove to rename or remove the hierarchy at any level.

Related Information

Creating a Geographic Hierarchy Using Latitude and Longitude [page 83]  
Creating a Custom Hierarchy [page 80]  
Creating Geographic Hierarchy [page 81]
5.5.3.2 Creating a Geographic Hierarchy Using Latitude and Longitude

Data in a geographic hierarchy can be mapped on a geographic chart. Latitude and longitude allows mapping of all possible locations, in addition to the cities, regions, and countries available in the geographic information database.

Prerequisites

Latitude and longitude data must be numeric. If data is not numeric, you must convert column values using a formula (for example, `ToNumber()`).

Context

The application automatically calculates levels above and below a selected geographic dimension. You can accept the calculated levels in your hierarchy or replace them with levels that you define based on your latitude and longitude data.

Table 19: Properties for a calculated level in a hierarchy

<table>
<thead>
<tr>
<th>Level property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Category</td>
<td>Definition of the level, either automatically calculated based on the latitude/longitude data or user-defined (you select the column to base a level on)</td>
</tr>
<tr>
<td>Column</td>
<td>For a user-defined level, select the column to use for the level.</td>
</tr>
<tr>
<td>Latitude</td>
<td>For a user-defined level, select the latitude data.</td>
</tr>
<tr>
<td>Longitude</td>
<td>For a user-defined level, select the longitude data.</td>
</tr>
<tr>
<td>Level type</td>
<td>Name of the level in the hierarchy</td>
</tr>
</tbody>
</table>

Note

The application does not support creating geographic hierarchies with latitude and longitude data from SAP HANA data sources.

Procedure

1. Ensure latitude and longitude dimensions are numeric.

   Use the following steps to create a numeric dimension:
a. Right click the latitude or longitude dimension and select \( \text{Create} \ \text{Calculations} \).

   The \textit{Calculations} dialog box opens. The name of the dimension appears in the \textit{Formula} windows, for example \{\textit{Latitude}\}.

b. In the \textit{Functions} pane, select and double-click the formula \textit{ToNumber}.

   The formula \textit{ToNumber} is added to the \textit{Formula} dialog.

c. Add the dimension name to the formula, for example \textit{ToNumber({Latitude})}.

d. Enter a name for the calculated dimension in \textit{Dimension Name} and select \textit{OK}.

e. Repeat these steps for the longitude dimension.

2. If you want to create a geographical hierarchy based on the longitude and latitude for a dimension or column, then perform the following:

   a. Right click the latitude or longitude dimension.

   b. Select \( \text{Create} \ \text{Geographic Hierarchy...} \ \text{By Latitude/Longitude} \).

   The \textit{Geographical Data} dialog box appears.

   c. Select the required latitude and longitude on which you want to define the hierarchy.

   d. To select the geographical level, perform one of the following:

<table>
<thead>
<tr>
<th>Option</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>For geographical hierarchy with one level</td>
<td>Select any option except \textit{Other}</td>
</tr>
</tbody>
</table>
   | For geographical hierarchy with two or more level | 1. Select \textit{Other}  
2. Choose \textit{Next}  
The \textit{Generate Parent Levels} dialog box appears.  
3. Select the parent level hierarchy based on your requirement |

   3. Choose \textit{Finish}.

Results

The geographic hierarchy is created.

Next Steps

Right-click the dimension where you have created new geographic hierarchy and select \textit{Rename or Remove} to rename or remove the hierarchy at any level.

Related Information

Hierarchical Data [page 127]
5.6 Sorting

5.6.1 Sorting Dimensions

Procedure

1. Choose the DataView option to navigate to the grid view.
2. Right-click the column header and select Sort.
3. Choose a sort order:

   i Note
   You can also sort dimensions in the facet view.

5.7 Creating Measures

Measures enrich datasets. You can create them manually at any time directly from a column or dimension, or by using the formula language to create a calculated measure. Alternatively, you can allow the application to detect them automatically on numeric column data types when a dataset is acquired.

   i Note
   When using a SAP HANA Live data source, it is not possible to create a measure with a numeric or string dimension. Measures in SAP HANA Live data sources are detected directly from the SAP HANA analytic view. Measures must be created in the SAP HANA view before being acquired automatically in the application.

   i Note
   When using a SAP HANA and SAP BW online data sources, it is not possible to change the aggregation type of a measure.
5.7.1 Creating a Measure from a Column or Dimension

You can create a measure from almost any column or dimension.

Context

These exceptions apply:

- If the column data type is **Numeric**, any aggregate function can be used for the measure.
- If the column data type is **Date** or **String**, neither **Sum** nor **Average** can be used.
- Aggregation is performed when the measure is used in the **Facet** view. It is not available in the **Grid** view.

**Note**

If the measure is created from a dimension type **Text**, the aggregations supported are **Count (All)** and **Count (Distinct)**

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Sum</strong></td>
<td>Returns the sum of a measure</td>
</tr>
<tr>
<td><strong>Min</strong></td>
<td>Returns the smallest value in a set of values</td>
</tr>
<tr>
<td><strong>Max</strong></td>
<td>Returns the largest value in a set of values</td>
</tr>
<tr>
<td><strong>Count (Distinct)</strong></td>
<td>Returns the number of distinct values in a set of values</td>
</tr>
<tr>
<td><strong>Count (All)</strong></td>
<td>Returns the number of values in a set of values</td>
</tr>
<tr>
<td><strong>Average</strong></td>
<td>Returns the average value of a measure</td>
</tr>
</tbody>
</table>
Function | Description
--- | ---
None | Allows a numeric dimension to be used as a measure, without aggregation. This type of measure enables each value to be visualized in a graph, which is useful for certain types of graphs.

For example, for a scatter plot that displays margin and quantity-sold values, this option displays all points on the scatter plot and shows the spread of individual values that would not be apparent using an aggregation function.

Note
The aggregation type None is not supported when using a Connect to SAP HANA data source.

Procedure

1. Right-click the dimension and choose Create Measure.

   Alternatively, you can select the column heading of any dimension and choose Create Measure.

   A measure is created in the MEASURES section of the MEASURES and DIMENSIONS pane.

2. Right-click the new measure, select Change Aggregation and select an aggregate function.

Next Steps

Switch to the Facet view to see the measure applied to data in a dataset. Select the measure to see changes to data values caused by aggregation.

5.7.2 Creating a Calculated Measure or Dimension

You can create calculated measures and dimensions using the Lumira Discovery formula language.

Context

The following features are supported in the formula editor:

- Combining any two columns in a dataset
- Applying functions from a predefined set of numeric and text functions
- Using “if,” “then,” “else” clauses
• Using automatic completion to improve editing speed
• Selecting text and syntax to a function definition

**Procedure**

1. Right click on the measure or dimension and select **Create Calculations**
   
   Also, you can select any column heading and then select **Create Calculations**.
2. Select **Measure or Dimension** from the **Create** field to create a measure or dimension.
3. Enter a name for the measure or dimension.
4. Choose **Dimensions or Measures** and double-click the required dimension or measure to add them to the **Formula** syntax box.
   
   You can also enter a search string to find the dimension or measure.
5. Choose **Functions**, select the operator for the function and double-click the associated parameters to add them to the **Formula** syntax box.
   
   You must enter the names of columns used in the formula. Automatic completion suggests a column name after you enter the first letter.
6. Select **OK** to apply the formula.
   
   A new measure or dimension is created.

**5.8 Measures Associated with Dimensions**

You can view the number of times each dimension value occurs in a dataset.

**Example**

Suppose a dataset contains a measure called “Number of Games Won” (calculated as a sum) and a dimension called “Name of Team”. You can display the total number of games that each team won beside each team name.

**5.8.1 Viewing a Measure Associated with Dimension**

You can sort dimensions visible by the number of times each dimension value occurs in a dataset.

**Procedure**

1. Choose the **DataView** option to navigate to the grid view.
2. Choose the (Facet) icon on the Global pane.
3. Right-click the column header, select Show Measure and then select the measure to view.

   If you want to view the number of times each dimension appears in your dataset for example, select Show Measure > Occurrences.
6 Working with Multiple Datasets

You can add a dataset to the available datasets, move between datasets, merge or append two datasets, and use data from more than one dataset inside a visualization.

When combining datasets, two datasets are merged using a JOIN operator, and two matched datasets are merged using a UNION operator. Appended datasets are compatible and have an equivalent number of columns in the merged table.

If you have multiple datasets that contain related data, but you don't want to wait for your technical staff to perform a time-consuming database merge, you can link the datasets while you're performing your analysis, in a Lumira Discovery visualization. This is called dataset linking.

6.1 Adding Datasets in a Document

You can open multiple datasets in the same document, and you can add a dataset to a document.

Procedure

1. Choose the New Dataset icon to add another dataset in your document.
2. Select a dataset from the list of connections.
3. Enter the required connection information for the dataset, and choose Visualize.
4. If you have multiple datasets opened in your document at the same time and want to switch from one dataset to another, choose the data selector option in the side bar.

The dataset you selected is the active dataset, and you can use the measures and dimensions from it to build charts and analyze your data.
6.2 Removing a Dataset

You can remove any dataset from a document that contains multiple datasets. Deleting a dataset will remove it completely from the document.

Procedure

1. In the object picker, on the DATASET tab, select the dataset that you want to delete.
2. Click on the dataset and choose (Remove).
   When the dataset is removed, all charts consisting of data associated with that dataset may be affected.
3. Choose OK.

6.3 Merging Datasets (JOIN)

Use the JOIN operator to merge two datasets.

Prerequisites

- The merging dataset must have a key dimension.
- Only dimensions with the similar data type can be merged.
- The merge process combines the datasets based on merge keys and the selected join operation.

Context

Dimensions in the second dataset are matched to a key dimension in the original dataset. The application proposes potential dimensions matches and the probability of each match.

Procedure

1. Choose the (Merge Datasets).
2. In the Merge Datasets... dialog, select the key dimension to use it as the identifying dimension for matching.
3. Select the datasets you want to merge from the drop-down list on both left pane and right pane.
4. Select a key dimension on left pane and a corresponding dimension on the right pane.
   ○ If selected dimensions are compatible, the Merge button is enabled.
   ○ Also, you can select two or more dimensions from a dataset simultaneously to perform Composite merge.
5. Select the required Merge Type.
6. Choose Merge.

**Results**
Dimensions in the second dataset are added to the dataset that are merged on the left pane.

**Note**
If you want to restore the original dataset, you can undo the merge operation, or remove the merged dataset and reacquire the original dataset.

### 6.4 Appending Datasets (UNION)

Use the UNION operator to append two datasets.

**Prerequisites**
- You have acquired two datasets.
- Both tables in the union must contain compatible data types. Only a dataset that is compatible with the target dataset can be appended.

**Procedure**

1. Choose the Append Datasets icon.
2. In the Append Data dialog, if the dataset to append is compatible with the original dataset, dimension columns are listed under Append Dataset on the right pane.
3. To select a different source dimension for the union with the matching target dimension, select another dimension in the list.
   - If the selected dimension contains a compatible data type, the dimension can be appended. If a Union cannot happen message appears, the selected dimension does not contain a compatible data type. You have to select a compatible dimension.
4. Choose *Append*.

**Results**

The two datasets are combined. The combined dataset retains the column names of the original dataset.

**Note**

If you want to restore the original dataset, you can undo the append operation, or remove the combined dataset and reacquire the original dataset.

### 6.5 Linking Datasets

If you have multiple datasets that contain related data, but you don't want to wait for your technical staff to perform a time-consuming database merge, you can link the datasets while performing your analysis, in a Lumira Discovery visualization.

A visualization with linked datasets contains one or more links between dimensions from separate datasets, and measure values from those datasets. These datasets are not merged or joined prior to the visualization. Instead, data is aggregated from each dataset separately, and then joined on one or more common linked dimensions, to produce a result set that is visualized in a chart or table. You can also create blended visualizations by linking datasets from multiple dimensions.

Dataset linking lets you enrich your own data, by adding columns that your IT organization may not provide. For example, if you're tracking sales performance for several account managers, but have them assigned to virtual teams, or have them weighted differently across different accounts, you can add this enrichment to an offline spreadsheet of your own, and link that information with your visualizations or tables to properly calculate the right sales numbers (performance and targets).

These terms are specific to dataset linking:

- **Primary dataset**: The dataset that is used when first creating a visualization.
- **Secondary dataset**: A dataset that is added to an existing visualization that is based on a primary dataset. There is no limit to the number of secondary datasets you can add.
- **Primary (or secondary) dimension**: A dimension from the primary (or secondary) dataset.
- **Link**: A relationship between dimensions in different datasets. For example, a `<Year>` dimension in Dataset1 and a `<Year>` dimension in Dataset2 can be linked, so that a visualization can display data from both datasets.
- **Active linked dimensions**: The set of dimensions that the datasets are linked on.

With traditional database merging, if your data contains multiple instances of records, you have to decide which level you want to roll up your data to, and then join the databases at that level. With dataset linking, the data is automatically aggregated up to the level of the primary dimensions that you link.
When working with linked datasets, there are various visual indications:

- For a visualization dimensions, measures, and filters from the primary dataset are identified by the primary dataset icon 📊.
- When linking datasets, you can choose between these types of joins:

<table>
<thead>
<tr>
<th>Join type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>📊 Left Outer Join</td>
<td>Returns all rows from the primary dataset, even if there are no matches in the secondary dataset.</td>
</tr>
<tr>
<td>📊 Inner Join</td>
<td>Returns rows where there is a match in both datasets.</td>
</tr>
<tr>
<td>📊 Full Outer Join</td>
<td>Returns all rows from both datasets.</td>
</tr>
<tr>
<td>📊 Exception</td>
<td>Returns only the rows from the primary dataset that do not have a match in the secondary dataset.</td>
</tr>
</tbody>
</table>

**Note**

- You cannot link online data sources with offline data sources.
- Secondary datasets always link to the primary dataset; not to other secondary datasets.
- When you add a filter on a linked dimension, the list of values is the combination (union) of the lists of values from all datasets used in the visualization.
- When working with linked datasets, sometimes a measure from a secondary dataset may show duplicated values. This is usually caused by insufficient linked dimensions. Lumira Discovery detects when the duplicated measure values occur, and prompts you to update the linked dimensions.
- When linking datasets, a message may be displayed if the default java heap size is insufficient. Depending on the size of your result set, you may need to increase the heap size value as follows:

1. **Open the SAPLumira.ini file, located at** `<LumiraInstallDir>\SAP BusinessObjects\Lumira\Lumira`.
2. **Find the heap size setting:** `-Xmx1024m` (default value).
3. **Change the setting to a larger value; for example,** `-Xmx2048m`. The value must be no greater than the amount of physical memory you have in your machine, in megabytes. For example, 2048 = 2 GB.
4. **Save the file and restart Lumira Discovery.**

**6.5.1 Creating and Managing Dataset Links**

**Context**

Use the **Define Dataset Links** dialog to create and manage links between dimensions in your datasets.
Procedure

1. While creating a visualization, choose Link dataset icon.
2. From the dimension lists, select a dimension from one dataset.
3. Select a dimension from the other dataset to complete the linking process.
   A link is initiated below the dimension lists.
4. Choose OK.

6.5.2 Linking Datasets While Creating a Visualization

Procedure

1. Create a visualization with a dataset that already contains dimensions or measures from one dataset (the primary dataset).
2. Choose the (New Dataset) icon to add the secondary dataset.
3. Select a dataset from the list of connections.
4. Choose Visualize.
   The secondary dataset becomes active, and the Measure and Dimensions pane shows the objects in the secondary dataset.
5. Add a dimension or measure from the secondary dataset to the visualization.
   The Link Datasets dialog opens. Here, you define and manage links between dimensions in the two datasets.
   In the Datasets in Use area in the Chart Builder, the primary dataset is indicated by the "primary dataset" icon.
   You can also use the + button in the Datasets in use area to start linking datasets, or to include additional secondary datasets in the current visualization.
6. By default, the datasets are linked using a (Left Outer Join). If you want to change the join type, select the join icon in the Datasets in use area.

Results

When dimensions and measures from both datasets are added to the visualization, the primary dataset icon appears in the tokens for the primary dimensions and measures.
7  Building Charts

7.1  Creating a Chart Directly on the Chart Canvas

You can quickly create a chart by dragging measures and dimensions to the Chart Canvas.

Context

A chart must have at least one measure. When you add a dimension to the chart, its values are calculated based on the chart’s measures.

Procedure

1. Choose the Insert Chart icon.
2. Select a chart type from the list. Bar Chart is the default chart type, but you can change the chart type.
3. Select a measure and drag it to an axis on the Chart Canvas. Text in the chart body guides you to the correct axis for the measure. A check mark appears when you drag the measure over an area where it can be dropped.
4. Select a dimension and drag it to the Chart Canvas. Text in the chart body guides you to the correct axis for the dimension. A check mark appears when you drag the dimension over an area where it can be dropped.
5. Add additional measures and dimensions as required.
6. To change the chart type, select (Chart Picker) at the top of the Chart Canvas, and select the required chart.
7. To filter data in the chart, select (Add filters) at top of the Chart Canvas, and select a dimension to filter on.

Next Steps

Each new chart that you create is automatically saved in the current session. However, to access the chart the next time you open the story, you must save the document.
7.2 Working with the Chart Builder

You can use the Chart Builder to change the chart type and to customize a chart. To obtain the chart builder, select the visualization and expand it using the (Maximize) icon.

The Chart Builder has different types of shelves (measures, dimensions, and trellis) for each chart type. Measures and dimensions can be dragged or added to shelves.

Table 21: Measure shelves

<table>
<thead>
<tr>
<th>Measure shelf</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Axis</td>
<td>An X or Y axis of a bar and column chart, line chart, scatter chart, bubble chart, box plot, radar chart, or waterfall chart. Multiple axis shelves may be available.</td>
</tr>
<tr>
<td>Color</td>
<td>The color used for each area in a heat map chart, or each word in a tag cloud.</td>
</tr>
<tr>
<td>Column Width</td>
<td>The width of each column in a marimekko chart.</td>
</tr>
<tr>
<td>Height</td>
<td>The thickness of each section in a pie with depth chart.</td>
</tr>
<tr>
<td>Measures</td>
<td>The measures that are displayed in a crosstab. You can move the Measures token to the Rows or Columns shelf to choose where the measures appear.</td>
</tr>
<tr>
<td>Primary Values</td>
<td>The primary values in a parallel coordinates chart</td>
</tr>
<tr>
<td>Size</td>
<td>The size of sections in a pie chart, bubbles in a bubble chart, areas in a tree map, or the size of words in a tag cloud</td>
</tr>
<tr>
<td>Value</td>
<td>The primary value used in a funnel chart or the number displayed in a geographic chart or numeric point chart</td>
</tr>
<tr>
<td>Word Weight</td>
<td>The weighting of text in a tag cloud</td>
</tr>
</tbody>
</table>

Related Information

Working with the Chart Builder [page 97]
Creating a chart with the Chart Builder [page 99]
Assigning Measure to Axis [page 99]
Changing Chart Type for Series [page 100]
Chart Properties [page 101]
### Table 22: Dimension shelves

<table>
<thead>
<tr>
<th>Dimension shelf</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Animation</strong></td>
<td>Adds an animation to a scatter chart. When you select the play button below a chart, the chart cycles through the values of the dimension added to this shelf.</td>
</tr>
<tr>
<td><strong>Axis</strong></td>
<td>An axis of a bar and column chart, line chart, box plot, heat map, or waterfall chart. Multiple axis shelves may be available. For example, if you select a Bar Chart, the Y Axis shelf appears.</td>
</tr>
<tr>
<td><strong>Category</strong></td>
<td>A section of data in a funnel chart or parallel coordinates chart</td>
</tr>
<tr>
<td><strong>Color</strong></td>
<td>The color of data points in a chart, including bar and column charts, line charts, pie charts, scatter charts, geographic charts, box plot charts, and radar charts.</td>
</tr>
<tr>
<td><strong>Geography</strong></td>
<td>A data point in a geographic chart</td>
</tr>
<tr>
<td><strong>Radar Branches</strong></td>
<td>The quantitative variables represented on axes starting from the same point in a radar chart</td>
</tr>
<tr>
<td><strong>Shape</strong></td>
<td>The shape of each entry in a legend and of each data point for a scatter chart or radar chart</td>
</tr>
<tr>
<td><strong>Tag</strong></td>
<td>The text displayed in a tag cloud</td>
</tr>
<tr>
<td><strong>Time Dimension</strong></td>
<td>The horizontal axis of a Line Chart for Date/Time Series.</td>
</tr>
</tbody>
</table>

### Table 23: Crosstab shelves

<table>
<thead>
<tr>
<th>Crosstab shelf</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Columns</strong></td>
<td>The column axis of a crosstab. You can add dimensions to this shelf, and move the Measures token to this shelf to display measures on the columns.</td>
</tr>
<tr>
<td><strong>Rows</strong></td>
<td>The row axis of a crosstab. You can add dimensions to this shelf, and move the Measures token to this shelf to display measures on the rows.</td>
</tr>
</tbody>
</table>

### Table 24: Trellis shelves

A trellis chart is a set of small charts shown in a grid for comparison. Each small chart represents one item in a section. For example, if you create a bar chart that compares revenue by region, and then add the <Country> dimension to the trellis, multiple small charts appear. Each small chart displays the revenue by region for one country.

<table>
<thead>
<tr>
<th>Trellis shelf</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Rows</strong></td>
<td>The rows in a trellis chart. For example, if you place the &lt;Year&gt; dimension on the Rows shelf, the trellis chart will contain a row for each year in the &lt;Year&gt; dimension.</td>
</tr>
<tr>
<td><strong>Columns</strong></td>
<td>The columns in a trellis chart. For example, if you place the &lt;Year&gt; dimension on the Columns shelf, the trellis chart will contain a column for each year in the &lt;Year&gt; dimension.</td>
</tr>
</tbody>
</table>
Related Information

Creating a chart with the Chart Builder [page 99]

7.2.1 Creating a chart with the Chart Builder

Use the Chart Builder if you need more control over chart creation.

Procedure

1. Select the Insert Chart icon.
2. Select a chart type from the list. Bar Chart is the default chart type, but you can change the chart type at any time.
3. Select the visualization and expand it using the (Maximize) icon.
4. Select an empty shelf in the Chart Builder and select measures and dimensions in the list that appears. You can also drag a measure or dimension to an empty shelf. Each chart must have at least one measure. When you add a dimension to a chart, the dimension values are calculated based on the chart's measures.
5. Add additional measures and dimensions as required.
6. To change the chart type, choose (Chart Picker) at the top of the Chart Canvas, and select the required chart.
7. To filter data in the chart, select (Add Filters) at the top of the Chart Canvas, and select a dimension to filter on.
8. Select File Save to save the visualization in the document.

7.2.2 Assigning Measure to Axis

Context

You can perform the following actions using the Assign Measure to Axis option:

- Switch between single and dual axis.
- Compare multiple measures using dual axes, which are two independent axis that are layered on top of each other. Dual axes are useful when you have two measures that have different scales.
To add a measure to single or dual axis, perform the following:

Procedure

1. Choose the \( \text{Insert Chart} \) icon.
2. Select a chart type from the list. \( \text{Bar Chart} \) is the default chart type, but you can change the chart type at any time.
3. Select the visualization and expand it using the \( \text{(Maximize)} \) icon.
4. Add additional measures and dimensions as required.
5. Right-click on the bar or column, select the \( \text{Assign Measure to Axis} \) option and then select the axis.
   For example, if you select \( \text{Column Chart} \) and \( \text{Assign Measure to Axis} \) and select \( \text{Secondary Axis} \), the Y-Axis on the left side and Y-Axis on the right side of the Chart Canvas appears.
   For example, if you select a \( \text{Bar Chart} \) and \( \text{Assign Measure to Axis} \), the Top X Axis and Bottom X Axis appear on the Chart Canvas.

7.2.3 Changing Chart Type for Series

Context

You want to create a chart that shows how the values of two measures compare against each other. But what if you also wanted to be able to choose which measures were being compared—or better still, change the chart type for the series, which would let any user select the measures to be compared.

You can use the following procedure to compare multiple measures in a single chart:

Procedure

1. Choose \( \text{Insert Chart} \) icon.
2. Select a chart type from the list. \( \text{Bar Chart} \) is the default chart type, but you can change the chart type at any time.
3. Select the visualization, expand it using the \( \text{(Maximize)} \) icon.
4. Add additional measures and dimensions as required.
5. Right-click on the bar or column, and select the \( \text{Change Chart Type for Series} \) option.
6. Select the required chart type.
Note

When you switch between the DATASET and DESIGN tabs after changing the chart type for series, the chart properties remain unchanged. This happens if, for example, you change the chart type from bar to line using the Change Chart Type for Series option, and switch to the DESIGN tab. In the visualization properties, the options listed are still relevant to the bar chart.

7.2.4 Chart Properties

Setting the properties for a chart can enhance its usability. Adding labels and legends, for example, can improve the visual analysis of data.

To set chart properties, select the visualization and select Show/Hide Properties option.

Table 25: Chart Properties

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
</table>
| Normal Stacking or 100% Stacking | Applies to charts where each data point is divided into segments, such as stacked column charts and area charts.  
Normal Stacking allows you to compare the absolute values of data points and their segments.  
With 100% Stacking, percentage values are displayed on the measures axis, allowing you to compare the proportional value of each segment across different data points. |
| Horizontal or Vertical    | Switches the orientation of the chart between horizontal and vertical.                                                                        |
| Show Title                | Adds a title to the chart. You can edit the title at any time.                                                                                 |
| Show Legend               | Adds a legend that shows a different color for each measure in a chart. To add dimensions to the legend in different colors, select Color in the Chart Builder. |
| Show Data Labels          | Displays measure values for each dimension in a chart.                                                                                      |
| Use Measures as a Dimension | Plots two or more measures as a dimension in a chart to show how data is spread over multiple measures on a single axis.  
You must add at least two measures to a chart before selecting this option.  
The measures appear as a new dimension in the Chart Builder. |
| Set Axis Scale...         | Defines the limits for values displayed on the Y Axis, either as a range or automatically to the highest measure value.  
This option applies only to charts with measures on the Y Axis. |
| Show Grid Lines           | Displays grid lines on the chart.                                                                                                           |
### 7.3 Chart Types

Some types of data are especially suited to a particular chart type.

<table>
<thead>
<tr>
<th>Type of analysis</th>
<th>Description</th>
<th>Charts available</th>
</tr>
</thead>
</table>
| **Comparison**   | Compares differences between values or shows a simple comparison of categorical divisions of measures. For example, use a bar chart to compare the differences in sales revenue between countries. | • Bar Chart  
• Column Chart  
• 100% Marimekko Chart  
• Radar Chart  
• Area Chart  
• Tag Cloud  
• Heat Map  
• Crosstab |
| **Percentage**   | Shows the percentage of parts in a whole or values as ratios to a whole. The legend shows the percentage and the total values. For example, use a pie chart to see who had the highest sales as part of a total sales value directly: Total sales = $200, Paul had 10% ($20), David had 65% ($130), and Susan had 25% ($50) | • Pie Chart  
• Donut Chart  
• Stacked Column Chart  
• Stacked Bar Chart  
• Tree  
• Funnel Chart |
| **Correlation**  | Shows the relationship between values or compares multiple measure values. For example, you can view the correlation of two measures and understand the impact of the first measure on the second measure. | • Scatter Plot  
• Scatter Matrix Chart  
• Bubble Chart  
• Network Chart  
• Numeric Point  
• Tree |
| **Trend**        | Shows a trend in the data values (especially for dimensions that are time-based, such as Year) or the progression of your data and possible patterns. For example, you can use a line chart to view sales revenue trends of a product throughout a range of years. | • Line Chart  
• Line Chart for Time Series  
• Combined Column Line Chart  
• Scatter Plot for Time Series  
• Bubble Chart for Time Series  
• Waterfall Chart  
• Box Plot  
• Parallel Coordinates Chart |
7.3.1 Working with Geo Map

In Lumira Discovery, you can use Geo Map to quickly find locations and analyze data worldwide. You can explore and interact with map views in many ways. You can easily drag and drop your data on a map, zoom in and out, customize data, and add many layers with different features. You can add different levels of details for each layer in the map. With Geo Maps, for each level of detail you add, the more granular your data becomes. For example, you might look at obesity rates at the state level, or you could drill down into the county level.

Geo Maps are categorized into 2 types:

1. **Geo Map**: You need to have a network connection to load the base map from the Esri server in Lumira Discovery. Using Geo Map you can import Esri base map in your chart. With Esri ArcGIS technology, you can overlay data on Geo map with detailed geographic information. With Esri On Premise connection, you can deploy the map from Esri ArcGIS server locally in your enterprise and customize it. In Lumira Discovery, Geo Map is also known as **Online Map (ESRI)**.

2. **Offline Map**: Lumira Discovery uses the Navteq geo information system data from Nokia. Using Offline Map you can customize your map locally by adding features like layers, data point type markers and modify the appearance of the map.

### Note

When you insert a map, Geo Map is loaded into your visualization, by default. However, you can switch to an offline map by choosing (Set Visualization Properties) in **DESIGN** tab.

You need to have an Esri ArcGIS account to access the Geo Map from Esri server.

7.3.1.1 Analyzing Data in Geo Map

**Prerequisites**

- Your document contains a dataset with a geographical dimension.
- You have entered your Esri ArcGIS account details in **Preferences**. For more information, see Configuring Geo Map in Preferences [page 224].
Procedure

1. Choose the icon.
2. Select Geo Map.
   The Esri Map is loaded with Topo view in Lumira Discovery.
3. Choose the visualization and expand it using (Maximize).
4. Choose the icon below Add Layer and select the Data Point Type for the first layer:
5. For the first layer, select the type of data point:
   ○ Choropleth: Geographic regions are shaded with a color that represents their measure value. You can customize the measure-based color palette by selecting Choose Colors from the layer Options list.
   ○ Bubble: Bubbles are overlaid on each region, with different sizes and colors based on the measure and dimension that you add. Select Cluster adjacent bubbles to group bubbles together for regions that are close to each other.
   ○ Marker: A marker is added to each geographic region in the dimension that you add. Adjacent data points can be grouped together by selecting Cluster adjacent markers.
   ○ Pie: A pie chart is overlaid on each region, sized according to the measure that you add and divided by the dimension that you add to the Color shelf. You can display donut charts instead of pie charts by selecting Show as donut.

   You can use different data points (Marker, bubble, choropleth, pie) to combine multiple offline maps and create a map.

   To change the map view, on the right-hand side of the map, select the current view. Select one map view among the four views.

6. In the chart builder, choose the (Add) next to the Geo Dimension shelf and choose a geographical dimension for the layer.

   Geo dimensions as represented as . You can also add layers by dragging and dropping the measures and dimensions.

   You can add measures and dimensions to your chart even when the chart is minimized.

   **Restriction**

   For an SAP HANA online document, if you create a geo hierarchy, you can add only the Country level dimension to the Geo Map chart.

7. If necessary, add a measure or dimension to other shelves for the layer.
8. To add another layer, choose Add Layer and repeat steps 5 to 8 for the layer.

   To manage multiple layers, do the following:
   ○ Select the checkbox beside the layer to toggle and view the geo feature details added to the layer.
Select (Options) beside each layer and then select the required option (Move down, Clear, Choose Colors, and Delete layer) to customize the layer.

Note
You can add data layers using the data objects from different datasets.

To customize the Esri map based on your requirements, choose the Import Esri Custom Service. This provides you with the option of customizing the Geo Map with feature services that are added to your Esri ArcGIS account. The feature services supported in Esri online server connections are also supported in Esri On Premise server connections.

Next Steps
After creating the visualization, choose (Set Visualization Properties) in Design tab to customize your map or to switch between Offline Map and Geo Map.

7.3.2 Analyzing Data in Crosstabs

Crosstabs show data points only as values, rather than providing a visual representation of those values. As a result, they are useful when your analysis depends on viewing exact values, or examining data from multiple measures with different scales or units of measurement.

In addition to regular sorting and ranking functionality, you can also use add totals on the rows or columns.

Crosstab Shelves

With a crosstab, you can add one or more measures to the Measures shelf, and switch the display of the measures between the columns and rows. Dimensions can be added to the rows, columns, or both, allowing complex multidimensional analysis.

For example, a crosstab could be an effective way of examining the sales revenue for a list of products. You could create a crosstab with the Revenue measure and Year dimension on the columns and the Product dimension on the rows, making it easier to spot relationships between the two dimensions. You might also add a Product Category dimension to the outside of the row axis and display the Sum total for the Product dimension, which would display the sum of sales revenue for the products in each category.
Related Information

Right-click Menu Options [page 106]
Adding Totals in a Crosstab [page 108]
Defining the Number Format [page 109]
Adjusting Column Width in Crosstab [page 110]

7.3.2.1 Right-click Menu Options

Many options are available from the right-click menu.

Right-click a crosstab cell for the following options:

<table>
<thead>
<tr>
<th>Cell type</th>
<th>Right-click menu options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dimension name</td>
<td>• <em>Totals</em>: Add a total for the dimension, or manage totals.</td>
</tr>
<tr>
<td></td>
<td>• <em>Sort</em>: You can sort dimension name in charts in ascending or descending order.</td>
</tr>
<tr>
<td></td>
<td>• <em>Select Hierarchy</em>: If a dimension includes a dimension hierarchy, then you can</td>
</tr>
<tr>
<td></td>
<td>include it in the chart.</td>
</tr>
<tr>
<td></td>
<td>• <em>Suppress Zeroes in Row</em>: You can specify whether rows that contain zeros as</td>
</tr>
<tr>
<td></td>
<td>values are to be displayed.</td>
</tr>
<tr>
<td></td>
<td>• <em>Swap Axes</em>: If a chart that you create does not display the worksheet data on the</td>
</tr>
<tr>
<td></td>
<td>axis that you want, you can quickly change the way that data is plotted. For example,</td>
</tr>
<tr>
<td></td>
<td>if rows of data are displayed on the horizontal axis, but you want them to be</td>
</tr>
<tr>
<td></td>
<td>displayed on the vertical axis instead, you can switch rows to columns.</td>
</tr>
<tr>
<td></td>
<td>• <em>Formatting, Font Color, Background Color</em>: You can customize formatting such as</td>
</tr>
<tr>
<td></td>
<td>font, text alignment, and background color. Different types of areas in a crosstab,</td>
</tr>
<tr>
<td></td>
<td>for example row labels, column labels, and data cells, can be formatted separately.</td>
</tr>
<tr>
<td></td>
<td>Select the area of the crosstab that you want to format in the story page.</td>
</tr>
<tr>
<td>Dimension member name</td>
<td>• <em>Keep Member on Axis</em>: Retains that dimension member and excludes the other members.</td>
</tr>
<tr>
<td></td>
<td>• <em>Totals</em>: Add a total for the dimension, or manage totals.</td>
</tr>
<tr>
<td></td>
<td>• <em>Suppress Zeroes in Row</em>: You can specify whether rows that contain zeros as</td>
</tr>
<tr>
<td></td>
<td>values are to be displayed.</td>
</tr>
<tr>
<td></td>
<td>• <em>Formatting, Font Color, Background Color</em>: You can customize formatting such as</td>
</tr>
<tr>
<td></td>
<td>font, text alignment, and background color. Different types of areas in a crosstab,</td>
</tr>
<tr>
<td></td>
<td>for example row labels, column labels, and data cells, can be formatted separately.</td>
</tr>
<tr>
<td></td>
<td>Select the area of the crosstab that you want to format in the story page.</td>
</tr>
<tr>
<td>Measure name</td>
<td>• <em>Sort</em>: You can sort dimension name in charts in ascending or descending order.</td>
</tr>
<tr>
<td></td>
<td>• <em>Suppress Zeroes in Column</em>: You can specify whether columns that contain zeros as</td>
</tr>
<tr>
<td></td>
<td>values are to be displayed.</td>
</tr>
<tr>
<td></td>
<td>• <em>Keep Member on Axis</em>: Retains that dimension member and excludes the other members.</td>
</tr>
</tbody>
</table>

End User Guide: SAP BusinessObjects Lumira Discovery
Building Charts
Cell type | Right-click menu options
---|---
**Number Format**: When you format a measure, you can specify the number format. You can select from a set of standard formats provided by Lumira Discovery.

**Formatting, Font Color, Background Color**: You can customize formatting such as font, text alignment, and background color. Different types of areas in a crosstab, for example row labels, column labels, and data cells, can be formatted separately. Select the area of the crosstab that you want to format in the story page.

---

### Exploring your analysis with SAP BW online

Right-click a crosstab cell for the following options:

Table 27:

<table>
<thead>
<tr>
<th>Cell Type</th>
<th>Right-click menu options</th>
</tr>
</thead>
</table>
| Dimension | **Sort**: You can sort dimension name in charts in ascending or descending order.  
**Expand All**: You can expand a member to show its constituent child members.  
**Collapse All**: You can collapse the member structure to show only the parent member.  
**Expand to Level**: You can quickly drill to a specific level of a hierarchy on the crosstab. Instead of expanding or collapsing individual members, you choose a level of the hierarchy. All of the parent members above that level are expanded, and the members at the level you choose are collapsed so that their children do not appear.  
**Select Hierarchy**: If a dimension includes a dimension hierarchy, then you can include it in the chart.  
**Totals**: Add a total for the dimension, or manage totals.  
**Suppress Zeros in Rows**: You can specify whether rows that contain zeros as values are to be displayed.  
**Compact Display in Rows**: Displaying two or more hierarchies on a crosstab axis is called nesting. With SAP BW data only, you can also combine the display of nested hierarchies on an axis so that they are easier to navigate. |
<table>
<thead>
<tr>
<th>Cell Type</th>
<th>Right-click menu options</th>
</tr>
</thead>
</table>
| Measure         | • Sort: You can sort dimension name in charts in ascending or descending order.  
|                 | • Number Format: When you format a measure, you can specify the number format. You can select from a set of standard formats provided by Lumira Discovery.  
|                 | • Add Dynamic Calculations: Opens a list of dynamic calculations. Select one of the dynamic calculations from the list. The calculation is added as a new column or row member to the right of or beneath the selected measure.  
|                 | • Keep Member on Axis: Retains that dimension member and excludes the other members.  
|                 | • Suppress Zeroes in Column: You can specify whether columns that contain zeros as values are to be displayed.  
|                 | • Compact Display in Column: Displaying two or more hierarchies on a crosstab axis is called nesting. With SAP BW data only, you can also combine the display of nested hierarchies on an axis so that they are easier to navigate. |

7.3.2.2 Adding Totals in a Crosstab

To get a summary of your data, you can add totals for dimensions on the rows or columns of the crosstab. Totals show an aggregation, such as a sum or an average, of the values of each measure.

Context

Data in crosstabs can be analyzed at different levels.

Procedure

1. Right-click a dimension in the crosstab and choose Totals to select a total that you want to display.
2. If you want to configure multiple totals, select **Totals > Select Multiple Totals**

   In the dialog that appears, select the totals that you want to display for that dimension, and use the up or down arrow to change the order in which they appear in the crosstab.

   Table 28:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Minimum</td>
<td>The smallest value for the corresponding area is displayed as the result.</td>
</tr>
<tr>
<td>Maximum</td>
<td>The highest value for the corresponding area is displayed as the result.</td>
</tr>
<tr>
<td>Sum</td>
<td>The total of all values for the corresponding area is displayed as the result.</td>
</tr>
<tr>
<td>Count</td>
<td>The count of all values for the corresponding area is displayed as the result.</td>
</tr>
<tr>
<td>Average</td>
<td>The average (total divided by total number of values) of all values for the corresponding area is displayed as the result.</td>
</tr>
<tr>
<td>Result</td>
<td>The result of all the values are displayed.</td>
</tr>
</tbody>
</table>

3. To show the totals in the crosstab, choose **Totals > Show Totals**.
4. To hide totals that only have one member, choose **Totals > Hide Totals if Only One Member**.
5. To hide the totals in the crosstab, choose **Totals > Hide Totals**.

### 7.3.2.3 Defining the Number Format

You can define the scaling factor and decimal places of the number format of data cells.

**Procedure**

1. Select a cell from the measure that you want to change.
2. Right-click and choose **Number Format**.
3. In the **Number Format** dialog box, select the **Scaling Factor** and the **Decimal Places** that you want to use for the measure display.
4. In a **Crosstab** chart, select the required option from the **Units and Scaling Factor** dropdown to show/hide the scaling factor in the crosstab.
5. Choose **OK**.

   The data cells of the selected measure are displayed according to your definition.
7.3.2.4 Adjusting Column Width in Crosstab

If the content of a column in the crosstab is too big or too small for the calculated column width, you can adjust the column width to the length of the cell content.

Procedure

1. Hover over the column header cell that you want to adjust, to show the clickable area in the right cell margin.
2. Double-click this area to adjust the column width.

7.4 Blending Your Data

Data blending is the self-service join of a primary data source with one or more secondary data sources that contain a common linked dimension.

Prerequisites

You have used only linked dimensions in your visualizations.

Context

If you want to visualize data from multiple datasets, you blend data and build a visualization from the blended data. The next step is to aggregate or summarize the information with appropriate measures or calculations in the chart.

Unlike merging datasets, you don’t need a unique key to blend your data. You can correlate two columns whose values are either the same or unique.

Procedure

1. Launch Lumira Discovery and acquire one dataset.
2. From the Global Tool Bar, choose New Dataset and add another dataset.
3. Right-click the chart and select (Maximize).
4. In the Chart Builder, on the Datasets in Use shelf, choose (Add) and add the datasets whose data you want to combine.

When you add the secondary dataset, the Link Datasets dialog appears.

5. Select the common dimension from both the datasets and link it.

You can link dimensions having a unique or different value.

6. Choose OK.

You can now view both datasets on the Datasets in Use shelf and the linked dimension on the Active Linked Dimensions shelf.

Also, to add a measure or dimension from other dataset, click the (Add) beside X Axis or Y Axis and then click the to select the dataset and select the value.

7. Add the linked dimension and other measures in the respective shelves in Chart Builder and build the chart.

You cannot blend a visualization created using online dataset with a visualization created using offline dataset and vice-versa.

You obtain a chart that contains blended visualization from one or more datasets.

---

**Example**

Suppose you have one dataset showing population values by **Country** and **City**; another dataset has the Average **Net Income** value broken down by **Country**. You need to first join the data that contains common dimensions (that is, **Country**) from those two datasets. Lumira Discovery can now join (by a left outer join) data from aggregate tables into one blended visualization. Henceforth, you can have one visualization that displays **Population** values from one dataset, matched with Average **Net Income** values from another dataset, based on a common **Country** dimension.
### 7.5 Renaming a Chart

The title displayed above a chart is generated automatically from the measures and dimensions added to the chart.

**Procedure**

1. Right click the existing chart title and select *Rename Title*.
2. Alternately, double-click the title to enter a new name.
3. Make the required changes and save the document before you exit from Lumira Discovery.

#### 7.5.1 Restoring a Chart's Default Title

After a chart’s title has been changed, you have the option of restoring the original title that was generated automatically from the measures and dimensions in the chart.

**Procedure**

Right click the existing chart title and select *Restore Default Title*.
## 8  Do More with Charts

### 8.1  Reference Lines

Some chart types allow you to define reference lines to show important dates or values on your chart. You can add reference lines that represent the dates of key project milestones for example.

Lumira Discovery provides two types of reference lines: *Fixed*, and *Dynamic*. Value-Fixed reference lines are created with a specific reference value, and don't change when you change the data in your chart; for example if you filter your data. Dynamic-value reference lines are updated when filters, ranking, and sorting are applied to the chart.

Reference lines aren't visible on unsupported chart types, but once created, they will appear if you switch to one of the supported chart types listed above.

When you place the pointer over a reference line, a tooltip shows you the corresponding value and label.

#### 8.1.1  Adding a Reference Line

**Procedure**

1. Select the visualization and select the *Reference Lines* option. The *Add Reference Line* dialog box appears.
   
   Alternatively, select the visualization, expand it using the (Maximize) icon and then choose the (Reference Lines) icon from the visualization toolbar.

2. Select the type of reference line you want to create in *Type* field.
   
   If your visualization shows part’s costs for example, you could choose the fixed value 500, or you could select the dynamic value *Average* by choosing the *Cost* measure and the *Average* aggregation.

3. If you choose a fixed value, follow these steps:
   
   a. Select an axis to add the reference line to.
   
   b. Enter a reference value.
      
      For a date/time axis, you can choose a date value for each reference date, or you can specify that you want the line to always appear at the current date (*Today*) on the axis. For other axis, accept the reference value if one is provided, or type a new value.

4. If you choose a *Dynamic* value, select the *Measure* to base your reference line on, and choose an *Aggregation* type.

5. Provide a name for the reference line in the *Edit Label* field or leave it empty.

6. Choose *Formatting*, and then choose *OK* to create the reference line.
When you define the reference line for the first time, the Add Reference Line dialog box is displayed. When you define rules subsequently, the Manage Reference Lines dialog box is displayed, where you can edit, add or remove, turn on or off the reference line.

7. Choose the \( \text{Minimize} \) icon to return to the chart canvas, where you can see your modifications.

### 8.1.2 Managing Reference Line

When you define the reference line for the first time, the Add Reference Line dialog box is displayed. When you define rules subsequently, the Manage Reference Lines dialog box is displayed. Here you can edit, add or remove, turn on or off the reference line.

#### Procedure

1. Choose \( \text{(Reference Lines)} \).
2. In the Manage Reference Lines dialog, perform any of these actions:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>To create a reference line</td>
<td>Select the ( \text{+} ) (New Reference Line).</td>
</tr>
<tr>
<td>To delete a reference line</td>
<td>Select the ( \text{-} ) (Delete Reference Line).</td>
</tr>
<tr>
<td>To move or change a reference line</td>
<td>Select a reference line and choose ( \text{Edit Reference Line}. )</td>
</tr>
<tr>
<td>To disable a rule</td>
<td>Clear the check box in the Show column. Disabled reference lines are not applied to the chart, but you can turn them on again if necessary.</td>
</tr>
</tbody>
</table>

3. Choose OK.

4. Choose the \( \text{Minimize} \) to return to the chart canvas and see your modifications.
8.2 Sorting

You can sort measures in charts in ascending or descending order.

8.2.1 Sorting Measures

Prerequisites

If you have filtered the data in your chart by rank, remove the rank before sorting measures.

Procedure

1. Select the visualization and choose \( \text{(Sort)} \).
2. Choose the measure that you want to sort the values on and then select the sorting order.

Alternatively, expand the visualization using \( \text{(Maximize)} \). Choose \( \text{(Sort)} \) and select the measure you want to sort. When you click on \( \text{(Sort)} \) for the first time, the values are sorted by default in descending order. When you click again, the values are sorted in ascending order, and the measures are sorted based on the dimensions.

Note

Sorting dimensions does not affect the data displayed in a visualization. You can sort measures based on a dimensions selected in your visualization.

Results

The data in the chart is sorted.
8.3 Conditional Formatting

Conditional formatting can highlight important data points in a chart by distinguishing values that meet a condition (such as being greater than a certain number or within a specific range).

You can define multiple conditional formatting rules on one or more measures or dimensions in the following chart types:

- Column & Bar
- Pie
- Time Series
- Table

For the following chart, you can define conditional formatting rules on dimensions that are added to the Color shelf, or to the Rows or Columns shelves in the Trellis section:

- Line & Area charts

You can also apply conditional formatting rules to measures displayed as lines in all types of line charts. The only operator available for these rules is the is any value operator.

These rules are preserved when you switch between chart types, and is applied to any valid chart type.

The Manage Rules dialog allows you to work with all the rules created for a chart.

Crosstabs support custom formatting for the text and background color of cells. For other charts, you can change the color of bars, columns, line, and pie slices, but text formatting does not apply.

**Example**

In a bar chart with a measure that shows inventory shrinkage at your company’s retail outlets, you could use conditional formatting to identify stores with high rates of shrinkage. A conditional formatting rule could change the bar color to red for each store with shrinkage higher than an amount you specify.

**Multiple conditional formatting rules**

- When you create multiple conditional formatting rules based on the same measure or dimension, data points may meet the condition for multiple rules. When this happens, the formatting for each rule that applies to a data point (that is, active rules) is considered a set. Formatting for each set is be applied or ignored, depending on the rule priorities.
- For each data point, the formatting set for the highest-priority active rule is applied first. Formatting for lower priority rules can also be applied. However, if two formatting sets for active rules modify the same attribute, none of the formatting defined for the lower priority rule is applied to the data point.
- For each data point, bold and italic formatting can be applied only by the highest priority active rule.

**Example**

A crosstab cell meets the conditions for three conditional formatting rules. The highest-priority active rule sets the font to Times New Roman. The rule with the second highest priority sets the background color to
8.3.1 Creating Conditional Formatting Rules

Procedure

1. Right click the visualization and select the Conditional Formatting option.
   
   Alternatively, select the visualization, expand it using (Maximize) and then select (Create Conditional Formatting) from the Visualization toolbar.

2. In the Conditional Formatting Settings dialog, Choose (Create Conditional Formatting Rule).
   
   The New Formatting Rule dialog box appears.

3. Enter a name for the rule.
   
   The name allows you to identify the rule in the Conditional Formatting Settings dialog, and also appears in the legend of the chart, if applicable. If you do not enter a name, the rule is named automatically, based on the condition that you set.

4. In the Based on list, select a measure or dimension.
   
   This measure determines the values that are used in the rule and the data points where formatting appears. You can set multiple conditional formatting rules on a single measure or dimension.

5. Select an operator, and enter one or more values for the condition.

6. Select Text Format, choose the appearance of data points that meet the condition.
   
   Crosstabs can display the background color as well as the text style that you set. For charts, only the data point color is applied, for example one specific bar in a Bar chart.

7. Choose OK.

Results

You have set the conditional formatting rule to the chart. By default, new conditional formatting rules have higher priority than older rules. The rule added for one particular chart is also displayed while working with other charts. You can choose to include that rule or create a new rule. For example, you have created and added a rule for bar chart, when you want to create a rule for crosstab the rule created in bar chart is displayed in the dialog. You can choose to add the same rule or create a new rule for crosstab.

Next Steps

If needed, you can use the Manage Rules dialog to change the priority of rules.
8.3.2 Managing Conditional Formatting Rules

In the Manage Rules dialog box you can edit, add or remove, turn on or off, and set the priority order of your rules.

Procedure

1. Choose (Conditional Formatting).
2. In the Manage Rules dialog, perform any of these actions:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>To create a rule</td>
<td>Choose (Create Conditional Formatting Rule).</td>
</tr>
<tr>
<td>To delete a rule</td>
<td>Choose (Delete Rule).</td>
</tr>
<tr>
<td>To duplicate a rule</td>
<td>Choose (Duplicate Rule).</td>
</tr>
<tr>
<td>To modify a rule</td>
<td>Select a rule and choose Edit Rule.</td>
</tr>
<tr>
<td>To disable a rule</td>
<td>Clear the check box in the Applied column next to the rule name. Disabled rules are not applied to the chart, but you can turn them on again if necessary.</td>
</tr>
<tr>
<td>To change the priority of a rule</td>
<td>Select a rule and use the Change Rule Order option to move it higher or lower in the list.</td>
</tr>
</tbody>
</table>

3. Choose OK.

8.4 Display Formatting

You can format settings and display the data point in different formats on a chart.

Context

Display formatting is applicable only on a measure. It is helpful when you want to view each data point on a chart for detailed information. For example, if a measure in your dataset is not in percentage format, you can format and display it as a percentage value on the chart.

You can make changes on a measure at both document level and visualization level. To change the settings at document level, after selecting a measure from the Side Bar and make formatting changes, the changes are therefore applied to all visualizations, pages, and stories. To change settings at visualization level, select the chart and choose Number Format option and do the required changes. For more information on display formatting options using Number Format, see Defining the Number Format [page 109].
Procedure

1. From the Side Bar, select the measure and choose Display Formatting.
   The Display Format for Measure dialog appears.
2. Under Select a value format, select one of the following:
   - Number: To display the value in decimal format.
   - Percentage: To display the value in percentage format.
3. Under Select a custom symbol, select the one of the following:
   - None: If no additional value is required.
   - Prefix: To add a prefix, if you have chosen Number as value format.
   - Suffix: To add a suffix, if you have chosen Number as value format.
4. Under Symbol, enter the Prefix or Suffix value.
5. Choose OK

8.5 Modifying Chart Colors and Appearance

Lumira Discovery provides color palettes that have been designed to work well together and effectively apply color to data in many situations, such as on heat maps, bar charts, etc. You can create and customize the appearance of charts and perform the following:

- For dimensions, you can create a custom palette from preferences or visualizations.
- For measures, you can create a custom palette from preferences or visualizations.

You can create or edit palettes while in preferences and save them to palettes. While in visualizations however, you can only modify the color palettes for the particular visualization you are in.

Note

- When you create a chart, the color and template settings that you set in the Chart Style section of the Preferences dialog are applied by default. Select File > Preferences > Charts to access these settings.

8.5.1 Dimension Color Palette

8.5.1.1 Creating a Dimension Color Palette from Preferences

Context

This section describes how to create a custom dimension palette from Preferences.
Procedure

1. To create a dimension custom palette from preferences, launch Lumira Discovery and choose
   ▶ Preferences ▶ Charts ▶
2. Select the Default Dimension Palette dropdown list.
3. Choose Create Dimension Palette.
   The Create Dimension Palette dialog appears.
4. To choose the required custom color palette, perform the following:
   a. Choose (Add Color).
   b. Select the required color from the color picker.
   c. Enter the name for the palette.
   d. (Optional) You can also choose (Reverse) to change the order of the palette colors from light to dark, or vice versa.
   e. Choose Create.
5. If you want to set a color palette as default, select the required User Defined Palettes or Standard Palettes from the Default Dimension Palette dropdown list.

Results

You have now created a color palette. The palette that you have created is listed under the Default Dimension Palette dropdown list under User Defined Palettes.

8.5.1.2 Creating a Dimension Color Palette from Visualizations

Prerequisites

Choose a chart type and add one or more dimensions and measures to the chart before customizing its appearance.

Note

You can also use an existing visualization or chart for customizing its appearance.

Context

This section describes how to create a custom dimension palette from visualizations.
Procedure

1. Launch Lumira Discovery.
2. Open a document that you want to view.
3. Choose the required visualization.
4. Right click on the visualization and select Choose Colors.
5. Choose Customize Dimension Palette.
   Customize Dimension Palette dialog appears.
6. Choose (Add Color).
   
   **Note**

   If the boxes are already filled with colors, the icon is not displayed.

7. Select the required color from the color picker.
8. (Optional) You can also choose (Reverse) to change the order of the palette colors from light to dark, or vice versa.
9. Select the Save As User Defined Palette option.
   
   **Note**

   If you don’t choose the Save As User Defined Palette option, the colors that you customized is only be applicable for the particular visualization you are working in.

10. Enter the name for the palette.
11. Choose OK.

Results

You have now created a color palette. The palette that you created is listed under the Default Dimension Palette dropdown list under User Defined Palettes.

8.5.1.3 Editing a Dimension Color Palette

Context

This section describes how to edit a dimension color palette from Preferences.
Procedure

1. To edit a dimension color palette from Preferences, launch Lumira Discovery and select Preferences > Charts.
2. Choose the required color palette from the Default Dimension Palette dropdown list.
3. Edit a color from the referenced palette by selecting (Edit). The Edit Dimension Palette dialog appears.
4. If you want to add more colors, perform the following:
   a. Choose + (Add Color).
   b. Select the required color from the color picker.
5. (Optional) You can also choose (Reverse) to change the order of the palette colors from light to dark, or vice versa.
6. If you want to remove the existing color from the box, choose the color and choose (Remove Color).
7. Choose OK.

Results

You have now edited a color palette.

8.5.1.4 Deleting a Dimension Color Palette

Context

This section describes how to delete dimension color palette from Preferences.

Procedure

1. To delete a dimension palette from Preferences, launch the Lumira Discovery and select Preferences > Charts.
2. Select the palette from the Default Dimension Palette dropdown list.
3. Choose (Delete).
4. Choose Done.
Results

You have now deleted a color palette.

8.5.2 Measure Color Palette

8.5.2.1 Creating a Measure Color Palette from Preferences

You can create a custom measure palette from Preferences.

Procedure

1. To create a measure custom palette from Preferences, launch the Lumira Discovery and select Preferences ➤ Charts ➤ Preferences ➤ Charts.
2. Select the Default Measure Palette dropdown list.
3. Choose Create Measure Palette.
   
   The Create Measure Palette dialog appears.
4. In the Create Measure Palette dialog, choose the number of colors you want to use in the Number of Colors dropdown list.
   
   You can use between two and nine different colors in the palette. The setting is reverted to nine when you choose a new palette.
5. To create a single color gradient, choose (Add Color) from the top or bottom box and select a color from the color picker.
6. To create a double color gradient, choose (Add Color) from the top and bottom box and select a color from the color picker.
7. Select the Generate Gradient check box.
   
   This creates a new palette based on the selected colors.
8. (Optional) You can also choose (Reverse) to change the order of the palette colors from light to dark, or vice versa.
9. Enter a name for the palette.
10. Choose Create.
11. If you want to set a color palette as default, select the required User Defined Palettes or Standard Palettes from the Default Measure Palette dropdown list.
Results

Your new color palette is listed in the Default Measure Palette dropdown list, under User Defined Palettes.

8.5.2.2 Creating a Measure Color Palette from Visualization

You can create a custom measure color palette from a visualization.

Prerequisites

You have chosen a chart type and added one or more dimensions and measures to the chart before customizing its appearance.

Note
You can also use an existing visualization or chart to customize its appearance.

Procedure

1. Launch Lumira Discovery.
2. Open a document that you want to view.
3. Choose the required visualization.
4. Right-click the visualization and select Choose Colors.

Note
Some charts, such as heat maps, tree maps, tag clouds, geo maps, and geographic choropleth charts, can display measure-based colors.

5. Choose the Customize Measure Palette dropdown list.
6. In the Number of Colors dropdown list, choose the number of colors you want to use in the palette.

You can use between two and nine different colors. The Number of Colors setting is reverted to five when you choose a new palette.

Note
This step is applicable to measure palettes created from visualization only.
7. To create a single color gradient, choose (Add Color) from the top or bottom box and select a color from a color picker.

8. To create a double color gradient, choose (Add Color) from the top and bottom box and select a color from a color picker.

9. Select the Generate Gradient check box. This automatically creates a new palette based on the selected colors.

This creates a new palette based on the selected colors.

Be aware of how the threshold values and colors are affected by modifying the color count in the Number of Colors list:

Table 29:

<table>
<thead>
<tr>
<th>Action</th>
<th>Effect on Threshold</th>
<th>Effect on Colors</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select Generate Gradient button and increase or decrease color count</td>
<td>Regenerated</td>
<td>Regenerated based on first color</td>
</tr>
<tr>
<td>Unselect Generate Gradient button and increase color count</td>
<td>Threshold values for additional steps remain the same as previous value</td>
<td>Colors for additional steps remain the same as previous color</td>
</tr>
<tr>
<td>Unselect Generate Gradient button and decrease color count</td>
<td>Truncated</td>
<td>Truncated</td>
</tr>
</tbody>
</table>

10. Type numeric values in the fields for each color in order to set the color thresholds.

Invalid entries are highlighted in red.

11. (Optional) You can also select (Reverse) to change the order of the palette colors from light to dark, or vice versa.

12. Select the Save As User Defined Palette option.

**Note**

If you don’t select the Save As User Defined Palette option, the colors that you have customized will only be applicable for the particular visualization you are working in.

13. Enter the name for the palette.

14. Choose OK.

The palette that you created is listed in the Default Measure Palette dropdown list under User Defined Palettes.
8.5.2.3 Editing a Measure Color Palette

You can edit measure color palettes from preferences.

Procedure

1. To edit measure color palettes from preferences, launch Lumira Discovery and choose Preferences ➤ Charts.
2. Select the required color palette from the Default Measure Palette dropdown list.
3. Choose (Edit).
4. In the Edit Measure Palette dialog, proceed as follows to edit the palette colors:
   a. In the Number of Colors dropdown list, choose the number of colors you want to use.
      
      **Note**
      
      You can use between two and nine different colors in the palette. The Number of Colors setting is reverted to five when you choose a new palette.
      
      b. To edit a single color gradient, choose (Add Color) from the top or bottom box and select a color from the color picker.
      
      c. To edit a double color gradient, choose (Add Color) from the top and bottom box and select a color from the color picker.
      
      d. To switch from dual color gradient to single color gradient, choose (Remove Color).
5. Choose OK.

Results

You have now edited a color palette.
8.5.2.4 Deleting a Measure Color Palette

You can delete a measure color palette from preferences.

Procedure

1. To delete a measure palette from preferences, launch Lumira Discovery and select Preferences > Charts.
2. Choose the required color palette from the Default Measure Palette dropdown list.
3. Choose (Delete).
4. Choose OK.

Results

The measure color palette has been deleted from preferences.

8.6 Hierarchical Data

The (Dimension Hierarchy) icon indicates that a hierarchy is associated with a dimension. There are multiple ways you can find and interact with hierarchical data.

8.6.1 Finding Dimensions in a Hierarchy

Context

Only the dimension containing the highest level of a hierarchy appears on the Measures and Dimensions pane, but you can expand the dimension to see additional levels.

You can add a dimension at any level of the hierarchy to a chart.
Procedure

In the Measures and Dimensions pane, select the (Expand Levels) beside a dimension to display all dimensions in the hierarchy.

8.6.2 Drilling Through Hierarchical Data

Context

If hierarchical dimensions are included in a chart or crosstab, you can drill up or down through dimensions on the chart to explore the data at different levels. You can at any time undo the drill operation and restore the chart to its original state.

The drill operation comprises:

- applying a filter
- redrawing the visualization at the new level in the hierarchy

When you drill, a filter token appears above the chart, or the filter may be added to an existing filter token.

8.6.2.1 Drilling Down and Up

Context

Drilling on visualizations provides a better understanding of your data and lets you discover the good or bad summary displayed on the visualization. The drill option allows you to either drill up or down to a dimension using the displayed hierarchy. For example, you have a crosstab or chart displaying countries (India, USA, Germany) and their respective sales revenue. You are interested to know the states that contributed to the sales revenue for India. So, you can right-click on India and perform a drill down operation. On performing this operation, a filter is applied on the country dimension and the state column replaces the country column in the chart or the crosstab. This is how you can drill up or drill down using the path defined in the hierarchy.

Procedure

1. Create a chart or a crosstab with the hierarchical dimension.
2. Right click on an area in the chart or a label on the axis or a cell in a crosstab.
3. Select Drill Down or Drill Up option.

For example, to drill down one field at a time, click one of the elements in your visualization, in a bar chart this means clicking one of the bars and in a tree map, this means clicking one of the leaves. Notice that the title changes as you drill down and up again.
A filter is applied to the data and new level of hierarchy is added to the same chart.

**8.6.2.2 Drilling By in a Hierarchy**

**Context**

On performing Drill By operation on a hierarchical dimension, the next lower level dimension gets added to the chart or crosstab without replacing the existing dimension.

For example, the visualization has a hierarchy made up of continent, country, city, and postal codes. Each continent has one or more countries, each countries has one or more cites, etc. By default, the visualization displays only the continent data as it the top node in the hierarchy. Now, you are interested in Asian countries. So, you perform a Drill By operation on a crosstab to add a country column next to the continent column in the visualization.

**Procedure**

1. Right click on an area in the chart or a label on the axis or a data cell in a cross tab.
2. Select the *Drill By* option.

   An extra column gets added in case of crosstab and a next level dimension gets added to color feed in the case of other charts.

**8.6.2.3 Drill Path Hierarchies**

A dimension can be part of multiple hierarchies. When you use such a dimension in your visualization, you can choose the hierarchy path to perform the drill operation. The selected the Drill Path acts as reference for further Drill Up and Drill Down operations.

**Context**

For example, the dimension Employee ID can be part of one or more hierarchies. The first hierarchy consists of country, region, city, Employee ID etc. The second hierarchy consists of country, sub-region, city, Employee ID etc. You can choose to analyze the data based on one of the hierarchies listed for Employee ID.

**Note**

Drill path hierarchies are supported only for offline and SAP HANA online data sources consisting of level based hierarchies.
**Procedure**

1. Drag a dimension from object picker which is part of 2 or more hierarchies and drop it to chart.
2. Select an area in the chart or a label on the axis.
3. Right click and choose *Drill Path*.
   
   Dropdown list appears.
4. Select a required hierarchy to analyze your data.

   After selecting Drill Path and performing Drill Up or Drill Down operation, the selected hierarchical path is considered.

**8.7 Plotting Measures as a Dimension in a Chart**

Plotting measures as a dimension in a chart can show how data is spread over multiple measures on a single axis.

**Context**

You can include two or more measures as a dimension in a chart. Each measure is plotted as a dimension value on an axis or in a separate chart. (For trellis charts, measures always appear in a separate chart.) The chart automatically updates to show the new measure dimension.

**Procedure**

1. Drag a measure from the *Measures and Dimensions* pane to a shelf.
2. Drag a second measure directly under the first measure, and drag each additional required measure under the previous measure.
3. Right-click on the Chart Canvas menu bar, and select *Use Measures as a Dimension*.
   
   For example, if the Revenue_Margin measure dimension is on an *X Axis* box, and the Product_Line dimension is in the *Color* box, each measure is plotted on the *X Axis* with Product_Line values shown in distinguishing colors.
   
   Measures appear as a new measure dimension on the *Measures and Dimensions* pane.
4. To display each measure in a separate chart, drag the combined measure to the *Columns or Rows* box on the *Trellis* panel.
   
   The chart displayed is split by each measure name.
9 Stories

A story is a presentation-style document that uses visualizations, text, graphics, illustrations, shapes, and other customizations to describe data. Explore and analyze the data using filters, controls, calculations, conditional text, and other tools. A story may have a single visualization or pages full of visualizations.

Related Information

Creating a Story [page 131]
Formatting a Story Page [page 132]
Enhancing your stories With Shapes, Illustrations, Text Boxes, and Images [page 135]

9.1 Creating a Story

Use visualizations together with pictures and text to create a story about data. Explore and analyze the data using filters, controls, calculations, conditional text, and other tools.

Context

Various options are available to help you develop professional-looking documents. Each page in a story can have its own template, and you can add, move, and delete pages as you work. You can also save your story and create a new one at any time.

The DESIGN area contains content such as Images, Illustrations, and Shapes. Drag content from these areas onto sections of the story page.

Procedure

1. Create a story by choosing the (Create new story).
2. Drag a Measure or Dimension from the DESIGN pane to a section in the story page.
3. To customize a visualization with filters, ranking, calculations, or drilling through hierarchical data click the visualization and select the required option Measures and Dimensions.
Alternatively, choose the visualization, expand it using the (Maximize) and choose the required option from the visualization toolbar.

4. Choose Preview to see how the story will appear when published.

5. To create additional pages, choose the (Add New Page).

Lumira Discovery can have more than one story. As and when you add stories, their titles are added next to the Story tab.

6. Save the story.

   You can save the story if you own it or have permissions to edit it.

7. If you want provide your own descriptive names for story, then right click story and choose Rename.

8. If you want to delete a story, choose the next to the story and select Delete.

9. If you want to duplicate a story, choose the next to story and select Duplicate.

### 9.2 Formatting a Story Page

**Context**

Every story has one or more pages that can contain items such as visualizations, text, graphics, and input controls. You can create new pages in a story and select between the pages in the story.

**Procedure**

1. Create a page by selecting the (Add New Page).
2. Right click the page to display the options available.
3. Select page formatting options, as needed.
Table 30: Page Settings Pane

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Settings</strong></td>
<td>To format the size, general appearance, and behavior of each page, right click on the page and select <strong>Settings</strong>.</td>
</tr>
<tr>
<td></td>
<td>The followings options are provided in the <strong>Page Settings</strong> pane:</td>
</tr>
<tr>
<td></td>
<td>○ <strong>Size</strong>: Select <strong>Standard (4:3)</strong> or <strong>Extended (16:9)</strong> or <strong>BI Launchpad (20:7)</strong> or <strong>Custom</strong>, depending on the preferred layout and the type of device that the published story is viewed on. Set the default page size (in pixels). This allows you to design story pages based on the size of the screen they are viewed on, whether it is larger or smaller than the screen used to create the pages. You only need to set one value; the other is set automatically.</td>
</tr>
<tr>
<td></td>
<td>○ Select <strong>Current Page</strong> to apply page settings only to the chart that you are working with, or choose <strong>All Pages</strong> to apply page settings to all visualizations in a story.</td>
</tr>
<tr>
<td><strong>Duplicate</strong></td>
<td>To duplicate the existing page, right click on the previous page and select <strong>Duplicate</strong>.</td>
</tr>
<tr>
<td><strong>Page Rename</strong></td>
<td>To rename the page, right click on the page and select <strong>Page Rename</strong>.</td>
</tr>
<tr>
<td><strong>Move Left</strong></td>
<td>To move the page left, right click on the page and select <strong>Move Left</strong>.</td>
</tr>
<tr>
<td><strong>Move Right</strong></td>
<td>To move the page right, right click on the page and select <strong>Move Right</strong>.</td>
</tr>
<tr>
<td><strong>Delete</strong></td>
<td>To delete the page right, right click on the page and select <strong>Delete</strong>.</td>
</tr>
</tbody>
</table>

4. Choose **Done**.

5. If you want to set grid lines for the page, then choose (Show/Hide Grid). Grid lines make it easy to align elements and achieve a professional appearance for your story.

6. If you want to add background color for the page, then choose **Choose Background** on the **Design** tab and choose the required color.
   Select **Apply to all Pages** checkbox to apply background color to all the pages in the story.

7. If you want to adjust the screen width, select (Fit to Width) to adjust the page size to the available screen space.

8. If you want to adjust the screen height, select (Fit to Height) to adjust the page size to the available screen space.

9. If the content is larger than available screen space, select (Fit to Content) to adjust the screen space.

10. If you want to retain the original screen space, select (Actual Size).
9.3 Formatting a Visualization

Visualizations can be easily customized to emphasize the data message.

Context

Use the Set Visualization Properties to modify the appearance of each visualization in the page. Different options are available for formatting, depending on the type of chart in your visualization.

To display the Set Visualization Properties, select a visualization in the page.

Procedure

1. Select a visualization on a story page and navigate to Set Visualization Properties. The Set Visualization Properties displays the options available. Different types of charts have different options.

Table 31: Property Panel Options

<table>
<thead>
<tr>
<th>Area</th>
<th>Description</th>
</tr>
</thead>
</table>
| General (Includes options generic to all the charts) | ○ Chart Area: Select the background color of the chart area.  
○ Chart Title: Display the chart title and format it. Use the default name or enter a new name.  
○ Plot Area: Select the background color of the plot area.  
○ Legend: Display a chart legend and to display a legend title and format it.  
○ Data Label: Display data labels or data-label pictograms.  
○ Horizontal Axis Title: Display the axis title and format it.  
○ Horizontal Axis: Display the axis line and ticker, display axis labels and format them, and display axis pictograms.  
○ Vertical Axis: Display the axis line and ticker, display axis labels and format them, and adjust the axis value scale.  
○ Vertical Axis Title: Display the axis title and format it.  
○ Enable Interactive Mode: This allows you to view report results within the document, and format the look and feel of the document in Mobile and desktop devices. |
| Bar chart | Bar: Select a bar shape or pictogram to display as the bars in a bar chart, and choose the color of the bars. |
2. From the drop box, select the area of the visualization you want to format.
   The formatting options for the selected visualization area appear.
3. Format the visualization area.
4. Save the story.

### 9.4 Enhancing your stories With Shapes, Illustrations, Text Boxes, and Images

Along with data-bound visualizations, you can also add elements such as text boxes, images, illustrations, and shapes to improve your visualization.

**Text Box**: You can add text to sections in a story page, or overlay the text on a visualization. Text boxes are an ideal way to display large titles, captions, or short paragraphs of information along with your visualizations. If a page has multiple elements (visualizations, pictures, pictograms, and shapes), use text to reinforce the intended message. For Information, see Adding Text to a Story [page 136].

**Illustrations and Shapes**: You can add visual flair to your story using illustrations and shapes. Before you can add your own pictograms and shapes to stories, you have to upload them to the application. The graphics
must be in Scalable Vector Graphics (SVG) format. For more information, see Uploading Custom Illustrations and Shapes [page 137].

Images: Selecting image will open a file browser where you can select the image from your computer or other networked source.

9.4.1 Adding Text to a Story

You can add text to sections in a story page, or overlay the text on a visualization.

Context

When a page has multiple elements (visualizations, pictures, pictograms, and shapes), use text to reinforce the intended message.

Procedure

1. Select the visualization or the page section to add text to.

2. Choose Choose Text on the Design tab, and drag the box for the required type of text from the panel to the page.
   A blue bounding box shows the position of the text box in the visualization.

3. Enter the required text in the box.

4. (Optional) To move the text box, drag the bounding box to a new location.

5. (Optional) To resize the text box, select an anchor on the bounding box, and drag it to the required size.

6. To delete the text box, right-click the text box and choose Delete.

7. To copy the text box, right-click the text box and choose Copy.

8. To cut the text box, right-click the text box and choose Cut.
9.4.2 Uploading Custom Illustrations and Shapes

Before you can add your own pictograms and shapes to stories, you have to upload them to the application. The graphics must be in Scalable Vector Graphics (SVG) format.

Procedure

1. Select the visualization or the page section to add illustrations or shapes to.
2. Choose (Choose Graphic) on the Design tab.
3. Select Illustrations or Shapes
4. Select + (Upload Illustrations/Shapes).
5. If you overlap many images on one another and want to move an image to the front or back, then right-click the image and select Send to Back or Bring to Front options.
6. Choose the .svg file to add, and select Open.
   The file must be an SVG file with valid XML encoding.

Results

The graphic appears under Illustrations or Shapes. You can add custom illustrations as part of a visualization.

9.5 Linking to a Web Page or to Another Page in the Story

You can add a hyperlink pointing to an external web page, or to another page in the same story. The hyperlink can be added to highlighted text in text boxes, pictograms, shapes, and pictures.

Procedure

1. Right-click the text, pictogram, shape, or picture that you want to link from, and select Hyperlink.
   For text, select the text itself, not just the frame containing the text.
2. In the Link to list, select External URL or Page.
3. Enter an external web page’s URL, or select a page in the story to link to.
4. Select OK.
   By default, clicking the hyperlink opens the page in a new browser window.
9.5.1 Modifying a Hyperlink

You can modify a hyperlink so that it points to a different web page, or to a different page in the story.

Procedure

1. Right-click the text, pictogram, shape, or picture that you want to modify, and select **Hyperlink**.
2. Modify the URL or change the story page to link to.
3. Select **OK**.

9.5.2 Removing a Hyperlink

You can remove a hyperlink.

Procedure

1. Right-click the object that you want to remove the link from.
2. Select **Remove**.
10 Filters

A filter is a restriction imposed to limit the values displayed. You create filters by choosing values or ranges of values from a dimension to include or exclude.

You can filter data in an entire dataset or in a single visualization. Filters applied to a dataset affect any chart that uses the data. However, filters applied to a visualization affect only the current chart (not the entire dataset). When viewing stories, you can also filter data in individual visualizations, in an entire page, or in the whole story. A page filter applies to all the visualizations on the page. A visualization filter applies to a single visualization on a page. And a story filter applies to all pages.

Related Information

Filtering Data in Visualization [page 141]
Filtering Data in Stories [page 143]
Filtering Data from Dataset [page 139]

10.1 Filtering Data from Dataset

Dataset filters allow you to easily filter a data list while working with large amounts of data. Add a filter to a dataset to limit the data in a report after the data is retrieved from an external data source. When you add a filter to a dataset, all report parts or data regions use only data that matches the filter conditions.

Context

You use the filter dialog to define a filter on the dataset and all the visualizations based on it. The filter dialog does not support SAP BusinessObjects Lumira formula language or regular expressions (regex). You need to add a calculated measure or dimension to create a more complex filter.

Procedure

1. Navigate to DataView.

   i Note

   You can view and apply dataset filters only in DataView.
2. To open the filter dialog, select the \( \checkmark \) (Filter) icon from the filter bar or right-click a dimension.

You can also select the token for an existing dataset filter to edit it in the filter dialog.

3. On the filter dialog, choose an operator from the list.

4. Specify the filter values:

<table>
<thead>
<tr>
<th>Operator</th>
<th>Description</th>
<th>Available for Text</th>
<th>Available for Numeric and Dates</th>
</tr>
</thead>
<tbody>
<tr>
<td><em>Between</em>, or <em>Not Between</em></td>
<td>Type a start value and an end value.</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td><em>Equals</em>, <em>Not Equals</em></td>
<td>Select single value (displays the values of the filter as a list of check boxes where only a single value can be selected at a time) or multiple values (displays the values in the filter as a list of check boxes where multiple values can be selected).</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td><em>Greater than</em>, <em>Greater than equal</em>, <em>Less than</em>, <em>Less than equal</em></td>
<td>Enter a value.</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td><em>Contains</em>, or <em>Not Contains</em></td>
<td>Enter a string that is contained in all the values that you want to include or exclude. Filtering a dimension of clothing product categories for <em>shirt</em> for example would return values like <em>T-shirts</em>, <em>long-sleeve shirts</em>, and <em>shirt dresses</em>.</td>
<td>Yes</td>
<td>No</td>
</tr>
</tbody>
</table>

5. Select *OK*.

**Results**

The data is filtered, and a token representing the filter is added to the filter bar.

**Next Steps**

You can edit the filter by selecting the token in the filter bar or remove it by pressing the \( \times \) (Delete) icon.
10.2 Filtering Data in Visualization

Context

While creating a visualization, you can create filters that affect all visualizations based on the current dataset, or just filter data for the current visualization.

You can filter data in the following ways:

- By selecting the \( \text{(Add filters).} \)
- By selecting data points in a chart to filter or exclude them.
- By selecting the data to display on the Measures and Dimensions pane.

You can also use the ranking by measure feature to filter data by measure.

You use the filter dialog to define a filter on the current visualization only, or on all of the visualizations based on it.

Tokens representing active filters are displayed above the Chart Canvas, including story filters and visualization filters.

Procedure

1. Choose the visualization and select \( \text{(Filter).} \)
Another way to create a filter is to drag a dimension directly from the Object Picker to the filter shelf.

If a dimension includes a dimension hierarchy, select (Expand Levels) to expand the list to show all dimensions included in the hierarchy.

You can also select the token for an existing filter to edit it in the filter dialog.

2. Choose the dimension to filter.
3. On the filter dialog, choose an operator from the list.
4. Specify the values to filter:

<table>
<thead>
<tr>
<th>Operator</th>
<th>Description</th>
<th>Available for Text</th>
<th>Available for Numeric and Dates</th>
</tr>
</thead>
<tbody>
<tr>
<td><em>Between, or Not Between</em></td>
<td>Type a start value and an end value.</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td><em>Equals, Not Equals</em></td>
<td>Select single value (displays the values of the filter as a list of check boxes where only a single value can be selected at a time) or multiple values (displays the values in the filter as a list of check boxes where multiple values can be selected).</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Operator</td>
<td>Description</td>
<td>Available for Text</td>
<td>Available for Numeric and Dates</td>
</tr>
<tr>
<td>--------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>--------------------</td>
<td>---------------------------------</td>
</tr>
<tr>
<td>Greater than, Greater than equal, Less than, or Less than equal</td>
<td>Type a value.</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Contains, or Not Contains</td>
<td>Type a string that is contained in all of the values that you want to include or exclude. Filtering a dimension of clothing product categories for shirt for example would return values like T-shirts, long-sleeve shirts, and shirt dresses.</td>
<td>Yes</td>
<td>No</td>
</tr>
</tbody>
</table>

5. Choose **Current Page** to apply the filter only to the chart that you are working with, or choose **All Pages** to apply the filter to all visualizations in a story.

6. Choose **OK**.

**Results**

The data is filtered, and a token representing the filter is added above the Chart Canvas.

**Next Steps**

You can edit the filter by selecting the token above the Chart Canvas, or remove it by choosing the icon.

**10.3 Filtering Data in Stories**

Use the (Add filters) icon to define a filter on the current story page or for all the pages in a story. Tokens representing active filters are displayed above the Chart Canvas.

**Context**

The following actions also apply filters to the entire story, or to the current page in the story:
- Choosing values for input controls or while viewing a story.
- Selecting data points in a chart to drill through hierarchical data while viewing a story.
- Selecting data points in a chart to filter or exclude the chart members while viewing a story.

**Procedure**

1. To open the filter dialog, choose the (Add filters) above the Chart Canvas and choose a dimension to filter.

   If a dimension includes a dimension hierarchy, choose ☰️ to expand the list to show all dimensions included in the hierarchy.

   You can also select the token for an existing filter to edit it in the filter dialog.

2. On the filter dialog, choose an operator from the list.

3. Specify the values to filter:

<table>
<thead>
<tr>
<th>Operator</th>
<th>Description</th>
<th>Available for Text</th>
<th>Available for Numeric and Dates</th>
</tr>
</thead>
<tbody>
<tr>
<td>Between, or Not Between</td>
<td>Type a beginning value and an end value.</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Equals, Not Equals</td>
<td>Select single value (Displays the values of the filter as a list of check boxes where only a single value can be selected at a time) or multiple values (Displays the values in the filter as a list of check boxes where multiple values can be selected).</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Greater than, Greater than or equal to, Less than, or Less than or equal to</td>
<td>Type a value.</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Contains, or Not Contains</td>
<td>Type a string that is contained in all of the values that you want to include or exclude. For example, filtering a dimension of clothing product categories for shirt would return values such as T-shirts, long-sleeve shirts, shirt dresses, and so on.</td>
<td>Yes</td>
<td>No</td>
</tr>
</tbody>
</table>

4. Choose All Pages to apply the filter to all visualizations in a story.

5. Choose OK.
Results

The data is filtered and a token representing the filter is added above the Chart Canvas.

10.4 Using Controls

Use controls to interactively filter data in your story’s visualizations. Interactive filters in a story make it easy to highlight different areas of the data in the story.

Context

The filter created by the control applies to each relevant visualization. You can add controls to a section in the story, or overlay the control on a visualization. A box indicates the placement of the control in the visualization. You can optionally re-size or move the control.

Once you have included a filter, there are different options to control how it works and appears. For more information on including a filter for a story, see Filtering Data in Stories.

Procedure

1. Access the control options by dragging a filter token above the chart canvas and dropping it to a story. The Control Type dialog box appears with multiple options for you to choose from.

   Note

   The control type options are displayed depending on the operator that you have chosen. For example, if you choose the Equals operator and select single values to filter, the Text Box, Drop-down, Choice, and Complex controls are displayed. If you choose the Equal to operator and select multiple values to filter, the Text Box control is displayed.

   Table 32: Control Type Options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Text Box</td>
<td>Displays a text box where you can enter few characters. All values that match those characters are automatically selected. You can also enter numeric values.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>----------</td>
<td>-------------</td>
</tr>
</tbody>
</table>
| **Choice** | This option is useful to view, search, and sort a list of members.  
In longer lists of values, you can find a value by scrolling through the list or by entering text in the Search box. You can also use the sort arrow to sort values in ascending or descending order.  
Single Selection (List): Displays the values of the filter as a list of radio buttons where only a single value can be selected at a time.  
Multiple Selection (List): Displays the values in the filter as a list of check boxes where multiple values can be selected. |
| **Drop-down** | This option is useful to view, search, and sort a list of members. This is more appropriate for smaller controls, because they show dimension members in a drop-down list.  
In longer lists of values, you can find a value by scrolling through the list or by entering text in the Search box. You can also use the sort arrow to sort values in ascending or descending order.  
Single Selection (Dropdown): Displays the values of the filter in a drop-down list where only a single value can be selected at a time.  
Multiple Selection (Dropdown): Displays the values of the filter in a drop-down list where multiple values can be selected. |
| **Date** | This option is useful for dimensions that have an implicit order, such as dates. You can use this to view and organize the charts for any specified time period. You can choose an individual date or multiple dates.  
**Individual date**: Select individual dates to filter specific dates from your chart.  
**Multiple dates**: Select multiple dates to specify the start date and end date to analyze the visualization. |
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Slider</td>
<td>This option displays the value of the filter along the range of a slider. You can use the slider bar to view and organize the charts for any specified values. You choose a single slider or double slider to analyze the visualization.</td>
</tr>
<tr>
<td></td>
<td><strong>Single Slider</strong>: Shows the filtered value for a single slider that you can adjust to include or exclude more values.</td>
</tr>
<tr>
<td></td>
<td><strong>Double Slider</strong>: Shows the filtered values as a pair of sliders that you can adjust to include or exclude more values.</td>
</tr>
<tr>
<td></td>
<td>You can filter the Revenue field to only include values between 20,000 and 50,000, for example, but your chart only contains values between 23,000 and 35,000. The sliders shows you the range of the filter.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong></td>
</tr>
<tr>
<td></td>
<td>Slider is supported only for numeric values.</td>
</tr>
<tr>
<td>Complex</td>
<td>Displays the value of the filter for one or more conditions. For example, include a filter for a visualization using more than one operator (Equal to and Greater than or equal to). After including a filter, when you drag and drop the filter token onto a story, in the Control Type dialog only the Complex Filters option is enabled.</td>
</tr>
</tbody>
</table>

2. Choose a control type and then choose **OK**. The control is added to the story.

### 10.4.1 Displaying Controls in the Document

When you add a control, an interactive filter appears in the visualization. Use the control to quickly include or exclude data in the visualization. There are two ways to add a visualization to your chart.

**Procedure**

1. Access the control options by dragging a filter token above the chart canvas and dropping it to a story.
2. (Optional) Another way to add a control is by using the *Insert Control* option in the Global toolbar.
a. Choose Insert Control.

b. In the filter dialog, choose the dimension to filter.

The Control Type dialog box appears with multiple options for you to choose from. For more information on supported control types, see Using Controls [page 145].

c. Choose the required Control Type and choose OK.

The control is added to the story. The default operator is “Equals” for all the control types. However, if you select the Single Slider control type, then the operator is “less than equal to” and the default value is the maximum value from the dimension. If you select the Double Slider, then “between” is the default operator and the minimum and maximum values from the dimension represent the default values for sliders.

**Note**

By default, the scope of the filter is set to Current Page when you add a control from the Global tool bar. However, you can choose the Edit Filter option by right-clicking the control and change the scope to All Pages.

You can always change filter values and the operator by using the Edit Filter option. For more information, see Editing Controls [page 150].
10.4.2 Editing Controls

You can edit the appearance and interaction of your controls in the visualization.

Procedure

1. Select control on the story and right-click the control. This displays a list of options for you to choose from:

<table>
<thead>
<tr>
<th>Controls Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Edit Filter</strong></td>
<td>This option opens the main Filter dialog box so you can further refine the filter by adding operators and values.</td>
</tr>
<tr>
<td><strong>Delete</strong></td>
<td>Removes the control from the visualization.</td>
</tr>
<tr>
<td><strong>Change Control Type</strong></td>
<td>Allows you to choose from available control type.</td>
</tr>
<tr>
<td><strong>Configure Slider</strong></td>
<td>By default, Discovery shows a slider with a fixed maximum and minimum value coming from the dimension. Use this option the set maximum and minimum values manually.</td>
</tr>
</tbody>
</table>

2. (Optional) The selected dataset appears above the Measures and Dimensions pane. If you want to view dimensions from a different dataset, choose them from the dataset selector.

10.5 Filtering Data in Charts

10.5.1 Filtering Data by Rank

Filtering data by rank focuses a visualization on a specified number of data points with the highest or lowest values. You can apply only one ranking to a visualization at a time.

Procedure

1. Choose the visualization and then select **Rank**.

   Alternatively, choose the visualization, expand it using the **(Maximize)** and choose the **(Rank)**. The **Ranking** dialog box appears.

2. Select the measure you want to rank the values on.
3. Select the order of ranking.
4. Enter the number of results to display.
   The default number is three.
5. Select the dimension to rank data on.
   If a chart shows Sales Revenue by Country and Product Line for example, ranking the top five data points by Country shows data for each product line in the five countries with the highest sales revenue.
6. Choose OK.

**Results**

The data is filtered by rank, and a token representing the filter is added above the Chart Canvas.

**Next Steps**

Choose the token to edit your ranking or remove it by choosing the (Delete).

You can edit the ranking by selecting the token, or remove it by selecting (Delete).

With visualizations that contain linked datasets, ranking is applied to the result set of the linked datasets, not the datasets prior to the link operation.
You can export datasets in CSV or Microsoft Excel format to your local system from Lumira Discovery. To export your datasets, select one of the following options:

Table 33: Options to Export Records

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Aggregated</td>
<td>Exports the data values that are included in your visualizations.</td>
</tr>
<tr>
<td>Detailed</td>
<td>Exports all the data values from a dataset. You can also choose to select the dimensions and measures.</td>
</tr>
</tbody>
</table>

For example, if your visualization shows sales by country from a dataset that contains all of your sales orders, you can export these aggregated sales values for each of the countries. You also have the option of exporting the individual sales order records behind these data points, which may be useful if there are additional columns of value in the data that are not easily accessible from the visualization. You cannot select the dimensions or measures if you are exporting aggregated values.

**Note**

If you export too many values, the exported set of data is truncated and to indicate this, the exported file includes a warning message. The Excel file format is more complex than the CSV file format and therefore the number of cells that can be exported in Excel file format is limited when compared to CSV file format. If your data is often truncated when you try to import large datasets, use CSV format.

**Note**

You can default your export type (detail or aggregate) in *Preferences*. To do this, select ![File](10) *Preferences* ![Charts](11) and select the required option.

### 11.1 Exporting Stories for all Data Points

You can export all data values from a visualization to Microsoft Excel or any CSV format.

**Context**

You can also export visualization extensions to PDF format.
Procedure

1. Choose the visualization and then select the **Export Records** option.
   
   Alternatively, choose the visualization, expand it using (Maximize) and then choose (Export Records) above the chart canvas.
2. In the **Export as File** dialog box, select the **Export Type** as **Aggregated** or **Detailed**.
   
   If you are exporting detailed records, select the dimensions and measures you want to export.
3. Select the file format, to export records to a **CSV** (comma-separated values) file or to an **Excel** file.
4. Choose **Export**.
5. In the **Save File** dialog box, choose a location and enter a file name.
6. Choose **Save**.

Results

The dataset is exported and saved at the required location.

11.2 Exporting Datasets for all Data Points

You can export a dataset from Lumira Discovery to your local system in either CSV or Microsoft Excel format.

Context

The following restrictions apply while exporting or publishing a dataset:

- Both visible and hidden objects will be exported.
- Columns that are referenced more than once in a dataset are exported multiple times.

Procedure

1. On **DataView**, select **File** > **Export as File**...
2. (Optional) In the **Export as File** dialog box, select an export option:
   - To export hidden dimensions in the dataset, select **Export hidden dimensions**.
   - To export hidden dimensions resulting from enrichment of the dataset, select **Export hidden dimensions derived from dataset enrichment**
Two examples of these columns are the Latitude and Longitude columns that are generated for geography hierarchies by geographical names.

3. Choose Export.
4. Choose a location and file format to save the dataset.
12 Inter-operability

With inter-operability, you can use the functionalities of both the Lumira Discovery tool and the Lumira Designer tool to create stories, thereby maintaining agility along with governance, scalability, and security of your data.

Prerequisites

You have to install both the client tools in your local system.

Context

With Lumira Discovery 2.0, you can edit your document using two desktop clients namely Lumira Discovery and Lumira Designer and also have a single server-side add on. You can create stories in Lumira Discovery and use Lumira Designer functionalities to enhance the stories, save them and re-open the newly edited stories in Lumira Discovery for further analysis.

Procedure

1. Launch Lumira Discovery.
2. Add a few charts and create a storybook.
   All the Lumira Discovery documents are stored in .lumx format.
3. Save the document.
4. Launch Lumira Designer.
5. Refresh the documents in the Document tab.
6. Search for document and double-click to open it.
   Charts created in Lumira Discovery can now be viewed in Lumira Designer.
   Expand the document to view the storybook listed under the document name.
7. Enhance the story book by adding the required Lumira Designer functionalities.
8. Choose the Execute Locally option to check for the behavior of the chart.
9. Save the document.
10. Open the same document in Lumira Discovery.
    All the changes made in Lumira Designer can now be viewed in Lumira Discovery.
Next Steps

**Note**

After editing the storybook in Lumira Designer, you cannot modify or edit the storybook by adding a new page, story, or visualization in Lumira Discovery. You can add a new storybook to the same Lumira Discovery document and can perform data exploration, which is reflected in both Lumira Discovery and Lumira Designer.

In Lumira Designer, you can add composites while creating a document and view that document in Lumira Discovery.

12.1 Working with Different Inter-operability Scenarios

After creating a Lumira Discovery document, you can use the advantages of the Lumira Designer application to enhance your Lumira Discovery document and vice versa in SAP BusinessObjects Lumira. Also you can publish the document created using various inter-operability scenarios to SAP BusinessObjects Lumira, server version for BI Platform.

The following table provides the inter-operability workflows, that is, when working with SAP BusinessObjects Lumira (Lumx) documents created in Lumira Discovery, modified in Lumira Discovery and later opened in Lumira Discovery again.

**Table 34: Interoperability Scenarios in Lumira Discovery**

<table>
<thead>
<tr>
<th>Scenarios</th>
<th>Lumira Discovery</th>
<th>Lumira Designer</th>
<th>Lumira Discovery</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scenario 1</td>
<td>Create a document</td>
<td>Open the document</td>
<td>Re-open the same document.</td>
</tr>
<tr>
<td>Scenario 2</td>
<td>Create a document</td>
<td>Add a <strong>Composite</strong> to the document.</td>
<td>You can view <strong>Composite</strong>.</td>
</tr>
<tr>
<td>Scenario 3</td>
<td>Create a document</td>
<td>Add an <strong>Application</strong> to the document.</td>
<td>You cannot view the <strong>Application</strong>.</td>
</tr>
<tr>
<td>Scenario 4</td>
<td>Create a document</td>
<td>Create a story</td>
<td>You can view the story</td>
</tr>
<tr>
<td>Scenario 5</td>
<td>Create a document with story</td>
<td>Modify the story</td>
<td>You cannot edit the modified story.</td>
</tr>
<tr>
<td>Scenario 6</td>
<td>Create a document</td>
<td>Delete the story</td>
<td>The document should not contain story.</td>
</tr>
<tr>
<td>Scenario 7</td>
<td>Create a document by acquiring data from an offline dataset.</td>
<td>Acquire data from an online dataset and enhance the same document by adding data from an online dataset.</td>
<td>You can only view the document.</td>
</tr>
<tr>
<td>Scenarios</td>
<td>Lumira Discovery</td>
<td>Lumira Designer</td>
<td>Lumira Discovery</td>
</tr>
<tr>
<td>------------</td>
<td>---------------------------------------------------------------------------------</td>
<td>---------------------------------------------------------------------------------</td>
<td>---------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Scenario 8</td>
<td>Create a document by acquiring data from an online dataset</td>
<td>Acquire data from an online dataset and enhance the same document by adding data from an online dataset.</td>
<td>You cannot view the document.</td>
</tr>
</tbody>
</table>

After creating a Lumira Designer document, when you open that document in Lumira Discovery, you can view the composites and stories created in Lumira Designer.
13  Advanced Analysis

This section provides information on the calculations that you can create and use in your charts.

Related Information

Calculations [page 158]
Lumira Functions Reference for Offline Documents [page 163]
Lumira Discovery Functions Reference for Online Documents [page 213]

13.1  Calculations

You can create a calculation and add it to your chart.

Context

You can use any measure from the dataset or any dimension from the chart when you create a calculation. The calculation appears as a measure in the chart. It appears only in the current chart, and is not added to the dataset. To add a calculated measure or dimension to the dataset choose Calculations.

The following calculations are available:

- Counter...
- Running Calculations...
  - Average
  - Count
  - Minimum
  - Maximum
  - Sum
- Moving Average...
- Percentage Of...
- Difference From...
- Custom Calculation...

Running count, running maximum, and running minimum calculations can be performed on numerical measures, or on non-numerical measures such as date. Counter is performed on a dimension. Custom calculations are performed on aggregated values. All other calculations are performed on numerical measures only.
Procedure

1. Choose the visualization and select the Calculations option.
   
   Alternatively, choose the visualization, expand it using the (Maximize) and choose Calculations from the visualization toolbar.

2. Select a calculation in the list.
3. Enter the required parameters in the dialog and select OK.

   You can use multiple measures in your calculation.

Results

The chart is updated to include the calculation, and the calculation token appears in the measure shelf in Chart Builder.

Example

This example shows how to use the Difference From... calculation. Suppose you have a crosstab containing the profit from three products for the years 2011 to 2014: the Measure is Profit and the rows are Year and Product. You can use a Difference From... calculation to create a year-over-year comparison of the profit.

In the Calculation Difference From... dialog, enter the following values:

Table 35:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Use the default name.</td>
</tr>
<tr>
<td>Measure</td>
<td>Profit (Sum).</td>
</tr>
<tr>
<td>Base Value</td>
<td>Previous (Value).</td>
</tr>
<tr>
<td>Base Dimension</td>
<td>Year.</td>
</tr>
<tr>
<td>Show as values</td>
<td>Selected.</td>
</tr>
</tbody>
</table>

The profit from a product in the current year is compared to the profit from a product in the previous year:

Related Information

Moving Average [page 160]
Difference From [page 160]
Percentage Of [page 161]
13.1.1 Moving Average

Use *Moving Average...* to calculate the average of different subsets of the measure values.

Table 36: Parameters for Moving Average

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of the calculation. Use the default name or enter a new one.</td>
</tr>
<tr>
<td>Measure</td>
<td>The measure to use in the calculation.</td>
</tr>
<tr>
<td>Reset At</td>
<td>The dimension to use for restarting the calculation.</td>
</tr>
<tr>
<td></td>
<td>Select <em>(None)</em> if you do not want the calculation to restart.</td>
</tr>
<tr>
<td></td>
<td>If your visualization has a dimension called Year for example, you could select Year to re-</td>
</tr>
<tr>
<td></td>
<td>start the calculation for each year.</td>
</tr>
<tr>
<td>Values Before</td>
<td>The number of values before the current value to include in the calculation.</td>
</tr>
<tr>
<td>Values After</td>
<td>The number of values after the current value to include in the calculation.</td>
</tr>
<tr>
<td>Include Self</td>
<td>Select to include the current value in the calculation.</td>
</tr>
</tbody>
</table>

13.1.2 Difference From

Use *Difference From...* to compare different subsets of the measure values.

Table 37: Parameters for Difference From

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of the calculation. Use the default name or enter a new one.</td>
</tr>
<tr>
<td>Measure</td>
<td>The measure to use in the calculation.</td>
</tr>
<tr>
<td>Base Value</td>
<td>The value to subtract from the current value. If you select <em>Previous (Value)</em> for example, the previous value of the measure is subtracted from its current value.</td>
</tr>
<tr>
<td>Base Dimension</td>
<td>The dimension used for the comparison. You could select <em>Year</em> to create a year-over-year comparison for example, or select <em>Product</em> to compare measures from different products.</td>
</tr>
<tr>
<td></td>
<td>Select <em>Row (Table)</em> to treat the entire table as a single group.</td>
</tr>
</tbody>
</table>
Parameter | Description
---|---
**Show as values** | Display the Difference From value as a number.
**Show as percentages** | Display the Difference From value as a percentage.

### 13.1.3 Percentage Of

Use *Percentage Of...* to calculate the current value’s percentage of the total of all the values for the measure.

Table 38: Parameters for Percentage Of

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Name</strong></td>
<td>The name of the calculation. Use the default name or enter a new name.</td>
</tr>
<tr>
<td><strong>Measure</strong></td>
<td>The measure to use in the calculation.</td>
</tr>
<tr>
<td><strong>Base Dimension</strong></td>
<td>The dimension used to create a subtotal for the selected measure. For example, select Year to calculate the current value’s percentage of the total of all the values for the current year. Select <em>(Grand Total)</em> to use the total of all the values for the measure in the calculation.</td>
</tr>
</tbody>
</table>

### 13.1.4 Running Calculations

Use running calculations for cumulative operations on the measure values.

Table 39: Parameters for Running Calculations

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Name</strong></td>
<td>The name of the calculation. Use the default name or enter a new one.</td>
</tr>
<tr>
<td><strong>Measure</strong></td>
<td>The measure to use in the calculation.</td>
</tr>
<tr>
<td><strong>Running Kind</strong></td>
<td>The type of running calculation. The following types are supported:</td>
</tr>
<tr>
<td></td>
<td>● <em>Average</em></td>
</tr>
<tr>
<td></td>
<td>● <em>Count</em></td>
</tr>
<tr>
<td></td>
<td>● <em>Maximum</em></td>
</tr>
<tr>
<td></td>
<td>● <em>Minimum</em></td>
</tr>
<tr>
<td></td>
<td>● <em>Sum</em></td>
</tr>
<tr>
<td>Parameter</td>
<td>Description</td>
</tr>
<tr>
<td>-------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Reset At</td>
<td>The dimension to use for restarting the calculation. Select <em>(None)</em> if you do not want the calculation to restart. If your visualization contained a dimension called <strong>year</strong> for example, you could select <strong>year</strong> to restart the calculation for each year.</td>
</tr>
<tr>
<td>Stop at last datapoint</td>
<td>This option automatically detects the last data point and stops the running sum line at that point. If you have a growth chart with a combined time dimension in which data does not exist for the entire time period for example, the running calculation line will stop at the last valid data point.</td>
</tr>
<tr>
<td>Empty values excluded</td>
<td>Used in running average and running count calculations. Select to exclude empty values from the calculation. If this option is <strong>not</strong> selected for example, empty values will be included as &quot;0&quot; in running average calculations.</td>
</tr>
</tbody>
</table>

### 13.1.5 Custom Calculation

Custom calculations are used for cumulative operations on aggregated measures.

You can create custom calculations on aggregated measures and on dimensions. You can even include other custom calculations in new custom calculations.

You can choose to remove a custom calculation from your visualization, but still keep the calculation for future use. The calculations will be available on the Calculations menu, even if you are not currently using them in the visualization.

When **Custom Calculation...** is selected from the Calculations menu, the calculation editor is launched. The calculation editor is also launched when you edit an existing custom calculation.

### Related Information

*Lumira Functions Reference for Offline Documents [page 163]*
13.2 Lumira Functions Reference for Offline Documents

Overview of the functions that are available.

You can use functions to create formulas for calculated measures or dimensions or for custom calculations. The following table shows the high-level grouping of the available functions.

Table 40: Categories of functions

<table>
<thead>
<tr>
<th>Category</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Aggregate [page 164]</td>
<td>Aggregates data (by summing or averaging a set of values for example)</td>
</tr>
<tr>
<td>Character [page 170]</td>
<td>Manipulates character strings</td>
</tr>
<tr>
<td>Date and Time [page 177]</td>
<td>Returns date or time data</td>
</tr>
<tr>
<td>Expression [page 191]</td>
<td>Functions that are used in custom calculations.</td>
</tr>
<tr>
<td>Miscellaneous [page 202]</td>
<td>Functions that do not fit in any other category</td>
</tr>
<tr>
<td>Numeric [page 206]</td>
<td>Returns numeric data</td>
</tr>
<tr>
<td>Operator [page 210]</td>
<td>Returns true or false</td>
</tr>
</tbody>
</table>

**Note**
Aggregate functions are implemented in the definition of a measure.

- **Aggregate Functions [page 164]**
  Functions that can be used for custom calculations on aggregated values.

- **Character Functions [page 170]**
  Use a character function to manipulate character strings in a formula.

- **Date and Time Functions [page 177]**
  Date and Time functions return date or time data.

- **Expression Functions [page 191]**
  Functions to be used for custom calculations and running calculations.

- **Miscellaneous Functions [page 202]**
  Miscellaneous functions reference.

- **Numeric Functions [page 206]**
  Functions that return numeric data.

- **Operator Functions [page 210]**
  Operator functions include logical functions and other functions that return true or false.
Related Information

Creating a Calculated Measure or Dimension [page 87]
Calculations [page 158]

13.2.1 Aggregate Functions

Functions that can be used for custom calculations on aggregated values.

All functions are case-sensitive:

- Average [page 164]
- Count [page 165]
- CountDistinct [page 166]
- Max [page 167]
- Min [page 168]
- Sum [page 168]

Average

Returns the post aggregated average value of a measure.

Code Syntax

Average(obj)

- obj: User object (column)

Example

Average({Sales})

returns:

<table>
<thead>
<tr>
<th>Country</th>
<th>Product</th>
<th>Sales</th>
<th>Avg</th>
</tr>
</thead>
<tbody>
<tr>
<td>DE</td>
<td>A</td>
<td>70</td>
<td>74</td>
</tr>
<tr>
<td>DE</td>
<td>B</td>
<td>90</td>
<td>74</td>
</tr>
<tr>
<td>US</td>
<td>A</td>
<td>100</td>
<td>74</td>
</tr>
<tr>
<td>US</td>
<td>B</td>
<td>50</td>
<td>74</td>
</tr>
</tbody>
</table>
### Example

Average(Sales) For [Country]

returns the sum of Sales divided by the count of all the Products displayed in the result set per Country:

<table>
<thead>
<tr>
<th>Country</th>
<th>Product</th>
<th>Sales</th>
<th>Avg</th>
</tr>
</thead>
<tbody>
<tr>
<td>DE</td>
<td>A</td>
<td>70</td>
<td>80</td>
</tr>
<tr>
<td>DE</td>
<td>B</td>
<td>90</td>
<td>80</td>
</tr>
<tr>
<td>US</td>
<td>A</td>
<td>100</td>
<td>70</td>
</tr>
<tr>
<td>US</td>
<td>B</td>
<td>50</td>
<td>70</td>
</tr>
<tr>
<td>US</td>
<td>C</td>
<td>60</td>
<td>70</td>
</tr>
</tbody>
</table>

### Count

Returns the post aggregated count of a measure.

#### Code Syntax

- **Count(obj)**

- **obj**: User object (column)

#### Example

Count(Product)

returns the count of all the Products in the result set:

<table>
<thead>
<tr>
<th>Country</th>
<th>Product</th>
<th>Sales</th>
<th>Count</th>
</tr>
</thead>
<tbody>
<tr>
<td>DE</td>
<td>A</td>
<td>70</td>
<td>5</td>
</tr>
<tr>
<td>DE</td>
<td>B</td>
<td>90</td>
<td>5</td>
</tr>
<tr>
<td>US</td>
<td>A</td>
<td>100</td>
<td>5</td>
</tr>
</tbody>
</table>
**CountDistinct**

Returns the post aggregated distinct count of a measure.

**Code Syntax**

```
CountDistinct(obj)
```

- **obj**: User object (column)

**Example**

```
CountDistinct({Product})
```

returns the distinct count of all the Products in the result set:

<table>
<thead>
<tr>
<th>Country</th>
<th>Product</th>
<th>Sales</th>
<th>CountDistinct</th>
</tr>
</thead>
<tbody>
<tr>
<td>DE</td>
<td>A</td>
<td>70</td>
<td>3</td>
</tr>
<tr>
<td>DE</td>
<td>B</td>
<td>90</td>
<td>3</td>
</tr>
<tr>
<td>US</td>
<td>A</td>
<td>100</td>
<td>3</td>
</tr>
<tr>
<td>US</td>
<td>B</td>
<td>50</td>
<td>3</td>
</tr>
<tr>
<td>US</td>
<td>C</td>
<td>60</td>
<td>3</td>
</tr>
</tbody>
</table>

**Example**

```
CountDistinct({Product}) For [{Country}]
```

returns the distinct count of all the Products per Country in the result set:

<table>
<thead>
<tr>
<th>Country</th>
<th>Product</th>
<th>Sales</th>
<th>CountDistinct</th>
</tr>
</thead>
<tbody>
<tr>
<td>DE</td>
<td>A</td>
<td>70</td>
<td>2</td>
</tr>
<tr>
<td>DE</td>
<td>B</td>
<td>90</td>
<td>2</td>
</tr>
<tr>
<td>Country</td>
<td>Product</td>
<td>Sales</td>
<td>CountDistinct</td>
</tr>
<tr>
<td>---------</td>
<td>---------</td>
<td>-------</td>
<td>--------------</td>
</tr>
<tr>
<td>US</td>
<td>A</td>
<td>100</td>
<td>3</td>
</tr>
<tr>
<td>US</td>
<td>B</td>
<td>50</td>
<td>3</td>
</tr>
<tr>
<td>US</td>
<td>C</td>
<td>60</td>
<td>3</td>
</tr>
</tbody>
</table>

**Max**

Returns the post aggregated maximum of a measure.

**Code Syntax**

Max(obj)

- **obj**: User object (column)

**Example**

Max(Sales)

returns the maximum Sales in the result set:

<table>
<thead>
<tr>
<th>Country</th>
<th>Product</th>
<th>Sales</th>
<th>Max</th>
</tr>
</thead>
<tbody>
<tr>
<td>DE</td>
<td>A</td>
<td>70</td>
<td>100</td>
</tr>
<tr>
<td>DE</td>
<td>B</td>
<td>90</td>
<td>100</td>
</tr>
<tr>
<td>US</td>
<td>A</td>
<td>100</td>
<td>100</td>
</tr>
<tr>
<td>US</td>
<td>B</td>
<td>50</td>
<td>100</td>
</tr>
<tr>
<td>US</td>
<td>C</td>
<td>60</td>
<td>100</td>
</tr>
</tbody>
</table>

**Example**

Max({Sales}) For [{Country}]

returns the maximum Sales value of Product in each Country:

<table>
<thead>
<tr>
<th>Country</th>
<th>Product</th>
<th>Sales</th>
<th>Max</th>
</tr>
</thead>
<tbody>
<tr>
<td>DE</td>
<td>A</td>
<td>70</td>
<td>90</td>
</tr>
<tr>
<td>Country</td>
<td>Product</td>
<td>Sales</td>
<td>Max</td>
</tr>
<tr>
<td>---------</td>
<td>---------</td>
<td>-------</td>
<td>-----</td>
</tr>
<tr>
<td>DE</td>
<td>B</td>
<td>90</td>
<td>90</td>
</tr>
<tr>
<td>US</td>
<td>A</td>
<td>100</td>
<td>100</td>
</tr>
<tr>
<td>US</td>
<td>B</td>
<td>50</td>
<td>100</td>
</tr>
<tr>
<td>US</td>
<td>C</td>
<td>60</td>
<td>100</td>
</tr>
</tbody>
</table>

**Min**

Returns the post aggregated minimum of a measure.

**Code Syntax**

```
Min(obj)
```

- **obj**: User object (column)

**Example**

```
Min({Sales})
```

returns the minimum Sales value in the result set:

<table>
<thead>
<tr>
<th>Country</th>
<th>Product</th>
<th>Sales</th>
<th>Min</th>
</tr>
</thead>
<tbody>
<tr>
<td>DE</td>
<td>A</td>
<td>70</td>
<td>50</td>
</tr>
<tr>
<td>DE</td>
<td>B</td>
<td>90</td>
<td>50</td>
</tr>
<tr>
<td>US</td>
<td>A</td>
<td>100</td>
<td>50</td>
</tr>
<tr>
<td>US</td>
<td>B</td>
<td>50</td>
<td>50</td>
</tr>
<tr>
<td>US</td>
<td>C</td>
<td>60</td>
<td>50</td>
</tr>
</tbody>
</table>

**Sum**

Returns the post aggregated sum of a measure.

**Code Syntax**

```
Sum(obj)
```
• obj: User object (column)

Example

```
Sum({Sales})
```

returns:

<table>
<thead>
<tr>
<th>Country</th>
<th>Product</th>
<th>Sales</th>
<th>Sum</th>
</tr>
</thead>
<tbody>
<tr>
<td>DE</td>
<td>A</td>
<td>70</td>
<td>370</td>
</tr>
<tr>
<td>DE</td>
<td>B</td>
<td>90</td>
<td>370</td>
</tr>
<tr>
<td>US</td>
<td>A</td>
<td>100</td>
<td>370</td>
</tr>
<tr>
<td>US</td>
<td>B</td>
<td>50</td>
<td>370</td>
</tr>
<tr>
<td>US</td>
<td>C</td>
<td>60</td>
<td>370</td>
</tr>
</tbody>
</table>

Example

```
Sum({Sales}) ForAllExcept [{Product}]
```

returns the sum of Sales for each Country:

<table>
<thead>
<tr>
<th>Country</th>
<th>Product</th>
<th>Sales</th>
<th>Sum</th>
</tr>
</thead>
<tbody>
<tr>
<td>DE</td>
<td>A</td>
<td>70</td>
<td>160</td>
</tr>
<tr>
<td>DE</td>
<td>B</td>
<td>90</td>
<td>160</td>
</tr>
<tr>
<td>US</td>
<td>A</td>
<td>100</td>
<td>210</td>
</tr>
<tr>
<td>US</td>
<td>B</td>
<td>50</td>
<td>210</td>
</tr>
<tr>
<td>US</td>
<td>C</td>
<td>60</td>
<td>210</td>
</tr>
</tbody>
</table>

Parent topic: Lumira Functions Reference for Offline Documents [page 163]

Related Information

- Character Functions [page 170]
- Date and Time Functions [page 177]
- Expression Functions [page 191]
- Miscellaneous Functions [page 202]
- Numeric Functions [page 206]
13.2.2 Character Functions

Use a character function to manipulate character strings in a formula.

The following character (string) functions can be used for calculations (all functions are case-sensitive):

- Concatenate [page 170]
- ExceptFirstWord [page 171]
- ExceptLastWord [page 171]
- FirstWord [page 171]
- LastWord [page 172]
- Length [page 172]
- LowerCase [page 173]
- Lpad [page 173]
- Replace [page 173]
- Rpad [page 174]
- SubString (length) [page 174]
- SubString [page 175]
- Trim [page 175]
- TrimLeft [page 176]
- TrimRight [page 176]
- UpperCase [page 177]

Concatenate

Concatenates two strings into a single string.

Code Syntax

```plaintext
Concatenate(str1, str2)
```

- `str1`: First string
- `str2`: Second string

The operator `+` can also concatenate strings.

Example

```plaintext
Concatenate("Mr", "Brown")
returns "MrBrown"
```
ExceptFirstWord

Returns a copy of a string, with the first word removed.

Code Syntax

```
ExceptFirstWord(str, sep)
```

- `str`: Input string
- `sep`: A separator

Example

```
ExceptFirstWord("Level 3, Standford Street", ", ")
returns "Standford Street"
```

ExceptLastWord

Returns a copy of a string, with the last word removed.

Code Syntax

```
ExceptLastWord(str, sep)
```

- `str`: Input string
- `sep`: A separator

Example

```
ExceptLastWord("james.brown@company.com", ", @")
returns "james.brown"
```

FirstWord

Returns the first word of a string.

Code Syntax

```
FirstWord(str, sep)
```
• *str*: Input string
• *sep*: A separator

### Example

```javascript
FirstWord("Senior Developer", " ")
```

returns "Senior"

### LastWord

Returns the last word of a string.

#### Code Syntax

```javascript
LastWord(str, sep)
```

• *str*: Input string
• *sep*: A separator

#### Example

```javascript
LastWord("Red/Purple", "/")
```

returns "Purple"

### Length

Returns the length of a string.

#### Code Syntax

```javascript
Length(str)
```

• *str*: Input string

#### Example

```javascript
Length("How long")
```

returns 8
LowerCase

Returns a copy of a string, with all characters converted to lowercase.

Code Syntax

```
LowerCase(str)
```

- **str**: Input string

Example

```
LowerCase("GOOD JOB")
```

returns "good job"

Lpad

Returns a copy of a string, padded with leading characters to the specified total length.

Code Syntax

```
Lpad(str, length, pad)
```

- **str**: Input string
- **length**: Expected length
- **pad**: Character sequence to add

Example

```
Lpad("Incomplete field", 20, ")
```

returns "####Incomplete field"

Replace

Returns a string, with all occurrences of a specified string replaced with another specified string.

Code Syntax

```
Replace(str, target, replacement)
```

End User Guide: SAP BusinessObjects Lumira Discovery
Advanced Analysis
- **str**: Input string
- **target**: String to be replaced
- **replacement**: String value to insert

**Example**

```r
Replace("hyperthermia", "ert", "ot")
```

Returns "hypothermia"

**Rpad**

Returns a copy of a string, padded with trailing characters to the specified total length.

**Code Syntax**

```r
Rpad(str, length, pad)
```

- **str**: Input string
- **length**: Expected length
- **pad**: Character sequence to add

**Example**

```r
Rpad("Incomplete field", 20, ":")
```

Returns "Incomplete field####"

**SubString (length)**

Returns a substring (of a specific length) of a string.

**Code Syntax**

```r
SubString(str, start, length)
```

- **str**: String from which a substring is computed
- **start**: Start position in the input substring
- **length**: Length of the substring to return

**Example**

```r
SubString("Wong", 2, 2)
```
returns "on"

SubString

Returns a substring of a string.

Code Syntax

SubString(str, start)

- str: String from which a substring is computed
- start: Start position in the input substring

Example

For example:

SubString("Wong", 3)
returns "ng"

Trim

Returns a copy of the string, with the leading and trailing repetitions of a character removed. This function is case-sensitive.

Code Syntax

Trim(str, toTrim)

- str: Input string
- toTrim: Character to be removed

Example

Trim("Aurora", "a")
returns "Auror"

Table 41: Example of the Trim(str, toTrim) function: Trim ({Name}, "a")

<table>
<thead>
<tr>
<th>Name</th>
<th>Trimmed string</th>
</tr>
</thead>
<tbody>
<tr>
<td>Auror</td>
<td>Auror</td>
</tr>
</tbody>
</table>
TrimLeft

Returns a copy of the string, with the leading occurrence of a character removed. This function is case-sensitive.

**Code Syntax**

```
TrimLeft(str, toTrim)
```

- **str**: Input string
- **toTrim**: Character to remove

**Example**

```
TrimLeft("Above", "A")
```

returns "bove"

TrimRight

Returns a copy of a string, with trailing repetitions of a character removed. This function is case-sensitive.

**Code Syntax**

```
TrimRight(str, toTrim)
```

- **str**: Input string
- **toTrim**: Character to be removed

**Example**

```
TrimRight("Laura", "a")
```

returns "Laur"
UpperCase

Returns a copy of a string, with all characters converted to uppercase.

**Code Syntax**

```
UpperCase(str)
```

- **str**: Input string

**Example**

```
UpperCase("Little Boy")
```

returns "LITTLE BOY"

Parent topic: Lumira Functions Reference for Offline Documents [page 163]

**Related Information**

Aggregate Functions [page 164]
Date and Time Functions [page 177]
Expression Functions [page 191]
Miscellaneous Functions [page 202]
Numeric Functions [page 206]
Operator Functions [page 210]

### 13.2.3 Date and Time Functions

Date and Time functions return date or time data.

The following Date and Time functions can be used for calculations (all functions are case-sensitive). Note that you might need to convert the format of your source data in the application:

- AddDayToDate [page 178]
- AddMonthToDate [page 178]
- AddTime [page 179]
- AddWeekToDate [page 179]
- AddYearToDate [page 180]
- CurrentDate [page 180]
- CurrentDateTime [page 181]
- CurrentTime [page 181]
AddDayToDate

Returns the date produced by adding a specified number of days (periods) to a specified date (date).

**Code Syntax**

```
AddDayToDate(date, periods)
```

- **date**: A Date or Datetime object
- **periods**: A number of days

**Example**

```
AddDayToDate(ToDateTime("2015-01-20 23:59:45", "yyyy-mm-dd hh:mi:ss"), 2)
```

returns 2015-01-22 11:59:45 PM

AddMonthToDate

Returns a date that is produced by adding a specified number of months to a specified date.
AddMonthToDate

Code Syntax

AddMonthToDate(#date#, periods)

- #date#: Original date
- periods: Number of periods to add

Example

AddMonthToDate(#2012-01-01#, 1)

returns 2012-02-01

AddTime

Returns the time produced by adding a specified amount of time (numberOfUnits) to a specified time (datetime), in the specified format (format).

Code Syntax

AddTime(datetime, numberOfUnits, format)

- datetime: A Time or Datetime object
- numberOfUnits: A number of time units. The time unit type is specified by the format.
- format:
  - hh: hours
  - mi: minutes
  - ss: seconds

Example

AddTime(ToDateTime("2015-01-20 23:59:45", "yyyy-mm-dd hh:mi:ss"), 1, "hh")

returns 2015-01-21 12:59:45 AM

AddWeekToDate

Returns a date that is produced by adding a specified number of weeks to a specified date.

Code Syntax

AddWeekToDate(#date#, periods)
- **#date#:** Original date
- **periods:** Number of periods to add

**Example**

AddWeekToDate(#2012-01-01#,1)

returns 2012-01-08

### AddYearToDate

Returns a date that is produced by adding a specified number of years to a specified date. Use negative numbers to remove a year.

**Code Syntax**

AddYearToDate(#date#,periods)

- **#date#:** Original date
- **periods:** Number of periods to add

**Example**

AddYearToDate(#2012-01-01#,1)

returns 2013-01-01

### CurrentDate

Returns the current date as a Date object.

**Code Syntax**

CurrentDate()

**Example**

CurrentDate()

returns the current date: 2015-01-01
**CurrentDateTime**

Returns the current Datetime (combined date and time).

**Code Syntax**

```
CurrentDateTime()
```

**Example**

```
CurrentDateTime()
```

returns the current datetime: 2011-06-12 8:39:45 PM

---

**CurrentTime**

Returns the current time as a Time object.

**Code Syntax**

```
CurrentTime()
```

**Example**

```
CurrentTime()
```

returns the current time: 8:39:45 PM

---

**DateDiffInDays**

Returns the number of days between two dates.

**Code Syntax**

```
DateDiffInDays(#start#, #end#)
```

- #start#: Start date of the interval
- #end#: End date of the interval

**Example**

```
DateDiffInDays(#2012-03-23#, #2012-01-30#)
```
DateDiffInMonths

Returns the number of months between two specified dates.

- **Code Syntax**
  
  ```
  DateDiffInMonths(#start#, #end#)
  ```

  - **#start#**: Start date of the interval
  - **#end#**: End date of the interval

- **Example**
  
  ```
  DateDiffInMonths(#2013-02-01#, #2014-01-01#)
  ```

  returns 11

Day

Returns the day of the month as a number from 1 to 31.

- **Code Syntax**
  
  ```
  Day(#date#)
  ```

  - **#date#**: A date

- **Example**
  
  ```
  Day(#2012-03-23#)
  ```

  returns 23

DayOfWeek

Returns the day of the week as a number from 1 (Sunday) to 7 (Saturday).
Code Syntax

DayOfWeek(#date#)

- #date#: A date

Example

DayOfWeek(#2012-03-23#)
returns 6

DayOfYear

Returns the day of the year as a number.

Code Syntax

DayOfYear(#date#)

- #date#: A date

Example

DayOfYear(#2012-03-23#)
returns 83

Hour

For a specified time (time), returns the hour.

Code Syntax

Hour(time)

- time: A Time or Datetime object

Example

Hour(ToTime("20:39:45", "hh:mi:ss"))
returns 20
**LastDayOfMonth**

Returns the date produced by computing the last day of the month of a specified date.

**Code Syntax**

\[
\text{LastDayOfMonth}(\#\text{date}\#)
\]

- \#date\#: A date

**Example**

\[
\text{LastDayOfMonth}(\#2012-03-23\#)
\]

returns the date \(2012-03-31\)

---

**LastDayOfWeek**

Returns the date produced by computing the last day of the week of a specified date.

**Code Syntax**

\[
\text{LastDayOfWeek}(\#\text{date}\#)
\]

- \#date\#: A date

**Example**

\[
\text{LastDayOfWeek}(\#2012-03-23\#)
\]

returns the date \(2012-03-24\)

---

**MakeDate**

Returns a date that is built from a specified year, month, and day.

**Code Syntax**

\[
\text{MakeDate}(\text{year, month, day})
\]

- \text{year}: Number that represents a year (0001-9999)
- \text{month}: Number that represents a month (1-12)
**day**: Number that represents a day of the month (1-31)

**Example**

```
MakeDate(2011,6,12)
```

returns the date 2011-06-12

---

**MakeDateTime**

Returns the Datetime (combined date and time) that corresponds to the specified date and time.

**Code Syntax**

```
MakeDateTime(date,time)
```

- **date**: A Date object
- **time**: A Time object

**Example**

```
date: A Date object
time: A Time object

MakeDateTime(MakeDate(2011,6,12), MakeTime(20,39,45))
```

returns 2011-06-12 8:39:45 PM

---

**MakeTime**

Returns the time that corresponds to the specified hours, minutes, and seconds.

**Code Syntax**

```
MakeTime(hour,minute,second)
```

- **hour**: Number that represents the hour (0-23)
- **minute**: Number that represents the minute (0-59)
- **second**: Number that represents the second (0-59)

**Example**

```
MakeTime(20,39,45)
```
Minute

For a specified time (time), returns the minute.

Code Syntax

Minute(time)

- time: A Time or Datetime object

Example

Minute(ToTime("20:39:45"), "hh:mm:ss")
returns 39

Month

Returns the month of the year as a number from 1 to 12.

Code Syntax

Month(#date#)

- #date#: A date

Example

Month(#2012-03-23#)
returns 3

Quarter

Returns a number that represents the quarter of a specified date.

Code Syntax

Quarter(#date#)
● \#date\#: A date

Example

Quarter(\#2012-03-23\#)
returns 1

Second

For a specified time (time), returns the seconds.

Code Syntax

Second(time)

● time: A Time or Datetime object

Example

Second(ToTime("20:39:45"), "hh:mi:ss")
returns 45

TimeDiff

Returns the amount of time between a specified start time (start) and a specified end time (end), in the specified format (format).

Code Syntax

TimeDiff(start,end,format)

● start and end: Time, Date, or Datetime objects

The format includes:

● hh: hours
● mi: minutes
● ss: seconds

Example

TimeDiff(MakeDateTime(MakeDate(2015,1,14), MakeTime(1,23,45)), MakeDateTime(MakeDate(2015,1,15), MakeTime(6,40,58)), "ss")
ToDate

Converts an input string to a date in a specified format, when the dates in a column of an original data source are in string format.

**Code Syntax**

```
ToDate(string, format)
```

- `string`: Input string to convert
- `format`: Date format

The date format is a combination of the following reserved tokens, separated by delimiters:

- **d** or **dd**: Day of month (1-31)
- **M** or **MM**: Month of year (1-12)
- **y** or **yy**: Abbreviated year without century (00-99)
- **yyyy**: Year with century (1956, 2012, 2014, and so on)

All other characters are considered delimiters.

**Example**

```
ToDate(Obj, 'yyyy/dd/MM')
```

converts a string in the format `yyyy/dd/MM` to a date

ToDateTime

Converts a specified input string (datetime) in the specified format (format) to a Datetime (combined date and time).

**Code Syntax**

```
ToDateTime(datetime, format)
```

- `datetime`: Input string to convert
- `format`: Datetime format

The datetime format is `<yyyy>-<mm>-<dd> <hh>:<mi>:<ss>.<ff>` where:

- `yyyy` or `YYYY`: Year (0001-9999)
● mm or MM: month (1-12)
● dd or DD: day (1-31)
● hh or HH: hours (0-23)
● mi or MI: minutes (0-59)
● ss or SS: seconds (0-59)
● ff or FF: fractional seconds. Include “ff” only if the input string contains fractional seconds. If fewer than 7
decimal places are provided, the value will be padded with zeros. If more than 7 decimal places are
provided, the value will be truncated to 7 decimal places.

All other characters are considered delimiters.

Tip

The date elements can be in any order.

For example, instead of <yyyy>-<mm>-<dd>, you could use <mm>-<dd>-<yyyy> or <dd>-<mm>-<yyyy>.

Example

ToDateTime(“2011-06-12 20:39:45.123”, “yyyy-mm-dd hh:mi:ss.ff”)

returns 2011-06-12 8:39:45.1230000 PM

ToTime

Converts a specified input string (time) in the specified format (format) to a Time object.

Code Syntax

ToTime(time,format)

● time: Input string to convert
● format: Time format

The time format is a combination of the following reserved tokens, separated by delimiters:

● hh or HH: hours (0-23)
● mi or MI: minutes (0-59)
● ss or SS: seconds (0-59)

All other characters are considered delimiters.

Example

ToTime(“20:39:45”, “hh:mi:ss”)

returns 8:39:45 PM
**Week**

Returns a number that represents the week of a specified date.

<table>
<thead>
<tr>
<th>Code Syntax</th>
<th>Week(#date#)</th>
</tr>
</thead>
<tbody>
<tr>
<td>● #date#: A date</td>
<td></td>
</tr>
</tbody>
</table>

**Example**

Week(#2012-03-23#) returns 12

---

**Year**

Returns the year of a specified date.

<table>
<thead>
<tr>
<th>Code Syntax</th>
<th>Year(#date#)</th>
</tr>
</thead>
<tbody>
<tr>
<td>● #date#: A date</td>
<td></td>
</tr>
</tbody>
</table>

**Example**

Year(#2012-03-23#) returns 2012

---

**Related Information**

- Aggregate Functions [page 164]
- Character Functions [page 170]
- Expression Functions [page 191]
- Miscellaneous Functions [page 202]
- Numeric Functions [page 206]
- Operator Functions [page 210]

---

**Parent topic:** Lumira Functions Reference for Offline Documents [page 163]
13.2.4 Expression Functions

Functions to be used for custom calculations and running calculations.

The following functions can be used for custom calculations on aggregated values (all functions are case-sensitive):

- **For** [page 191]
- **ForAllExcept** [page 192]
- **CumulativeDistribution** [page 192]
- **DenseRank** [page 193]
- **First** [page 193]
- **Index** [page 194]
- **Key** [page 194]
- **Last** [page 195]
- **Median** [page 195]
- **MovingAverage** [page 196]
- **MovingSum** [page 197]
- **Next** [page 197]
- **NthValue** [page 197]
- **PercentRank** [page 198]
- **Previous** [page 198]
- **Rank** [page 199]
- **RunningAverage** [page 199]
- **RunningCount** [page 199]
- **RunningMax** [page 200]
- **RunningMin** [page 200]
- **RunningSum** [page 201]
- **Value** [page 201]
- **Variance** [page 202]

**For**

Returns the context for a calculation.

**Code Syntax**

```
<calculation> For <context>
```

**Example**

```
RunningSum({Sales}) For [{Country}, {Product}]
```

returns the running sum of Sales and resets it at Country and Product level.
ForAllExcept

Returns everything else in the dimensions as the context for a calculation.

**Code Syntax**

```
<calculation> ForAllExcept <context>
```

**Example**

```
Previous({Sales}) ForAllExcept [{Country}, {Product}]
```

returns the previous value of Sales, resetting at all dimensions other than Country and Product.

CumulativeDistribution

Returns the cumulative distribution of a measure object (obj). The parameter (bool) is used to set the relative rank order. (true) is ascending order and (false) is descending order.

**Code Syntax**

```
CumulativeDistribution(obj, bool)
```

- **obj**: User object (column)
- **bool**: A Boolean

**Example**

```
CumulativeDistribution({Sales}, false)
```

returns the relative rank of the current Sales value: (number of rows preceding or peer with the current Sales value divided by the total number of rows).

<table>
<thead>
<tr>
<th>Year</th>
<th>Product</th>
<th>Sales</th>
<th>Cumulative Distribution</th>
</tr>
</thead>
<tbody>
<tr>
<td>2010</td>
<td>B</td>
<td>160</td>
<td>25</td>
</tr>
<tr>
<td>2010</td>
<td>A</td>
<td>110</td>
<td>50</td>
</tr>
<tr>
<td>2011</td>
<td>B</td>
<td>10</td>
<td>100</td>
</tr>
<tr>
<td>2011</td>
<td>A</td>
<td>10</td>
<td>100</td>
</tr>
</tbody>
</table>
DenseRank

Returns the density rank of a measure. The second parameter is a Boolean value used to set the dense rank order: true ranks the number from high to low and false ranks the number from low to high.

**Code Syntax**

DenseRank(obj, bool)

- **obj**: User object (column)
- **bool**: A Boolean

**Example**

DenseRank({Sales}, true)

returns Sales in a ranked manner (without gaps).

<table>
<thead>
<tr>
<th>Country</th>
<th>Product</th>
<th>Sales</th>
<th>Dense Rank</th>
</tr>
</thead>
<tbody>
<tr>
<td>DE</td>
<td>A</td>
<td>70</td>
<td>3</td>
</tr>
<tr>
<td>DE</td>
<td>B</td>
<td>90</td>
<td>2</td>
</tr>
<tr>
<td>US</td>
<td>A</td>
<td>100</td>
<td>1</td>
</tr>
<tr>
<td>US</td>
<td>B</td>
<td>50</td>
<td>5</td>
</tr>
<tr>
<td>US</td>
<td>C</td>
<td>60</td>
<td>4</td>
</tr>
</tbody>
</table>

First

Returns the first value of a measure.

**Code Syntax**

First(obj)

- **obj**: User object (column)

**Example**

First(Sales)

returns the first value of Sales in the result set:
Example

\texttt{First(Sales) For \{[Year]\}}

returns the first value of Sales in the result set for each Year:

<table>
<thead>
<tr>
<th>Year</th>
<th>Quarter</th>
<th>Sales</th>
<th>Last</th>
</tr>
</thead>
<tbody>
<tr>
<td>2014</td>
<td>Q1</td>
<td>500</td>
<td>500</td>
</tr>
<tr>
<td>2014</td>
<td>Q2</td>
<td>0</td>
<td>500</td>
</tr>
<tr>
<td>2015</td>
<td>Q1</td>
<td>400</td>
<td>500</td>
</tr>
<tr>
<td>2015</td>
<td>Q2</td>
<td>700</td>
<td>500</td>
</tr>
</tbody>
</table>

Index

Returns the row number of the current row in the result set.

\textbf{Code Syntax}

\texttt{Index()}

Key

Returns the key value of a dimension member.

\textbf{Code Syntax}

\texttt{Key(obj)}

- \texttt{obj}: User object (column)
Example

Key(Month)

returns the key value of the Month level in a time hierarchy.

<table>
<thead>
<tr>
<th>Year _lvl</th>
<th>Month _lvl</th>
<th>Key</th>
</tr>
</thead>
<tbody>
<tr>
<td>2010</td>
<td>1</td>
<td>[2010].[1]</td>
</tr>
<tr>
<td>2010</td>
<td>2</td>
<td>[2010].[2]</td>
</tr>
<tr>
<td>2011</td>
<td>1</td>
<td>[2011].[1]</td>
</tr>
<tr>
<td>2011</td>
<td>2</td>
<td>[2011].[2]</td>
</tr>
</tbody>
</table>

Last

Returns the last value of a measure.

Code Syntax

Last(obj)

- obj: User object (column)

Example

Last(Sales)

returns the last value of Sales in the result set:

<table>
<thead>
<tr>
<th>Year</th>
<th>Quarter</th>
<th>Sales</th>
<th>Last</th>
</tr>
</thead>
<tbody>
<tr>
<td>2014</td>
<td>Q1</td>
<td>500</td>
<td>700</td>
</tr>
<tr>
<td>2014</td>
<td>Q2</td>
<td>0</td>
<td>700</td>
</tr>
<tr>
<td>2015</td>
<td>Q1</td>
<td>400</td>
<td>700</td>
</tr>
<tr>
<td>2015</td>
<td>Q2</td>
<td>700</td>
<td>700</td>
</tr>
</tbody>
</table>

Median

Returns the median of a measure
### Code Syntax

**Median(obj)**

- **obj**: User object (column)

### Example

**Median(obj)** returns the median of Sales in the result set:

<table>
<thead>
<tr>
<th>Country</th>
<th>Year</th>
<th>Sales</th>
<th>Median</th>
</tr>
</thead>
<tbody>
<tr>
<td>CA</td>
<td>2013</td>
<td>100</td>
<td>60</td>
</tr>
<tr>
<td>US</td>
<td>2014</td>
<td>50</td>
<td>60</td>
</tr>
<tr>
<td>US</td>
<td>2014</td>
<td>60</td>
<td>60</td>
</tr>
</tbody>
</table>

### MovingAverage

The moving average returns the sum of the previous n values and the current value divided by n+1.

#### Code Syntax

**MovingAverage(obj, int, int, bool)**

- **obj**: User object (column)
- **int**: an integer; the first integer sets the number of values before the current value.
- **int**: an integer; the second integer sets the number of values after the current value.
- **bool**: A Boolean; true includes the current value, false excludes the current value.

#### Example

**MovingAverage([Sales],1,0,true) For [Country])**

The moving average returns the sum of the previous Sales value and the current value divided by 2. The For operator is used to reset the moving average at the Country level.

<table>
<thead>
<tr>
<th>Country</th>
<th>Product</th>
<th>Sales</th>
<th>Moving Avg</th>
</tr>
</thead>
<tbody>
<tr>
<td>DE</td>
<td>A</td>
<td>70</td>
<td>70</td>
</tr>
<tr>
<td>DE</td>
<td>B</td>
<td>90</td>
<td>80</td>
</tr>
<tr>
<td>Country</td>
<td>Product</td>
<td>Sales</td>
<td>Moving Avg</td>
</tr>
<tr>
<td>---------</td>
<td>---------</td>
<td>-------</td>
<td>------------</td>
</tr>
<tr>
<td>US</td>
<td>A</td>
<td>100</td>
<td>100</td>
</tr>
<tr>
<td>US</td>
<td>B</td>
<td>50</td>
<td>75</td>
</tr>
<tr>
<td>US</td>
<td>C</td>
<td>60</td>
<td>55</td>
</tr>
</tbody>
</table>

**MovingSum**

Returns the moving sum of a measure.

**Code Syntax**

```c
MovingSum(obj, int, int, bool)
```

- `obj`: User object (column)
- `int`: an integer; the first integer sets the number of values before the current value.
- `int`: an integer; the second integer sets the number of values after the current value.
- `bool`: A Boolean; `true` includes the current value, `false` excludes the current value.

**Next**

Returns the next value of a measure.

**Code Syntax**

```c
Next(obj, int)
```

- `obj`: User object (column)
- `int`: an integer

**NthValue**

Returns the nth value of a measure.

**Code Syntax**

```c
NthValue(obj, int)
```
- **obj**: User object (column)
- **int**: an integer

**Example**

```
NthValue({Sales}, 3)
```

returns the Sales value at the 3rd row of the result set (counting from 1); returns null if there is no such row.

<table>
<thead>
<tr>
<th>Year</th>
<th>Product</th>
<th>Sales</th>
<th>NthValue</th>
</tr>
</thead>
<tbody>
<tr>
<td>2010</td>
<td>B</td>
<td>160</td>
<td>10</td>
</tr>
<tr>
<td>2010</td>
<td>A</td>
<td>110</td>
<td>10</td>
</tr>
<tr>
<td>2011</td>
<td>B</td>
<td>10</td>
<td>10</td>
</tr>
<tr>
<td>2011</td>
<td>A</td>
<td>10</td>
<td>10</td>
</tr>
</tbody>
</table>

**PercentRank**

Returns the percent rank of a measure.

**Code Syntax**

```
PercentRank(obj, bool)
```

- **obj**: User object (column)
- **bool**: A Boolean; true is ascending order, false is descending order.

**Previous**

Returns the previous value of a measure.

**Code Syntax**

```
Previous(obj, int)
```

- **obj**: User object (column)
- **int**: an integer
**Rank**

Returns the rank value of a measure.

#### Code Syntax

```
Rank(obj, bool)
```

- `obj`: User object (column)
- `bool`: A Boolean; `true` ranks from high to low, and `false` ranks from low to high.

**RunningAverage**

Returns the running average of a measure. The parameter `true` excludes empty sales values.

#### Code Syntax

```
RunningAverage([Sales], true) for [Country])
```

#### Example

Returns running average of Sales and resets it at the Country level.

```
RunningAverage([Sales], true) for [Country])
```

<table>
<thead>
<tr>
<th>Country</th>
<th>Year</th>
<th>Sales</th>
<th>R Avg</th>
</tr>
</thead>
<tbody>
<tr>
<td>DE</td>
<td>2013</td>
<td>70</td>
<td>70</td>
</tr>
<tr>
<td>DE</td>
<td>2014</td>
<td>90</td>
<td>80</td>
</tr>
<tr>
<td>US</td>
<td>2013</td>
<td>100</td>
<td>100</td>
</tr>
<tr>
<td>US</td>
<td>2014</td>
<td>50</td>
<td>75</td>
</tr>
<tr>
<td>US</td>
<td>2015</td>
<td>60</td>
<td>70</td>
</tr>
</tbody>
</table>

**RunningCount**

Returns the running count of a measure.

#### Code Syntax

```
RunningCount([Sales], true)
```
Example

Returns running count of Sales and resets it at the Country level.

RunningCount([Sales] for [Country])

<table>
<thead>
<tr>
<th>Country</th>
<th>Year</th>
<th>Sales</th>
<th>R Count</th>
</tr>
</thead>
<tbody>
<tr>
<td>DE</td>
<td>2013</td>
<td>70</td>
<td>1</td>
</tr>
<tr>
<td>DE</td>
<td>2014</td>
<td>90</td>
<td>2</td>
</tr>
<tr>
<td>US</td>
<td>2013</td>
<td>100</td>
<td>1</td>
</tr>
<tr>
<td>US</td>
<td>2014</td>
<td>50</td>
<td>2</td>
</tr>
<tr>
<td>US</td>
<td>2015</td>
<td>50</td>
<td>3</td>
</tr>
</tbody>
</table>

RunningMax

Returns the running maximum of a measure.

Code Syntax

RunningMax([Sales])

Example

Returns running maximum of Sales and resets it at the Country level.

RunningMax([Sales] for [Country])

<table>
<thead>
<tr>
<th>Country</th>
<th>Year</th>
<th>Sales</th>
<th>R Max</th>
</tr>
</thead>
<tbody>
<tr>
<td>DE</td>
<td>2013</td>
<td>70</td>
<td>70</td>
</tr>
<tr>
<td>DE</td>
<td>2014</td>
<td>90</td>
<td>90</td>
</tr>
<tr>
<td>US</td>
<td>2013</td>
<td>100</td>
<td>100</td>
</tr>
<tr>
<td>US</td>
<td>2014</td>
<td>50</td>
<td>100</td>
</tr>
</tbody>
</table>

RunningMin

Returns the running minimum of a measure.
Code Syntax

RunningMin([Sales])

Example

Returns running minimum of Sales and resets it at the Country level.

RunningMin([Sales] for [Country])

<table>
<thead>
<tr>
<th>Country</th>
<th>Year</th>
<th>Sales</th>
<th>R Min</th>
</tr>
</thead>
<tbody>
<tr>
<td>DE</td>
<td>2013</td>
<td>70</td>
<td>70</td>
</tr>
<tr>
<td>DE</td>
<td>2014</td>
<td>90</td>
<td>70</td>
</tr>
<tr>
<td>US</td>
<td>2013</td>
<td>100</td>
<td>100</td>
</tr>
<tr>
<td>US</td>
<td>2014</td>
<td>50</td>
<td>50</td>
</tr>
</tbody>
</table>

RunningSum

Returns the running sum of a measure.

Code Syntax

RunningSum([Sales])

Example

Returns running sum of Sales and resets it at the Country level.

RunningSum([Sales] for [Country])

<table>
<thead>
<tr>
<th>Country</th>
<th>Year</th>
<th>Sales</th>
<th>R Sum</th>
</tr>
</thead>
<tbody>
<tr>
<td>CA</td>
<td>2014</td>
<td>100</td>
<td>100</td>
</tr>
<tr>
<td>US</td>
<td>2013</td>
<td>100</td>
<td>100</td>
</tr>
<tr>
<td>US</td>
<td>2014</td>
<td>50</td>
<td>150</td>
</tr>
</tbody>
</table>

Value

Returns the value of a dimension member.
**Value(obj)**

- **obj**: User object (column)

**Variance**

Returns the variance value of a member.

**Code Syntax**

```
Variance(obj)
```

- **obj**: User object (column)

**Parent topic**: Lumira Functions Reference for Offline Documents [page 163]

**Related Information**

- Aggregate Functions [page 164]
- Character Functions [page 170]
- Date and Time Functions [page 177]
- Miscellaneous Functions [page 202]
- Numeric Functions [page 206]
- Operator Functions [page 210]

**13.2.5 Miscellaneous Functions**

Miscellaneous functions reference.

The following miscellaneous functions can be used for calculations (all functions are case-sensitive):

- **Contain** [page 203]
- **GroupValues** [page 203]
- **if then else** [page 203]
- **IsNotNull** [page 204]
- **IsNull** [page 204]
- **ToNumber** [page 204]
- **ToText** [page 205] number
ToText [page 205] parameter

Contain

Returns occurrences of a string within another string. The search is not case-sensitive.

Code Syntax

`Contain(whereStr, whatStr)`

- `whereStr`: String in which a search is conducted
- `whatStr`: Substring that is the object of the search

Example

```
Contain("Cats are grey", "aRe")
```

returns `true`

GroupValues

Groups a list of values.

Code Syntax

`GroupValues(column, ListOfValues, newValue)`

- `column`: User object to apply the grouping to
- `ListOfValues`: List of values to be grouped
- `newValue`: Value that will replace the grouped values

Example

```
GroupValues(CountryColumn, ["USA", "India", "France"], "My Countries")
```

returns "My Countries" when the `CountryColumn` column contains "USA", "India", or "France"

If Then Else

Chooses between two alternatives, based on a Boolean condition. The second alternative is optional and evaluates to `null` when missing.
**Code Syntax**

```
if<cond> then <alt1> else <alt2>
```

- **cond**: Boolean condition to test
- **alt1**: Alternative 1
- **alt2**: Alternative 2

---

**IsnNotNull**

Returns a Boolean value that indicates whether a supplied field contains a null value. If a field contains a null value, the function returns `false`. Otherwise it returns `true`.

```
IsnNotNull(obj)
```

- **obj**: User object (column)

---

**IsNull**

Returns a Boolean value that indicates whether the supplied field contains a null value. If a field contains a null value, the function returns `true`. Otherwise it returns `false`.

```
IsNull(obj)
```

- **obj**: User object (column)

---

**ToNumber**

Converts any type of parameter to a numeric value. Numbers are truncated to zero decimal places.

```
ToNumber(param)
```

- **param**: Parameter to convert
**ToText (number)**

Converts a specified number to a string. The number is truncated to the specified number of decimal places.

<table>
<thead>
<tr>
<th>Code Syntax</th>
</tr>
</thead>
<tbody>
<tr>
<td>ToText(num, digits)</td>
</tr>
</tbody>
</table>

- **num**: A number
- **digits**: Number of decimal places to use. This parameter is optional, and its default value is 0.

**Example**

ToText(12.1451, 2) returns 12.14

**ToText (parameter)**

Converts a parameter to a string.

<table>
<thead>
<tr>
<th>Code Syntax</th>
</tr>
</thead>
<tbody>
<tr>
<td>ToText(param)</td>
</tr>
</tbody>
</table>

- **param**: Parameter to convert

**Parent topic**: Lumira Functions Reference for Offline Documents [page 163]

**Related Information**

- Aggregate Functions [page 164]
- Character Functions [page 170]
- Date and Time Functions [page 177]
- Expression Functions [page 191]
- Numeric Functions [page 206]
- Operator Functions [page 210]
13.2.6 Numeric Functions

Functions that return numeric data.

The following functions can be used for custom calculations on aggregated values (all functions are case-sensitive):

- Abs [page 206]
- Ceil [page 206]
- Floor [page 207]
- Log [page 207]
- Log10 [page 207]
- Mod [page 208]
- Power [page 208]
- Round [page 209]
- Sign [page 209]
- Truncate [page 210]

Abs

Returns the absolute value of a number

Code Syntax

Abs(num)

- num: A number

Example

Abs(-11)
returns 11

Ceil

Returns the smallest integer that is greater than or equal to a specified number.

Code Syntax

Ceil(num)

- num: A number
Example

Ceil(14.2)
returns 15

Floor

Returns the largest integer that is not greater than a specified number.

Code Syntax

Floor(num)

- num: A number

Example

Floor(14.8)
returns 14

Log

Returns the natural logarithm of a specified number.

Code Syntax

Log(num)

- num: A number

Example

Log(100)
returns 4.605

Log10

Returns the base 10 logarithm of a specified number.
**Code Syntax**

Log10(num)

- **num**: A number

**Example**

Log10(100)

returns 2

---

**Mod**

Returns the remainder of the division of a number by another number.

**Code Syntax**

Mod(num, divisor)

- **num**: A number
- **divisor**: The divisor

**Example**

Mod(15,2)

returns 1

---

**Power**

Raises a number to a power.

**Code Syntax**

Power(num, exponent)

- **num**: A number
- **exponent**: The exponent

The operator `^` (caret) can be used instead of this function.
Example

Power(2, 3) returns 8

Round

Returns a numeric value, rounded to a specified number of decimal places.

Code Syntax

Round(num, digits)

- num: A number
- digits: The number of decimal places to round off to.

Example

Round(14.81, 1) returns 14.8

Sign

Returns -1 if a specified number is negative, 0 if the specified number is zero, or +1 if the specified number is positive.

Code Syntax

Sign(num)

- num: A number

Example

Sign(-2) returns -1
Truncate

Returns a numeric value, truncated at a specified number of decimal places.

<table>
<thead>
<tr>
<th>Code Syntax</th>
</tr>
</thead>
<tbody>
<tr>
<td>Truncate(num, digits)</td>
</tr>
</tbody>
</table>

- **num**: A number
- **digits**: Number of decimal places to truncate

**Example**

Truncate(12.281, 1)

returns 12.200

**Parent topic**: [Lumira Functions Reference for Offline Documents](#)

**Related Information**

- [Aggregate Functions](#)
- [Character Functions](#)
- [Date and Time Functions](#)
- [Expression Functions](#)
- [Miscellaneous Functions](#)
- [Operator Functions](#)

### 13.2.7 Operator Functions

Operator functions include logical functions and other functions that return *true* or *false*.

The following functions can be used for custom calculations on aggregated values (all functions are case-sensitive):

- [And operator](#)
- [Or operator](#)
- [Like pattern](#)
- [InList](#)
- [Not operator](#)
And operator

Returns the logical conjunction of its Boolean inputs. This function returns false: true and false.

Code Syntax

<left> and <right>

- left: Left operand
- right: Right operand

Or operator

Returns the logical disjunction of its Boolean inputs. This function returns true: true or false.

Code Syntax

<left> or <right>

- left: Left operand
- right: Right operand

Like pattern

Determines whether a character string matches a specified pattern. The search is not case-sensitive.

Code Syntax

<matchExpr> like <pattern>

- matchExpr: The string expression to search
- pattern: The pattern string constant to search for

The pattern can include regular characters and the following special characters:

- "_" matches a single character
- "%" matches zero to many characters

Before you can use a special character as a regular character, you must escape it, using a backslash ("\").

Note

"[", "^", "_*", and "]" are reserved for future use.
Example

"Hiking is fun" like "H% is _un"
returns true

In List

Use to determine whether a first input matches a value in a second input list.

Code Syntax

<testExpr> in <candidateList>

- testExpr: Expression to be tested
- candidateList: List of match candidates

Example

3 in [2, 4, 6]
returns false

Not operator

Use to negate a Boolean input.

Code Syntax

not<bool>

- bool: A Boolean

Example

not false
returns true

Parent topic: Lumira Functions Reference for Offline Documents [page 163]
13.3 Lumira Discovery Functions Reference for Online Documents

Overview of the functions that are available for online documents. Currently Lumira Discovery supports SAP HANA and SAP BW online data sources.

The following tables list the available functions for SAP HANA and SAP BW sources.

Table 42: Functions available for SAP HANA

<table>
<thead>
<tr>
<th>Available Lumira Discovery functions reference</th>
<th>Available functions for calculations</th>
</tr>
</thead>
<tbody>
<tr>
<td>Miscellaneous functions</td>
<td>If Then Else</td>
</tr>
<tr>
<td></td>
<td>Note</td>
</tr>
<tr>
<td></td>
<td>String and Boolean are not supported for formula input and output.</td>
</tr>
<tr>
<td></td>
<td>For more information, see Miscellaneous Functions [page 202].</td>
</tr>
<tr>
<td>Numeric functions</td>
<td>Abs</td>
</tr>
<tr>
<td></td>
<td>Ceil</td>
</tr>
<tr>
<td></td>
<td>Floor</td>
</tr>
<tr>
<td></td>
<td>Log</td>
</tr>
<tr>
<td></td>
<td>Log10</td>
</tr>
<tr>
<td></td>
<td>For more information, see Numeric Functions [page 206].</td>
</tr>
<tr>
<td>Operator functions</td>
<td>&lt;lhs&gt;/&lt;rhs&gt; (Division)</td>
</tr>
<tr>
<td></td>
<td>&lt;lhs&gt;+&lt;rhs&gt; (Addition)</td>
</tr>
<tr>
<td></td>
<td>&lt;lhs&gt;=&lt;rhs&gt; (Equals)</td>
</tr>
<tr>
<td></td>
<td>For more information, see Operator Functions [page 210].</td>
</tr>
</tbody>
</table>
Table 43: Functions available for SAP BW

<table>
<thead>
<tr>
<th>Available Lumira Discovery functions reference</th>
<th>Available functions for calculations</th>
</tr>
</thead>
<tbody>
<tr>
<td>Aggregate functions</td>
<td>• Max</td>
</tr>
<tr>
<td></td>
<td>• Min</td>
</tr>
<tr>
<td></td>
<td>For more information, see Aggregate Functions [page 164].</td>
</tr>
<tr>
<td>Numeric functions</td>
<td>• Abs</td>
</tr>
<tr>
<td></td>
<td>• Ceil</td>
</tr>
<tr>
<td></td>
<td>• Floor</td>
</tr>
<tr>
<td></td>
<td>• Log</td>
</tr>
<tr>
<td></td>
<td>• Log10</td>
</tr>
<tr>
<td></td>
<td>For more information, see Numeric Functions [page 206].</td>
</tr>
<tr>
<td></td>
<td>• &lt;lhs&gt;/&lt;rhs&gt; (Division)</td>
</tr>
<tr>
<td></td>
<td>• &lt;lhs&gt;+&lt;rhs&gt; (Addition)</td>
</tr>
<tr>
<td></td>
<td>For more information, see Operator Functions [page 210].</td>
</tr>
</tbody>
</table>
14 Publish Dataset and Documents

You can publish the following content:

- **Dataset**: You can publish datasets that others can use to build new documents.
- **Document**: Documents contain your visualizations, stories, and data connection. You can include local resources, such as images, illustrations and so on.

You can share your work with others by publishing it to SAP BusinessObjects Lumira, server version for BI Platform. When you save a document to the SAP BusinessObjects Lumira, server version for BI Platform, you can take benefit from authorization, auditing, data loss prevention, and sharing functions for your dataset, visualizations, and stories.

14.1 Saving a Document to Local Directory

When you save a document locally, your dataset, visualizations, and stories are added to the document.

**Procedure**

1. Choose ![Save](#) (Save) from the global toolbar.
   
   Alternatively, you can save document by selecting ![File > Save As...](#) and then selecting Local in the Save Document dialog box.
   
   The Save Document dialog box appears.
2. Select **Local**.
3. Enter a name, location, and description (optional) for the document or select a name from the list, and choose **Save**.

**Note**

If your document contains any sensitive data and you do not want to save that data while saving the document, select the **Save without data** option in **Save Document** dialog box and then save the document.

If you modify your dataset, the changes are saved in your document even if you do not edit it. If you have more than one document that uses the same data source and dataset, the dataset appears twice in the list of datasets.

You can follow a similar procedure to locally save the SAP HANA online document.
Results

The document is saved locally.

14.2 Publishing a Document to SAP BusinessObjects Lumira, server for BI Platform

When you save a document to the SAP BusinessObjects Lumira, server version for BI Platform, you can benefit from authorization, auditing, data loss prevention, and sharing functions for your dataset, visualizations, and stories.

Prerequisites

- Make sure that SAP BI platform 4.1 SP3 or higher is installed and running on your network.

- Configure the URL to the BI platform in Lumira Discovery by selecting $Preferences$ $Network$.
  
  To find the URL, launch SAP BusinessObjects Lumira, server version for BI Platform from the CMC/BI Launchpad from the start menu and copy the system name or IP address and the port number that appears.

  **Example**

  ![Example Image]

  **Sample Code**


  **Note**

  Port is the RESTful port here (i.e. 6405). If IT has changed the default REST port, you need to get the PORT from the BI platform administrator.

- To view items on the BI platform, make sure that SAP BusinessObjects Lumira, server version for BI Platform with the same version as Lumira Discovery is installed.

  **Note**

  If a message appears indicating that the versions are different, contact your BI platform administrator.
Procedure

1. Open a Lumira Discovery document that you want to publish.
2. Selecting File > Save As... and select SAP BusinessObjects BI Platform in Save Options.
3. Enter your credentials.

   **Note**
   You can publish a document or log on to SAP BusinessObjects Lumira, server version for BI Platform from Lumira Discovery using the operating system SSO. Make sure however that you have configured the SSO on SAP BusinessObjects Lumira, server version for BI Platform environment and on both the Lumira Discovery and SAP BusinessObjects Lumira, server version for BI Platform reside on the same machine.

4. Choose the Authentication Type and choose Connect.

   **Note**
   If you select SAP as the authentication type, enter the SAP System and the SAP Client.

5. Select a folder where you want to place the document.
6. Enter the name for the document.
7. Choose Save.

Results

The document is saved to the BI platform repository.

   **Note**
   When you save a dataset, a visualization, or a story, the document and all of its contents are saved.

Related Information

Setting Application Preferences [page 222]
Home Page [page 18]
14.3 Publishing a Dataset to SAP HANA

When you publish a dataset to SAP HANA, only the dataset is published (without any associated visualizations).

Prerequisites

Before you publish the time hierarchies to SAP HANA, the following prerequisites apply:

- The maximum calendar range must be 50 years.
- The SAP HANA calendar system table must be available, and the calendar must be Gregorian. Lumira Discovery uses time information from the SAP HANA server to match data to the SAP HANA Gregorian calendar.

Procedure

1. Select the dataset that you want to publish.
2. Choose File > Publish > SAP HANA. The Publish to SAP HANA dialog box appears.
3. Enter your connection details.
4. Choose Connect. The dialog box appears with the list of Available Views.
5. Select the required view.
6. Choose Publish.

Results

The dataset is published as a new analytic view.
14.4 Saving a Discovery Document Without Sensitive Data

You can save Lumira Discovery documents without saving any sensitive data they may contain. This is useful if you connect Lumira Discovery documents to data sources that have row-level security.

Prerequisites

You have the rights required to save a document.

Context

This option is supported only for the following data sources:

- UNX
- SAP BW Offline
- SAP HANA Offline

Note

Lumira Discovery documents that connect to SAP HANA in online mode do not contain any data while saving. They therefore do not require this process.

Advantage:

You can use this feature to prevent sharing confidential or restricted data with unauthorized users. As a report designer, for example, the data that you need in a Lumira Discovery document is test data which makes no sense to business users. You would therefore like to save the document without data as a template. Business users can then open the Lumira Discovery document and choose Save As to save the document with the data they require.

Procedure

1. Select File > Save As...
2. In the Save Document dialog, enter the following details:
   1. A name for the document.
   2. A description (optional).
3. Choose the Save without data option to purge all data sets from the document.
4. Choose Save.
15 Managing Lumira Discovery

You can optimize your Lumira Discovery settings, upgrade the product, send feedback, and so on.

Related Information

Setting Application Preferences [page 222]
Configuring Geo Map in Preferences [page 224]

15.1 Manage Licenses

When you initially download and install Lumira Discovery, you have access to the features that are available for the duration of a 30 day trial. Once this period has expired, you need to enter a valid license key. You can enter any of the following license keys, depending on your requirements:

- Trial key
- Permanent key
- Limited Key

Note

If you are a Lumira 1.x user, you need to obtain a new license key for Lumira Discovery 2.0. You won’t be allowed to work with Lumira Discovery 2.0 with your existing license key.

Trial Key

This type of license allows you to access all the features for 30 days. Once this period has expired, you need to purchase a permanent license to use the software.

Permanent Key

This type of license permits continued use of the licensed software for as long as you comply with all of the terms of the license agreement.
Limited Key

This type of license restricts access to certain features, which are listed below. However, you have the option of buying a permanent license key and getting access to all the features which Lumira Discovery offers.

- You cannot access SAP BW Live and Import connections, as it remains disabled in the Home page.
- FH SQL data access to the SAP BW sources such as SAP R/3, SAP ERP6 and SAP ERP remains disabled.
- You cannot refresh the documents migrated from 1.x consisting of SAP BW Offline data source.
- Interactions with BI Platform are restricted, for example:
  - You cannot connect to BI Platform via Universe connection.
  - You cannot connect to SAP HANA: Live/Import and SAP BW: Live/Import via managed connections.
  - You cannot access a list of documents in BI Platform by logging on to BI Platform from Lumira Discovery Home page.
  - You cannot save the documents to BI Platform, because the Save As option to BI Platform is disabled in Lumira Discovery.
  - You cannot refresh documents created using BI Platform.
  - You cannot refresh documents migrated from Lumira 1.x consisting Universe/SAP BW/SAP HANA connectivity via managed connections.

15.1.1 Upgrading from Lumira Discovery Trial

To activate a permanent license, follow these steps:

Procedure

1. Open Lumira Discovery.
2. Choose Help > Enter Keycode > Copy the permanent keycode and press OK.
15.2 Setting Application Preferences

You can modify the default settings for Lumira Discovery preferences.

Context

Table 44: Application preferences

<table>
<thead>
<tr>
<th>Preference Area</th>
<th>Description</th>
</tr>
</thead>
</table>
| **General**     | ● *Language*: Select the language to use in the Lumira Discovery user interface.  
                | ● *Auto Recovery*: The default time interval is five minutes. You can select the required  
                |   time interval to automatically create a recovery file of the current document. If the  
                |   *Auto Recovery* is enabled and Lumira Discovery shuts down unexpectedly, the  
                |   next time the application starts, the recovery file is located and Lumira has  
                |   recovered a file from the previous session. Choose OK if you wish to keep it.  
                |   message appears.  
                | ● *Default View*: Select the default view to open documents in. |
| **Views**       | Set the preferred view to open when starting Lumira Discovery. You can select a default  
                | view (Grid or Canvas) for each type of data source. |
| **Charts**      | *Export Records*: Choose the default export type.  
                | Select the default colors and visual template for new charts that you create. The *Default  
                | Measure Palette* applies to charts with measure-based color schemes. The *Default  
                | Dimension Palette* applies to any other chart that has the Colors setting available. |
| **Datasets**    | *Offline Datasets*  
                | ● Specify how hierarchies and measures are detected when data is acquired. This is  
                | called enriching your dataset.  
                | ● Specify whether to show dataset statistics in the status bar. |
### Preference Area

<table>
<thead>
<tr>
<th>Preference Area</th>
<th>Description</th>
</tr>
</thead>
</table>
| **Network**     | ● **Proxy:**  
|                 | ○ If your network doesn’t use a proxy server, select *No Proxy*.  
|                 | ○ If your network uses a proxy server and you want to use the system’s Internet proxy settings, select *Use System Proxy Settings*.  
|                 | ○ If your network uses a proxy server, and you want to enter the HTTP proxy server address, port number, user, and password, select *Manual Proxy Configuration*, and enter the information. This information might be required when performing automatic updates and viewing maps with Esri.  
|                 | ● *SAP BI Platform:* Enter the URL to the SAP BusinessObjects Business Intelligence platform RESTful web services. Set this URL to open and save documents on the Business Intelligence (BI) platform repository. The default URL is `http://<ServerName>:<port>/biprws/`, where `<ServerName>` is the BI platform server name or IP address, and `<port>` is the RESTful web services port, by default 6405. |
| **SQL Drivers** | Select the SQL drivers to install. |
| **Geo Map Service** | Enter the account information for the Esri Geo map data provider. The Esri map is used by the *Geo Map* chart. |

### Procedure

1. Choose *Preferences* by clicking on 📋 in the upper-right corner of Lumira Discovery.
2. Customize your preferences as required and then choose *Done*.

### Related Information

*Acquiring Data Using Query with SQL* [page 52]
15.2.1 Configuring the RESTful Web Service URL in Discovery

Context

When you publish datasets from Lumira Discovery to the BI platform you need to enter the REST access URL, which is the BI platform’s URL for web service requests. The publishing wizard in Lumira Discovery provides a default value for you. You can configure this value in the Lumira Discovery Preferences area. You can override the default value during publishing.

Procedure

1. In Lumira Discovery, select Preferences.
2. Select Network.
3. In SAP BI Platform field, enter the base URL for web service requests.
   To find the value for the URL, perform the following:
   1. Navigate to the Central Management Console on the BI platform.
   2. Select Applications.
   3. Right-click on RESTful Web Service.
4. Select Done.

15.3 Configuring Geo Map in Preferences

In Lumira Discovery you have to apply configuration settings in Preferences and then restart the application to use geographical charts for your analysis.

Related Information

Connecting to Esri ArcGIS Server [page 225]
Connecting to Esri ArcGIS On Premise Server [page 226]
15.3.1 Connecting to Esri ArcGIS Server

To use Geo Map in Lumira Discovery, you need to connect to Esri ArcGIS server and load the base map to your application.

Context

Connect to Esri ArcGIS server to load the Esri base map from the server to your application. To do this, perform the following steps:

Procedure

1. Launch Lumira Discovery.
2. Navigate to Preferences.
3. Choose Geo Map Service.
4. To log on to the server directly, select the Esri ArcGIS Online option and proceed as follows:
   - To access the basic features of Esri map, perform the following steps:
     1. Select the Default Account option.
     2. Choose Done.
        You can only load the base map in your application and access the basic features of ESRI map. You cannot customize it. Therefore, you cannot modify the map when you choose the Import Esri Custom Service link.
   - To customize the Esri, perform the following steps:
     1. Select the Use this Account option.
     2. Enter the user name and the password of your Esri ArcGIS account.
     3. Choose Done.
        You can customize your Esri maps by choosing the Import Esri Custom Service link. You can only do this by adding the customized feature services from your ESRI ArcGIS account to the Geo maps.

In Network, the proxy setting is set to Use System Proxy Settings by default. If you select No Proxy, the map is not loaded to your visualization.
15.3.2 Connecting to Esri ArcGIS On Premise Server

When you connect to Esri ArcGIS server using an on premise server connection, you can deploy the map from the server locally in your enterprise and customize it.

Procedure

1. Navigate to Preferences.
2. Choose Geo Map Services.
4. Enter the User Name, Password, and the Portal URL of your local Esri ArcGIS server account.
5. Choose Done

Note

The feature service supported in Esri ArcGIS Online connections is also supported in Esri On Premise connections.

In Network, the proxy setting is set to Use System Proxy Settings, by default. If you select No Proxy, the map is not loaded to your visualization.

15.4 Supported OLAP Measures

SAP HANA supports the following measures of aggregation in OLAP data sources:

- SUM
- MIN
- MAX
- COUNT

If a dataset contains an aggregation on a different measure, SAP HANA will ignore the aggregation during publication, and the aggregation will not be part of the final published artifact.
15.5 Lumira Discovery: Changing the location of the SAP Lumira Documents folder

With Lumira Discovery, you can place the SAP Lumira Documents folder in a different location.

**Context**

For Lumira documents created with Lumira Discovery, add a JAVA VM argument to the SBOPLumiraDiscovery.ini file:

**Procedure**

1. Go to the directory on your machine, where you have installed Lumira Discovery.
2. Open the SBOPLumiraDiscovery.ini file.
3. Enter the following JAVA VM argument with the required value at the end:
   ```bash
   Dhilo.document.dir=<document folder>
   ```
5. Restart Lumira Discovery.
Important Disclaimers and Legal Information

Coding Samples

Any software coding and/or code lines / strings ("Code") included in this documentation are only examples and are not intended to be used in a productive system environment. The Code is only intended to better explain and visualize the syntax and phrasing rules of certain coding. SAP does not warrant the correctness and completeness of the Code given herein, and SAP shall not be liable for errors or damages caused by the usage of the Code, unless damages were caused by SAP intentionally or by SAP’s gross negligence.

Accessibility

The information contained in the SAP documentation represents SAP’s current view of accessibility criteria as of the date of publication; it is in no way intended to be a binding guideline on how to ensure accessibility of software products. SAP in particular disclaims any liability in relation to this document. This disclaimer, however, does not apply in cases of willful misconduct or gross negligence of SAP. Furthermore, this document does not result in any direct or indirect contractual obligations of SAP.

Gender-Neutral Language

As far as possible, SAP documentation is gender neutral. Depending on the context, the reader is addressed directly with “you”, or a gender-neutral noun (such as “sales person” or “working days”) is used. If when referring to members of both sexes, however, the third-person singular cannot be avoided or a gender-neutral noun does not exist, SAP reserves the right to use the masculine form of the noun and pronoun. This is to ensure that the documentation remains comprehensible.

Internet Hyperlinks

The SAP documentation may contain hyperlinks to the Internet. These hyperlinks are intended to serve as a hint about where to find related information. SAP does not warrant the availability and correctness of this related information or the ability of this information to serve a particular purpose. SAP shall not be liable for any damages caused by the use of related information unless damages have been caused by SAP’s gross negligence or willful misconduct. All links are categorized for transparency (see: http://help.sap.com/disclaimer).